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DEPARTMENT OF TRANSPORTATION
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2000 South Holly Street
Denver, CO 80222
303-757-9372; FAX: 303-757-9907

Modified Phase | ESA Addendum April 7, 2009

This letter is designed to provide an update to the Phase | Environmental Site Assessment —

US 36 Corridor (Pinyon Environmental Engineering Resources, Inc. October 2004) that was
completed for the Draft Environmental Impact Statement (DEIS) in July 2007. This 2009
Addendum involved an update and review of the federal, state, and local regulatory databases for
current and historic known releases or uses of hazardous substances and/or petroleum products.
Historic land uses identified in the 2004 Phase | and ranked as having a potential moderate or high
impact were included in the updated Final Environmental Impact Statement (FEIS) Site Ranking
tables for Packages 2 and 4, and the Combined Alternative Package. Sites within 0.5 mile of the
corridor were classified following the DEIS methodology, with a minor deviation. For the 2009
Addendum, all Resource Conservation and Recovery Act (RCRA) generators (Conditionally
Exempt Small Quantity, Small, and Large) and registered tanks that had no documented releases or
violations were ranked as having a low potential to impact the project. This ranking methodology
differed from the 2004 Phase | methodology, which included all registered generators and tanks
within 2,000 feet of the project. As a result, the number of moderate or high potential impact sites
considerably decreased between the 2004 and 2009 evaluations. All sites identified in the database
search and located within 0.1 mile of the CAP project footprint were evaluated for potential risks to
the project. Many were ranked as low, due to their minimal potential to impact the project. A low
potential for impact to the project still exists from generators and other low ranking sites, so all
acquisition sites would need to be re-evaluated after final plans are developed. Liability associated
with acquisitions was not used as a risk identifying criterion.

Description of the Combined Alternative Package (Preferred Alternative) Project Work:

Through public comments and agency and community support, a new hybrid alternative package
was developed that contained aspects of both build Packages 2 and 4. The new and preferred
build option is referred to as the Combined Alternative Package (Preferred Alternative). The
Preferred Alternative would add one managed lane in each direction on United States

Highway 36 (US 36) and auxiliary lanes between most interchanges. In addition, the Preferred
Alternative would improve cross street intersections and interchanges, including lane transitions
of ramp terminals, widening cross streets at intersections, lengthening turn-lanes, and adding
turn-lanes.



Conclusion

Because of the time that has passed since the DEIS was completed, the Colorado Department of
Transportation (CDOT) reviewed the hazardous material sites within 0.5 mile of the new
Preferred Alternative project footprint. Identified sites were then ranked low, moderate, or high
based on such factors as proximity to the corridor, known or suspected contamination, and potential
for contamination to migrate. Sites identified that have a moderate or high potential to impact the
Preferred Alternative footprint are described in Section 4.17, Hazardous Materials, of the FEIS.

The construction activities and the proposed mitigation for the Preferred Alternative are
consistent with the conclusions provided in the original DEIS. As discussed in the FEIS, when
the project enters final design, additional information will be known about required right-of-way
and acquisitions. At that time, further investigations will be made to characterize the extent and
quantity of hazardous material sites impacted by the project.

In summary, the Preferred Alternative footprint has fewer high ranking hazardous material sites
within the proposed footprint than Packages 2 or 4. At this stage in the Preferred Alternative
development and design process, there are no known hazardous material sites that present
sufficient risk such that an alignment would be changed.

If you have any questions regarding the content of this letter, please contact me at
(303) 757-9935.

Sincerely,

Soradh Cuaste.

Sarah Czajka

CDOT - Region 6

Project Environmental Manager
Hazardous Materials

Attachments: Figures 1 through 10 and Related Data Sheets
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| Fac_ility Registry System (FRS) . R Share

Recent Additions | Contact Us | Search: (DAl EPA @ This Area I . i Go.
You are here: EPA Home  Envirofacts FRS  Report R '

Facility Name: || TPIPETROLEUM INC #4147 |

Location Address: I 7285 PECOS STREET |
Supplementat Address: | ' .
City Name: |  WESTMINSTER

i 'State : : o &¢] - |

. Countx Name: ADAMS : I
Z1P/Postal Code: " : 802212761

Il

EPA Region: 08
Conqressional District Number: _ _ 02

o - [ Legislative District Number: "
[ HUCCode: |r 10190004 |

L

- Federal Facility: " L o |

.| US:Mexico Border Indicator: " NO |
L grbaliand: NO ]
1B Latitude: 39.828525 ]

Longitude: -105.006155 |

Method: ADDRESS MATCHING-HOUSE NUMBER]

Reference Point Description: | _]
Duns Number: - I -I

Registry ID: | 110009557158 |

[~ Map this facility ]

EnVironmentaI Inter'eSts

L

) - - o - s “WMM
- |Information |Information Environmental Interest |[Data Last Su : lemental
System System ID - |[Type ' Source Undated . Environmental
: - Date Interests:
[ ars/ars || 0800100856 AIR MINOR () AIRS/AFS || 09/24/2008 ||
ICRITERIA AND HAZARDOUS
NEI NEICOOB5S |AIR POLLUTANT INVENTORY|| oV N
‘ - UNSPECIFIED UNIVERSE
RCRAINFO C00000733451 || (NACTIVE) RCRAINFO || 12/22/1995

| Facility Mailing Addresses
I T I [ 1




l Affiliation Type n Delivery Point ”Citv Name"State"Posta! Code"Information Svstem“

[FACILITY MAILING ADDRESS|[5590 HAVANA  |[DENVER |[co {80239 |lAIRS/AFS I
[REGULATORY cONTACT _ |[5590 HAvANA sT|[DENVER llco  J[so23s [IRCRAINFO 5
[FACILITY MAILING ADDRESS][5590 HAVANA STJ[DENVER o - [80239 |IRCRAINFO | ]
[owNER {lPo BOX 500 [iDENVER  |lco  ||80201 |[RCRAINFO

NAICS Codes

:.5' |Data_Sourcel|[NAICS Codel[Description||Primary|

L NE - || 4471  ||- N | _ |
- SIC Codes
IData Source”SIC Co@l Description '|1Primary|

AIRS/AFS ~5541 |GASOLINE SERVICE STATIONS|| - - |

NEI 5541 |GASOLINE SERVICE STATIONS

Contacts

[Affiliation Type |Full Name ||office Phone|[Information System||Mailing Address
{|COMPLIANCE CONTACT||  VICTOR VALADEZ || 3033736019 J[AIRS/AFS I
|[PERMITTING CONTACT]| (I |lRCRAINFO IR

[REGULATORY CONTACT||ALICE NIGHTENGALE LUH|| 3033736019 |[RCRAINFO ~ I View |

Organizations
|Affiliation Type"Name ||DUNS Number"Information System|Mailing Address

| OownER  |[TOTAL PETROLEUM INC| |[RcrAINFO - View

" Alternative Names

|Alternative Name ' |lsource of Data

[ TOTAL STATION #2344 |[NoTIFICATION (RCRA)
| TOTAL PETROLEUM NUMBER 4147 [ Ars/aFs |
[TOTAL PETROLEUM INCORPROATED - NUMBER 4147| MANUAL ENTRY _|
| TPI PETROLEUM INC. #4147 AIRS/AFS
[ DIAMOND SHAMROCK REFINING & MARKETING || AIRS/AFS

Query executed on: MAR-19-2009

EPA Home | Privacy and Security Notice | Contact Us




| Home | Search | Help |

Event _ . - i

Event Id 10243 ' Facility

Logged By Tina Sandoval =~ On Friday, November 03,2006 9804 - DIAMOND SHAMROCK 4147 |
Reviewer Bobby Sornier - 3 7285 PECOS ST

. - : DENVER, CO 80221, ADAMS County

Site Name DIAMOND SHAMROCK 4147 - . Category Retail Gas Station.

Locationl 7285 PECOS ST : :

Location2

Location3

City,County,Zip DENVER, ADAMS, 80221

Source of Release - o Status Closed o - Site Classification 3.1
: : . s _ o MTBE Classification
Cause of Release . o Projected Closure
: ' Date

- Sardo:iyx Primary ID: USADMTOT
Sardonyx Secondary ID: 006

Activity  Classify

Date : ' Activity
11/2/2006 Confirmed Release Reported
11/9/2006 SSF / SCR Request Letter Sent
12/27/2006 SSF - Site Summary Form Received
12/27/2006 Change Status '
2/9/2007 SCR Deadline Extension Request Received
2/13/2007 SCR Deadlme Extension Approval Letter Sent

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
0 ‘please contact the Public Records Center to schedule a file review at
(303) 318 8521 or (303) 318-8522.

CDLE | Stak

Labor and Empluyman

Copyright © 2000, Colorado Dept, of Labor and Employmcnt
. Developed by Greenbner & Russel, Inc.

You are currentls.f logged into database COSTIS as Public . .




|Home | Search | Help|

~ Event - . .
. Event Id 9592 : Facility
Logged By Tina Sandoval ' On Wednesday, September 01, 7859 - AE GAS AND FOOD
2004 7490 PECOS ST
Reviewer Mike ' : ' DENVER, CO 80221, ADAMS County .
Kwiecinski _ Category Retail Gas Station

Site Name WORKINGMANS FRIEND #515
Locationl 7490 PECOS ST

5 Location2

Location3 -

’ City,County,Zip DENVER, ADAMS, 80221 -

Source of Release Tank - corrosion outer . Status Closed o - 8ite Classification
: : o .MTBE Classification
© Cause of Release : . ' - Projected Closure
' ' : Date

‘Sardonyx Primary ID: USADMPUM
_ Sardonyx Secondary ID: 001

Activity ~Classify

Date ' Activity
. 8/31/2004 Confirmed Release Reported : -
9/1/2004 SSF / SCR Request Letter Sent
9/2/2004 Other Notable Reports Received
10/14/2004 SCR Deadline Extension Request Received
10/14/2004 SCR Deadline Extension Approval Letter Sent
10/14/2004 Change Status
10/18/2004 SSF - Site Summary Form Received
11/26/2604 SCR Deadline Extension Request Received
11/26/2004 SCR Deadline Extension Approval Letter Sent
12/17/2004 SCR - Site Characterization Report Received
1/25/2005 - - - CAP Request Letter Sent
1/25/2005 Change Status
2/11/2005 - Phone Call Received
3/ 172005 - CAP Final Request Letter Sent
3/25/2005 . Site Visit
2/7/2006 - Phone Call Made
7/6/2006 " Change Status
1/11/2007 "~ Phone Call Received
- 1/16/2007 Phone Call Received
- 3/5/2007 Phone Call Received
3/29/2007 Closure Letter Sent (LT RBSLs)

4/3/2007 Closure Request Received

Log in is for Oil and Public Safety Employees only. For more detailed mformatlon '

Leg In
a 9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

CI'JLE | Stats

Labor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




|Home | .Search | Help |

Event _ 0
- Event Id 6552 Alt Event Id Facility
~ Logged By . On Tuesday, May 12, 1998 2018 - JOE BRONCUCIA
" . Reviewer Coiter 120 E 70TH AVE
: DENVER, CO 80221, ADAMS County
Site Name JOE BRONCUCIA SAND & GRAVEL Category Commercial/Industrial
Locationl 120 E 70TH AVE
Location2 : '
Loeation3

City,County,Zip DENVER, ADAMS, 80221

Source of Release - o . Status Closed Site Classification o
R - " MTBE Classification
Cause of Release " .- . Projected Closure

Date

Sardonyx Primary ID: USADMBRO
Sardonyx Secondary ID: 003 '

Activity Classify -

Date ' Activity
5/1/1998 Confirmed Release Reported o
5/1/1998 Tank Release Under Control
5/1/1998 LUST Cleanup Initiated: Petroleumn
7/8/1998 Request for CAP

10/26/1998 Request for Extension
1/25/1999 Site Cleanup Completed
1/25/199% CR - No Further Action Required

5/4/1999 Send Closure Letter - NFA

Log in is for Oil and Public Safety Employees only. For more detailed information

Log in
w °9 please contact the Public Records Center to schednle a file review at
' (303) 318-8521 or (303) 318-8522. T

_ ’

CDLE | Stat -

Lobor and Employment

Cepyright © 2000, Colorado Diept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




' | Home | Search | Heip |

Event _
“Event Id 8804 . Facility
. Logged By Kathleen Turner On Tuesday, December 04, = 7861 - AMMCO LLC
; 2001 . © 7310 BROADWAY
Revnewer Tim Kelley .3 T DENVER, CO 80221, ADAMS County

Category Retail Gas Station
Site Name FAIRWAY OIL #406 o o -
Location1 7310 BROADWAY - ' : _ |
Location2 - S L : ; |
‘Location3 '
City,County,Zip DENVER ADAMS, 80221

Source of Release -~ _ Status Closed - Site Classification
_ ' . MTBE Classification
Cause of Release . o Projected Closure
' a Date

Sardonyx Primary ID: USADMFAI
Sardonyx Secondary ID: 001

Activity Classify

f Date Activity
11/28/2001 Confirmed Release Reported .
12/4/2001 SSF / SCR Request Letter Sent
: 12/19/2601 Other Notable Reports Received
3/28/2002 Change Status

Log in is for Oil and Pubhc Safety Employees only. For more detailed information

Log in
0 °9 please contact the Public Records Center to schedule a ﬁie review at
(303) 318- 8521 or (303) 318-8522,

STRT a2

.. E CDLE | Stat

tabor and Empioyment

Copyright © 2000, Colorado Dept. of Labor and Employment . -
. Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




| | Home | Search | Help |

Event

Event Id 2047
Logged By

Reviewer Joe'l Lambe

Alt Event Id 9000904-1
On Tuesday, February 11, 1992

Site Name DENVER INSTITUTE OF TECHNOLOGY
Locationl 7350 N BROADWAY

Locatlonz
Locat10n3

Clty,County,le DENVER, ADAMS 80221

Source of Release

Cause of Release

© Status Closed

- Sardonyx Primary ID: USADMDEN
Sardonyx Secondary ID: 007

Activity Classify

Date
2/11/1992
2/11/1992
8/18/1992
8/18/1992
8/18/1992

9/9/1992

Confirmed Release Reported

CR - No Further Action Required
LUST Cleanup Initiated: Petroleum
Tank Release Under Control

Site Cleanup Completed

Send Closure Letter - NFA

Facility

12757 - DENVER INSTITUTE OF TECHNOLOGY
7356 N BROADWAY = -

DENVER, CO 80221, ADAMS County

Category Other _ :

- Site Classification
~ MTBE Classification
* Projected Closure
Date

' :Activity

Log in is for Oil and Public Safety Employees only. For mbre detailed information

Log in
0 °9 pledse contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

Developed by Greenbrier & Russel. Inc. .

P Yéu'are curréntly logged into database_COSTIS as Public

Tabor ond Employment

CDLE | Statu







Facmty Reglstry System (FRS) = = s

‘Recent Addltlons | Contact Us | Search: OAll EPA .Thls Areal r GO .
You are here: EPA Home Envirofacts ERS Report o ‘

| Facility Name: i MOUNTAIN STATES TOYOTA |

Location Address: || 7300 NORTH BROADWAY
| Supplemental Address: "
City Name: . DENVER
State I ____co

_County Name: l ~ADAMS |
ZIP/Pgstal Code: "_ 80221 ; —

" EPA- Reglon ' 08
!@mnqressmnal District Number: 02

Legistative District Number: :
HUC Code: © . ©.10190004

|

|

|

Federal Facility: l

'US Mexico Border Indicator: . NO |
. Tribal Land ; - . . No ]
Latitude: - 39.828859 |
Longitude; ' -104.987693 |

_ |

| Method: __||ADDRESS MATCHING-HOUSE NUMBER
§ Reference Point Descrigtiog:_

} |
Duns Number: _! - . ]
|

Registry ID: [ 110009565531

[ . Map this facility _‘_;_]'

Environmental Interests

Information |[Information Environmental Data Source Undated |lenvironmental
System System ID Interest Type Il Date Nlinterests:
: o RCRAINFO-
ECOMAP COM000001334 STATE MASTER ECOMAP . . COR000010348
L SQG
RCRAINFO ‘ COR000010348 || SQG (ACTIVE) Nonlgéif)’xow || 09/30/2008

Facility Mailing Addresses
: || Affiliation Type _” Delivery Point |ICitv Name“State"Postal Code"Information System




|OPERATOR - ___|l7300 N BROADWAY |[DENVER _ [[cO (80221 [[rerAINFO

|
[FACILITY MAILING ADDRESS|[201 W 70TH AVE  |[DENVER |[cO |[80221 [RCRAINFO |
REGULATORY CONTACT 201 W 70THAVE_|[DENVER _|[cO__][80221 |[RCRAINFO |
OWNER 1650 W. 104TH AVE[THORNTON|[cO  |[80234 [[RcrAINFO 1l
FACILITY MAILING ADDRESS|[7300 N BROADWAY [[DENVER _[ico  ||g0221 |IRCRAINFO ]

- NAICS Codes

No NAICS Codes returned. -

‘SIC Codes

No SIC Codes returned.

‘Contacts

_!Aﬂ’iliation Type . - ”Ful[ Name = |]bffice thﬁll_nformation Sy. stem“Mailing Address|

| PERMITTING CONTACT | l ~|rcramnre |

I

[REGULATORY CONTACT|[SERVICE MANAGER[ 3034261026 |[RCRAINFO ||

Organizations

|

|Affiliation Type lName ‘ ||DUNS Nu_mb_e_u:“!nformatlon Svstem"Ma!hn Address

[ _OPERATOR _J[MOUNTAIN STATES TOYOTA & SCION|| IRCRAINFO
[ ownErR LARRY H MILLER | lRcraInFO

[ opERATOR || MOUNTAIN STATES TOYOTA || ~ |[rcraInFO

Alternative Names

Alternative Name ||Source of Datal
LARRY MILLER TOYOTA||  ECOMAP |

Query executed on: MAR-19-2009

EPA Home | Privacy and Security Notice -I;Contact Us

Last updated on Thursday, March 19th, 2009 o

http://oaspub. epa gov/enwro/fn query dtt. dxsp_program facmty'?pgm SYS_] 1d _in= COR000010348&pgm _Sys_acrnm_.in= RCRAINFO

Print As-fs

Thls document W|II now print as it appears on screen when you use the F|!e » Prlnt command.

Use Vlew » Refresh to return to original state.




Facility __:Registry System (FRS) snare

Recent Additions | Contact Us | Search: (OAIl EPA @ This Area | Pl
You are here: EPA Home  Envirofacts FRS  Report o .

Focilty Name: ____ ]| RSLINC. DENVER BRANCH ||
Location Address: || 7100 BROADWAY #6-C |
- I Supplemental Address:_l'_;- ; " BLDG6UNITC _ |
[~ CiyNeme: [ DENVER |
[ State | co
County Name: . “ o DENVER
ZIp/Postal Code: . || 80221 ]
[ EpARegion: | o8

Congressional District Number-:" .
Legislative District Number: |
HUC Code: |

Federal Facility:

US Mexico Border Indicator: | _ NO

Tribal Land : - || NO
Latitude: I 39.826352
Longitude: I -104.984837

Method: ||ADDRESS MATCHING-HOUSE NUMBER

‘| Reference Point Description: ||
Duns Number: |

Registry ID; i 110008302791 ]

|... Map this facility. |

Environmental Interests

y . . . Last Suppleme;tal
J{Information Information Environmental -

Svsterm System ID ——InterestT o Data Source Updated Environmental
System =ysiem LD ~nierest ype Date Inte5_§§ts:

I RCRAINFQ " COD983798950 || CESQG (ACTIVE) NOT(I&%T)ION " 12/24/1992

Facility Mailing Addresses

| Affiliation Type || Delivery Point || City Name"State"_Eostal Code| Information Systeml

[ownER |[1701 DALSHANK |PFLUGERVILLE[[TX_][78660 [RCRAINFO ]
FACILITY MAILING ADDRESS][7100 BROADWAY #6-Cl[DENVER ||co |80221 “RCRAINFO |




:REGULATORY CONTACT  [[7100 BROADWAY #6-C||DENVER llco Jlso221

[reramnFo
'NAICS Codes
No NAICS Codes returned.

SIC Codes

No SIC Codes returned.

Contacts
Affiliation Type

HFuII Name HOfﬁce Phone”Informatlon S_y_stem”Mallmg Addres_|
REGULATORY CONTACT][EARL WILLIS][ 3036570525 |[RCRAINFO A View
| PERMITTING CONTACT | I [RCRAINFO l \
- Organizations
lAfflIlation Tvne”Name !!DUNS Number”Information Svstem”MalImg Addres |
| OwWNER '

|[Rst IvC ]| IRCrAINFO ]l

View |

Alternative Names

No Alternative Names returned

- Query executed on: MAR-19-2009 . -

o :I_E'PA Hoine EPrivacx and Security Notice | ContactUs ' :
.-Last updated on Thursday, March 19th, 2009,

http /foaspub.epa. gov/enwro/ﬁ_query dtI dlsp_program facility?pgm_sys_id_in= COD983798950&pgm sys acrnm_in=RCRAINFO
Print As-Is

This document will now prmt as it appears on screen when you use the File » Prlnt command..
) - Use V|ew » Refresh to return to orlglnai state.




NATIONAL RESPONSE CENTER 1-800-424-8802
*%** For Public Use *#%%
Information releazed to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Léﬁs

Incident Report # 576083

INCIDENT DESCRIPTION . »

#%&* THIS IS A POTENTIAL RELEASE *#%%%

*Report taken at 22:30 on 10-AUG-01

Incident Type: FIXED

Incident Cause: OTHER

Affected Area: o

The incident waz discovered on 10-AUG-01 at 15:53 local time.

Affected Medium: OTHER

SUSPECTED RESPONSIELE PARTY .

XX

Type of Organization: UNKNOWN

INCIDENT LOCATION

7604 HEATHER PL County: ADAMS
City: DENVER State: CO

POTENTIALLY RELEASED MATERIAL(S)

DESCRIPTION OF INCIDENT

THE CALLER IS REPORTING A METH LAB BEING DISCOVERED AND BEING DISPOSED OF.

INCIDENT DETAILS

Package: N/A

Building ID:

Type of Fixed Object: OTHER
Power Generating Facility: NO
Generating Capacity:

Type of Fuel:

NPDES:

NPDES Compliance: UNKNOWN

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: NO Hospitalized: Empl /Crew:
FATALITIES: NO Empl /Crew: Passenger:
EVACUATIONS: NO Who Evacuated: Radius/Area:
Damages: NO
Length of

Closure Type Description of Closure Closure
Alr:

N
Read: N

Waterway: N

Passenger:
Occupant:

Direction of

Clogure

Major
Artery:




Track: N

Pagsengers Transferred: UNKMNOWN
Environmental Impact: UNKNOWN
Media Interest: NONE Community Impact due to Material: NO

REMEDIAL ACTICNS
TESTED THE ACID AND BAGGED THE MATERIAL, POLICE HAS TAKEN ACTION

Releage Secured: UNKNOWN
Release Rate:
Estimated Release Duration:

WEATHER

Weather: CLEAR, 60°2F

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: POLICE DEPT
State/Local On Scene:

State Agency Number: NO REPORT #

NOTIFICATIONS BY NRC -
ATSDR CO ATTN:JANET JONES (PRIMARY)
10-AUG-01 22:35

U.S. EPA VIII (PRIMARY)
10-AUG-01 22:58

NOAR 1ST CLASS BB RPTS FOR CO (PRIMARY)
10-AUG-01 22:35

CO OIL & GAS CONSERVATION COMM (PRIMARY)
10-AUG-01 22:35 AR

DOI/QEPC DENVER (PRIMARY)
10-AUG-01 22:35

ADDITIONAL INFORMATION
THE CALLER HAD NO ADDITIONAL INFORMATION.

*%¥%* END INCIDENT REPORT # 576083 Tk x




| | Home | Search | Help |

' Event

Cause of Release

Activity  Classify

Date
5/2/1989
8/16/1990
8/16/1990.

11/7/1994
- 9/22/1995
- 10/25/1995
- 8/12/1996
' 9/24/1996

12/16/1996

1/13/1997

4/1/1997

9/26/1997

4/8/1999

10/12/1999

12/13/1999

5/12/2000

5/18/2000

5/4/2001

5/17/2001

10/11/2001

5/2/2002

11/6/2002

11/29/2002

2/26/2003

4/2/2003

5/28/2003 -

7/17/2003

11/20/2003
- 1/16/2004
. 1/26/2004
C2/25/2004
- '3/11/2004

7/23/2004

10/21/2004

12/3/2004

4/1/2005

7/11/2005

Source of Release Tank

8/16/1990
| 2112/1991
3/25/1991 .o

Event Id 253 Alt Event 1d 6073-1 Facility : '
Logged By On Thursday, August 16 1990. 6607 - DON'S SHERRELWOOD 66 -
- Reviewer Vinny Secondo ' 7590 PECOSST.
- DENVER, CO 80221; ADAMS County
Site Name AMOCO OIL #8339 . Category Retail Gas Station
Locationl 7590 PECOS ST SR Do
‘Location2
Location3

City,County,Zip DENVER, ADAMS, 80221

Status Open. -~ Site Classification 2.7
. : - .. .MTBE Classification 2
-~ Projected Closure
. Date -

Sardonyx Primary ID: USADMAMO
Sardonyx Secondary ID: 014

. - Activity
Other Notable Reports Received
Confirmed Release Reported

- LUST Cleanup Initiated: Petroleum

Site Investigation Completed

SA/FAN 2 - Further Action Neccessary Priority 2
General Correspondence

Other Notable Reports Received
Other Notable Reports

Other Notable Reports

Request for CAP

CAP - Corrective Action Plan
Monitoring Report

CAP Denial Letter Sent

CAP - Corrective Action Plan

CAP Denial Letter Sent -

CAP - Corrective Action Plan

CAP Conditional Approval Letter Sent
Monitoring Report '

Monitoring Report

CAP Approval Letter Sent

Monitoring Report Received

Change Status

Monitoring Report Received _
Monitoring Report Received -
Phone Call Received :
Monitoring Report Received

Other Notable Reports Received:

CAP Modification Request Sent
CAP Deadline Extension Request Received
Electronic EFS Received
Monitoring Report Received

Phone Call Made -

CAP Conditional Approval Letter Sent
Monitoring Report Received

CAP Conditional Approval Accepted
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received



9/20/2005
1/3/2006
2/23/2006
3/10/2006
3/15/2006
5/15/2006 -
5/19/2006.
6/21/2006
6/22/2006
9/5/2006
12/26/2006

212712007

- 10/17/2007
11/8/2007
1/25/2008

5/23/2008

- 10/27/2008
1/15/2009
2/2/2009
3/10/2009

Log in is for Oil and Public Safety Efnployees only. For more detailed information

Log In Coe
o o8 please contact the Public Records Center to schedule a file review at

Monitoring Report Received

Monitoring Report Received

Monitoring Report Received

CAP Modification Request Sent _
MTBE Initial Report Deficiency Letter Sent
CAP Addendum/Modification Received
Other Notable Reports Received

. MTBE MARS Report Requested
- CAP Modification Approval Letter Sent
~ Monitoring Report Received
. Monitoring Report Received
. ~Monitoring Report Received
~ MTBE MARS Report Received
. Miscellaneous Correspondence Sent
- Monitoring Report Received

Monitoring Report Received

' Monitoring Report Received

Monitoring Report Received
Miscellaneous Correspondence Sent
Monitoring Report Received

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colerado Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc,

You are currently logged into database COSTIS as Public

.. habor and Employment
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Event

Event Id 6816 Alt Event Id
Logged By On Tuesday, August 25, 1998
Reviewer Tom Fox

Site Name 7 ELEVEN #13167
Laocationl 7540 PECOS ST
Location2

Location3
City,County,Zip DENVER, ADAMS, 80221

Source of Release Tank . Status Open

Cause of Release

' Sardonyx Primary ID: USADMSEV
Sardonyx Secondary ID: 015

Activity Classify

Date -
6/2/1998 - Site Assessment Request.-
6/2/1998 Confirmed Release Reported
6/2/1998 Site Assessment Request Letter Sent
8/21/1998 .~ SA/FAN 3 - Further Action Neccessary Priority 3
4/15/1999 . CAP - Corrective Action Plan
7/9/1999 : Monitoring Report
8/16/1999 - CAP Conditional Approval Letter Sent
11/23/1999 Monitoring Report
5/12/2000 ' Monitoring Report
12/20/2000 Monitoring Report Received
5/16/2001 : Change Status
6/18/2001° Monitoring Report Received
11/16/2001 Monitoring Report Received
12/12/2001 CAP Modification Request Sent
©2/13/2002 Monitoring Report Received
. 4/30/2002 Monitering Report Received
o 81772002 CAP EFS Effective Date
. 9/13/2002 Monitoring Report Received
10/17/2002 Monitoring Report Received
2/6/2003 CAP Modification Request Sent
3/10/2003 Monitoring Report Received
3/27/2003 Electronic EFS Received
3/31/2003 CAP Addendum/Modification Received
5/14/2003 CAP Modification Approval Letter Sent
5/16/2003 Monitoring Report Received
7/31/2003 Monitoring Report Received
11/19/2003 _Monitoring Report Received
2/9/2004 ~ Monitoring Report Received
5/17/2004 . Monitoring Report Received
8/23/2004 “Monitoring Report Received
12/16/2004 ~ Monitoring Report Received
1/28/2005 Monitoring Report Received
5/5/2005 Monitoring Report Received
8/26/2005 Monitoring Report Received
12/172005 Monitoring Report Received
2/16/2006 Monitoring Report Received
4/13/2006 MTBE MARS Report Requested
6/6/2006 Phone Call Received
6/12/2006 CAP Addendum/Modification Received

9/1/2006 . Monitoring Report Received

Facility

9163 - 7-ELEVEN #13167

7540 PECOS ST

DENVER, CO 80221, ADAMS County
Category Retail Gas Station

Site Classification: 3.2
MTBE Classification 2

Projected Closure
Date

Activity



9/27/2006
10/2/2006
10/16/2006
11/1/2006
3/23/2007
5/23/2007
7/25/2007
7/26/2007
8/20/2007
8/20/2007
12/11/2007
4/18/2008
7/31/2G08
10/16/2008
11/5/2008
12/19/2008

Log in is for Oil and Public Safety Employees only. For more detailed information

) Log In
e : o9 please contact the Public Records Center to schedule a file review at

CAP EFS in Negotiation
Electronic EFS Received

CAP Modification Approval Letter Sent

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Phone Call Received

Closure Denial Letter Sent -
Phone Call Received . -
Monitoring Report Received
Monitoring Report Received -
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Phone Call Received
Monitoring Report Received

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc.

You are currently logged info database COSTIS as Public

Laber and Employment

CDLE | Stat:
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Event
Event Id 9069 - Facility
Logged By Tina Sandoval On Wednesday, November 13, 9804 - DIAMOND SHAMROCK 4147
2002 7285 PECOS ST o
Reviewer John Gould =~ DENVER, CO 80221, ADAMS County

Site Name SHAMROCK #4147

Category Retail Gas Station

Locationl 7285 PECOS ST

Location2
Location3

City,County,Zip DENVER, ADAMS, 80221

Source of Release Dispenser_'

Cause of Release

- ‘Sardonyx Primary ID: USADMTOT

Status Open o "~ Site Classification . 3.2
' : ~ - . -MTBE Classification -3
 Projected Closure -
Date;' .

Sardonyx Secondary ID: 006

~ Activity Classify

- 11/8/2002
- 11/12/2002
11/14/2002
1/17/2003

" 3/27/2003
6/26/2003
7/24/2003
8/26/2003
8/28/2003
8/29/2003
11/3/2003
11/5/2003
1/20/2004
1/20/2004
1/20/2004
1/26/2004
6/24/2004
8/20/2004
12/7/2004
1/25/2005
5/9/20065
7/5/2005
11/28/2005
1/23/2006
4/24/2006
7/13/2006
8/14/2006
8/15/2006
10/9/2006
10/25/2006
11/3/2006
11/16/2006
1/29/2007
3/2/20077
3/21/2007
4/16/2007

- 6/28/2007
-6/28/2007
8/21/2007

Activity
Suspected Release Reported | '
Confirmed Release Reported
SSTF / SCR Request Letter Sent
SSF - Site Summary Form Received
SCR - Site Characterization Report Received
SCR Final Request Letter Sent
Change Status '
SCRDeadline Extension Request Received
SCR Deadline Extension Approval Letter Sent
Monitoring Report Received
SCR Deadline Extension Request Received
SCR Deadline Extension Approval Letter Sent
Sent to Enforcement
Monitoring Report Received
SCR - Site Characterization Addendum Received
Receive Misc Correspondence
Monitoring Report Received
Monitoring Report Received
Phone Call Made
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Change Status
Phone Call Received
Monitoring Report Received
Phone Call Received
Other Notable Reports Received
Site Visit '
MTBE MARS Report Requested
Monitoring Report Received
Monitoring Report Received
SCR - Site Characterization Report Received
CAP EFS Effective Date

' CAP Request Letter Sent

Change Status
CAP Deadline Extension Request Received . . -



8/21/2007 CAP Deadline Extension Approval Letter Sent .

10/25/2007 CAP - Corrective Action Plan Received
1/10/2008 CAP EFS in Negotiation '
27112008 CAP Approval Letter Sent
2/12/2008 Request for Extension
2/25/2008 " Request for Extension
2/26/2008 Change Status ‘

3/28/2008 ' Monitoring Report Received
3/28/2008 MTBE MARS Report Received
9/3/2008 Monitoring Report Received

12/10/2008 Monitoring Report Received

1/2/2009 Monitoring Report Received

Log in is for Oil and Pubhc Safety Employees only. For more detalled mformatmn

Log in
o °8 pledse contact the Publlc Records Center to schedule a ﬁIe revxew at
(303) 318-8521 or (303) 318-8522. '

iober and Employment

" Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public
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- Event o
. Event Id 2417 Alt Event Id 2211-1 - Faclhty
Logged By On Thursday, August 27, 1987 2814 - EVERYDAY STORE #5719
- Reviewer Vinny Secondo o © .. 7990 N FEDERAL BLVD
: : WESTMINSTER, CO 80030, ADAMS County
Site Name CIRCLE K #8519 . . Category Retail Gas Station
Locationl 7990 N FEDERAL BLVD .
Location2
Location3

City,County,Zip DENVER, ADAMS, 80221

Source of Release _ Status Open - - . = . Site Classification 2.6 -
. : v ...  MTBE Classification 3 .
Cause of Release _ .. .. . - . Projected Closure
: ' ' ' . Date

- Sardonyx Primary ID: USADMCIR
Sardonyx Secondary ID: 005 i
N 7 \ 000
Activity Classify R L :
' Date Activity -

8/27/1987 SA/FAN 3 - Further Action Neccessary Priority 3
8/27/1987 Fund Application Received
10/17/1989 Confirmed Release Reported
12/6/1989 Site Assessment Request
1/7/1991 SA/FAN 1 - Further Action Neccessary Priority 1
4/21/1991 Request for CAP
4/23/1991 SA/FAN 1 - Further Action Neccessary Priority 1.
4/29/1991 LUST Cleanup Initiated: Petroleum- N
8/26/1991 SA/FAN 1 - Further Action Neccessary Priority 1 -
12/20/1991 Other Notable Reports
8/19/1992 SA/FAN 1 - Further Action Neccessary Priority 1
9/3/1992 Request for CAP
4/23/1993 SA/FAN 1 - Further Action Neccessary Priority 1
6/7/1993 : SA/FAN 1 - Further Action Neccessary Priority 1
7/15/1993 General Correspondence
 8/25/1993 Monitoring Report
11/26/1993 Monitoring Report
2/22/1994 Other Notable Reports
3/28/1954 Monitoring Report
4/12/19%94 - Request for CAP
5/26/1994 : Monitoring Report
6/20/1994 "CAP - Corrective Action Plan
7/7/1994 Tank Release Under Control
7/12/19%4 CAP Conditional Approval Letter Sent
8/4/1994 : CAP - Corrective Action Plan
8/8/1994 CAP Approval Letter Sent
9/1/1994 Monitoring Report
12/7/1994 Monitoring Report
3/2/1995 Monitoring Report
6/5/1995 Monitoring Report
8/31/1995 Monitoring Report
12/4/1995 Monitoring Report
5/6/19%96 Monitoring Report
6/19/1996 REV Cleanup Completed
11/18/1996 Other Notable Reports
5/16/1997 : Monitoring Report
12/3/1997 Monitoring Report
7/24/1998 Monitoring Report
9/30/1998 Monitoring Report

4/8/1999 Monitoring Report




12/1/1999 Monitoring Report

8/18/2000 Monitoring Report
1/30/2001 Monitoring Report Received
3/26/2001 Monitoring Report Received
5/3/2001 Monitoring Report Received
517/2001 _Change Status .
71272001 " Monitoring Report Received
10/31/2001 .. Monitoring Report Received
12/14/2001 Other Notable Reports Received
3/13/2002 Monitoring Report Received
4/5/2002 Other Notable Reports Received
5/10/2002 Monitoring Report Received - -
7/31/2002 Monitoring Report Received
9/20/2002 Site Visit - RSIP '
11212002 . Monitoring Report Received - a
11/27/2002 . CAP' Addendum/Modification Recelved
2/6/2003 " CAP Modification Request Sent -
2/19/2003 Monitoring Report Received
4/2/2003 CAP Deadline Extension Request Received
4/5/2003 - CAP EFS Effective Date
4/7/2003 Deadline Extension Approval Letter Sent
4/17/2003 - - CAP Denial Letter Sent
5/6/2003 Receive Misc Correspondence
. 5/7/2003 - _ Receive Misc Correspondence
571272003 Meeting Held '
- 5/23/2003 Receive Misc Correspondence
. 6/10/2003 . Monitoring Report Received
7/10/2003 - Meeting Held
7/14/2003 CAP Deadline Extension Request Received
C /2172003 0 CAP Deadline Extension Approval Letter Sent
7/28/2003 Electrenic EFS Received
8/1/2003 - CAP Addendum/Modification Received ..
. 9/4/2003 Monitoring Report Received
C10/17/2003 - - Monitoring Report Received
1/26/2004 Monitoring Report Received
3/17/2004 Site Visit
-3/18/2004 Other Notable Reports Received
.. 372472004 : Electronic EFS Received
- 3/24/2004 CAP Addendum/Modification Received
- 4/5/2004 " Monitoring Report Received
5/3/2004 Signed EFS Received
5/3/2004 - CAP Conditional Approval Letter Sent . -
7/19/2004 Monitoring Report Received
10/19/2004 Site Visit - RSIP
- 11/17/2004 Other Notable Reports Received
2/1/2005 Monitoring Report Received
3/1/2005 CAP Implementation Report Received
3/7/2005 Other Notable Reports Received
4/26/2005 Monitoring Report Received
5/12/2005 Monitoring Report Received
5/18/2005 Receive Misc Correspondence
7/18/2005 Receive Misc Correspondence
7/25/2005 Monitoring Report Received
11/9/2005 Other Notable Reports Received
12/12/2005 Monitoring Report Received
1/19/2006 Other Notable Reports Received
2/23/2006 Other Notable Reports Received
4/18/2006 MTBE MARS Report Requested
4/21/2006 Monitoring Report Received
5/24/2006 Miscellaneous Correspondence Sent
6/5/2006 Monitoring Report Received
- 6/5/2006 Other Notable Reports Received
. 6/8/2006 Monitoring Report Received




8/24/2006 . Miécellaneous Correspondence Sent

12/26/2006 - Monitoring Report Received
1/8/2007 - .Phone Call Received
1/19/2007 . Monitoring Report Received
2/22/2007 - . Electronic EFS Received
2/26/2007 .. CAP Addendum/Modification Recewed
5/3/20067 ' " Monitoring Report Received
5/10/2007 ' CAP EFS in Negotiation
5/24/2007 . CAP Modification Approval Letter Sent
6/1/2007 Signed EFS Received _ -
6/19/2007 Receive Misc Correspondence
9/14/2007 Monitoring Report Received
10/29/2007 Monitoring Report Received
1/15/2008 Other Notable Reports Received
1/23/2008 Phone Call Received
1/25/2008 Site Visit '
2/14/2008 Monitoring Report Received
4/22/2008 Monitoring Report Received
6/10/2008 Miscellaneous Correspondence Sent
7/18/2008 Other Notable Reports Received
7/21/2008 CAP Addendum/Modification Received
7/21/2008 CAP EFS in Negotiation
7/30/2008 CAP Modification Approval Letter Sent
8/10/2008 Receive Misc Correspondence
8/13/2008 Monitoring Report Received
8/14/2008 Miscellaneous Correspondence Sent
8/19/2008 Monitoring Report Received
10/20/2008 Other Notable Reports Received
12/8/2008 Monitoring Report Received
12/17/2008 Miscellaneous Correspondence Sent
12/17/2008 Receive Misc Correspondence
1/206/2009 Other Notable Reports Received
1/28/2009 Monitoring Report Received
- 3/4/2009 Meeting Held

Log in is for Oil and Public Safety Employees only. For more detailed information

Login .
a °9 please contact the Public Records Center to schedule a file review at
' (303) 318-8521 or (303) 318-8522, -
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NATIONAL RESPONSE CENTER 1-800-424-8802

*%% For Public Use ***% .

Information released to a third party shall comply with any .
applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 585023

INCIDENT DESCRIPTION

*Report taken at 22:56 on 02-NOV-01

Incident Type: MOBILE ’

Incident Cause: TRANSPORT ACCIDENT

Affected Area: ROAD SIDE DITCH

The incident occurred on 02-NOV-0l1 at 18:03 local time.

Affected Medium: WATER ROAD SIDE DITCH

SUSPECTED RESPONSIBLE PARTY

Organization: SAFEWAY
DENVER, CO

Type of Organization: PRIVATE ENTERPRISE

INCIDENT LOCATION
8040 FEDERAL BLVD. County: ADAMS o
City: WESTMINSTER State: CO

RELEASED MATERIAL(S)

CHERIS Code: QDS Official Material Name: OIL: DIESEL
Also Known As: R

Qty Released: 30 GALLON(S) Qty in Water: 10 GALLON(S)

DESCRIPTION OF INCIDENT . -
THE MATERIAL SPILLED OUT OF THE SADDLE TANKS ON A TRACTOR TRATILER TRUCK DUE TO A
MULTI-VEHICLE ACCIDENT.

INCIDENT DETAILS

Road Mile Marker:

Length of Service Disruption:
Airbag Deployed:

~««SHEEN INFORMATION---
Sheen Color: OTHER

Sheen Odor Description:
Sheen Travel Direction:
Sheen Size Length: 6 FEET
Sheen Size Width: 1 FEET

~=~WATER INFORMATION---

Body of Water: ROAD SIDE DITCH
Tributary of: NONE

Nearest River Mile Marker:
Water Supply Contaminated: NO

---MOBILE INFORMATION---

Vehicle Type: TRACTOR TRAILER TRUCK

Vehicle MNumber: UNKNOWN Trailer/Tanker Number: UNKNOWN
Vehicle Fuel Capacity: 45

Cargo Capacity: 0 UNKNOWN AMOUNT

Cargo On Board: 0 UNKNOWN AMOUNT

Hazmat Carrier: NO

Carrier Licensed: NO




Suspected Non Compliance: NO

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: YES Hospitalized: = 4 “ 'Empl/Crew: ' T "Passenger:
FATALITIES: NO Empl/Crew: Passenger: Occupant :
EVACUATIONS: NO Whe Evacuated: Radius/Area: ' '
bamages: NO
Lehgth of Pirection of
Closure Type Description of Clogure Closure i '_-Cloéure
Air: N I '
Road: b4 FEDERARL: BLVD T3 ' '8 Major
Artery: ¥
Waterway: N
Track: N

Passengers Transgferred: UNKNOWN
Environmental Impact: UNKNOWN
Media Interest: NONE Community Impact due to Material: NO

REMEDIAL ACTIONS
BOOMS APPLIED,ABSORBENTS APPLIED,MATERIAL CONTAINED

Release Secured: YES
Release Rate:
Estimated Release Duration:

WEATHER

Weather: CLEAR, 402§

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: FIRE, POLICE, DHE

State/Local On Scene: FIRE, POLICE, HAZMAT
State Agency Number: NO REFORT #

NOTIFICATIONS BY NRC
ATSDR CO ATTN:JANET JONES (PRIMARY)
02-NOV-01 23:04

U.S. EPA VIII (PRIMARY)
02-NOV-0L 23:26

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
02-NOV-01 23:04

CO OIL & GAS CONSERVATION COMM (PRIMARY)
02-ROV-01 23:04

DOI/QOEPC DENVER (PRIMARY)
02-NOV-01 23:04

ADDITIONAL INFORMATION

*** END INCIDENT REPORT # 585023  ##%




NATIONAL: RESPONSE CENTER 1-800-424-8802

*%% For Public Use ***

Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 630853

INCIDENT DESCRIPTION

*Report taken at 17:43 on 04-DEC-02

Incident Type: STORAGE TANK

Incident Cause: EQUIPMENT FAILURE

Affected Area: STORM DRAIN

The incident was discovered on 04-DEC-02 at 10: 15 local tlme.

Affected Medium: WATER STORM DRAIN

SUSPECTED RESPONSIBLE PARTY

Organization: LOS ARCOS RESTAURANT
WESTMINSTER, CO

Type of Organization: PRIVATE ENTERPRISE

INCIDENT LOCATION
4991 WEST 80TH AVE County: ADAMS
City: WESTMINSTER State: CO

RELEASED MATERIAL(S)
CHRIS Code: NCC Official Material Name: NO CHRIS CODE
Also Known As: RESTAURANT WASTE MATERIAL (NON HAZARDOUS)
Qty Released: 0 UNKNOWN AMOUNT Qty in Water: (0 UNEKNOWN AMOUNT

DESCRIPTION OF INCIDENT

A HOLE OCCURRED IN A RESTAURANT DUMPSTER CAUSING RESTAURANT WASTE MATERIALS TO LEARK

INTO A STORM DRAIN.

INCIDENT DETAILS

Description of Tank: RESTAURANT DUMPSTER
Tank Above/Below Ground: ABOVE
Transportable Container: UNKNOWN

Tank Regulated: UNKNOWN

Tank Regulated By:

Tank ID:

Capacity of Tank:

Actual Amount:

-==WATER INFORMATION---

Body of Water: STORM DRAIN
Tributary of: LITTLE DRY CREEK
Nearest River Mile Marker:
Water Supply Contaminated: NO

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: NO Hosgpitalized: Empl /Crew: Passenger:
FATALITIES: NO Empl/Crew: ) Passenger: Occupant:
EVACUATIONS: NO Who Evacuated: o Radius/Area:

Damages: ~ NO




Length of Direction of

Closure Type Description of Closure - Cloguxe “Closure

Alr: N '

Road: N : . : - Major
 Artery:

Waterway: N R

Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWKN
Media Interest: NONE Community Impact due to Material: NO

REMEDIAL ACTIONS .
IN THE PROCES OF CLEANING THE DRAIN / WILL REPLACE THE DUMPSTER

Release Secured: YES
Release Rate:
Estimated Release Duration:

WEATHER

Weather: OVERCAST, °F

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: " STATE OF COLORADO
State/Local On Scene:

State Agency Number:

NOTTIFICATIONS BY NRC
ATSDR CO ATTN:JANET JOMES (PRIMARY)
04-DEC-02 17:51

U.S. EPA VIIT (PRIMARY)
04-DEC-02. 17:51

NOAA 15T CLASS BB RPTS FOR CO (PRIMARY)
04-DEC-02 17:51

CO CIL & GAS CONSERVATION COMM (PRIMARY)
04-DEC-02 17:51

DOI/OEPC DENVER (PRIMARY)
04-DEC-02 17:51

ADDITIONAL INFORMATION

NONE

#*%* END INCIDENT REPORT # 630853 *Ekk
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Event _

Event Id 9705 ' Facility
Logged By Tina Sandoval On Tuesday, January 04, 2005 17745 - WORLD SAVINGS

Reviewer Bobby Sonnier 7401 FEDERAL BLVD

WESTMINSTER, CO 80221 ADAMS County

Site Name WORLD SAVINGS Category Other -
Locationl 7401 FEDERAL BLVD
Location2
Location3

City,County,Zip WESTMINSTER, JEFFERSON, 86030

Source of Release Historical contamination Status Open - Site Classification 3.2
o ' MTBE Classification
Cause of Release e : Projected Closure
' ' ' Date

Sardonyx Primary ID: USADMWOR
Sardonyx Secondary ID: 001

Activity Classify

Date Activity
1/4/2005 Confirmed Release Reported
1/6/2005 SSF/ SCR Request Letter Sent

2/25/2005 Other Notable Reports Received
7/6/2006 Change Status
2/5/2007 Phone Call Made
3/15/2007 Miscellaneous Correspondence Sent
3/16/2007 Change Status
. 1/24/2008 Phone Call Made
7/25/2008 Phone Call Made
7/25/2008 Miscellaneous Correspondence Sent
7/31/2008 Phone Call Made
8/1/2008 "Phone Call Received
8/19/2008 Phone Call Made
9/2/2008 Phone Call Made
9/4/2008 Phone Call Made
9/4/2008 Phone Call Received
.- 9/9/2008 Suspected Release Reported
- .9/18/2008 Phone Call Made
10/16/2008 Phone Call Made
. 11/13/2008 Phone Call Received
-12/18/2008 Phone Call Made
1/15/2009 Phone Call Made

_Log in is for Oil and Public Safety Employees only. For more detailed information

Log in
@ ug _ please contact the Public Records Center to.schedule a file review at
-{303) 318-8521 or (303) 318-8522.

i  CDLE | Stat
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Event-~ . :
- Event Id 8264 Alt Event Id "~ Facility
Logged By : _ On Wednesday, July 05, 2000 15224 - COMMERCIAL BLDG
Reviewer John Gould =~ o _ 7397NFEDERAL BLVD _
- _ WESTMINSTER, CO 80030, ADAMS County
Site Name COMMERCIAL BLDG : E Category Other
Locationl 7397 N FEDERAL BLVD
Location2
Location3d

City,County,Zip WESTMINSTER, ADAMS, 80030

Source of Release Status Open Site Classification 27
' MTRE Classification
Cause of Release Projected Closure
L Date

Sardonyx Primary ID: USADMCOM
Sardonyx Secondary ID: 005

Activity ' Classify L o
Date : L . Activity -

6/19/2000 Confirmed Release Reported
7/5/2000 Site Assessment Request
7/12/2000 Other Notable Repeorts
8/7/2000 See Comments
10/13/2000 No Further Action Request Report Recewed
6/4/2001 SSF - Site Summary Form Received
6/6/2001 Change Status
7/26/2001 SCR - Site Characterization Report Received
9/4/2001 SCR Incomplete Letter Sent
/572001 SCR Deadline Extension Request Received
10/31/2001 Monitoring Report Received
11/7/2001 Phone Call Received
1/24/2002 SCR Final Request Letter Sent
2/1/2002 - Request for Extension Received
4/16/2002 : Request for Extension Received
5/31/2002 - SCR - Site Characterization Report Received
7/15/2002 - CAP - Corrective Action Plan Received
.8/12/2002 CAP Denial Letter Sent
9/4/2002 Monitoring Report Received
1/23/2003 Monitoring Report Received
4/22/2003- Phone Call Made
4/28/2003 Phone Call Made
7/16/2003 Monitoring Report Received
7/19/2004 Monitoring Report Received
12/16/2004 Meeting Held
1/7/2005 CAP Final Request Letter Sent
2/3/2005 CAP Deadline Extension Request Received
2/4/2005 CAP Deadline Extension Approval Letter Sent
3/3/2005 CAP Deadline Extension Request Received
3/3/2005 CAP Deadline Extension Approval Letter Sent
3/14/2005 CAP Addendum/Moedification Received
4/4/2005 Electronic EFS Received - -
5/31/2005 CAP EFS in Negotiation
10/28/2005 CAP Approval Letter Sent
10/29/2005 - Change Status
9/19/2006 : Receive Misc Correspondence
10/30/2006 ~ Miscellaneous Correspondence Sent

Log in’is for Oil and Public Safety Employees only. For more detailed information




01-0’9 In . please contact the Public Records Center to schedule a file review at
 (303) 318-8521 or (303) 318-8522,

CDLE | Stat

and Empioyment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




~ | Home | Search | Help |

Event
Event Id 3626 Alt Event Id 9101044-1 Facility

Logged By _ On Saturday, May 06, 1995 13306 - COLORADQO CAISSONS

Reviewer Jane Bral - 7268 OSCEOLA

. : WESTMINSTER, CO 80030, ADAMS County

Site Name COLORADO CAISSONS Category Other

Locationl 7268 OSCEOLA

Location2 - :

Location3

City,County,Zip WESTMINSTER, JEFFERSON, 80030

Source of Release - Status Closed s : Site Classification 3.1
S o o MTBE Classification
‘Cause of Release o : Projected Closure
. ' ' Date

' Sardonyx Primary ID: USADMCOL
Sardonyx Secondary ID: 023

Activity Classify

Date Activity

5/6/1895 Confirmed Release Reported
5/26/1995 AST (ABOVE GROUND STORAGE TANKS)
5/26/1995 . Other Notable Reports
6/21/1995 ~ Site Assessment Request
6/30/1995 SA/FIN - Further Information Needed
7/20/1995 - LUST Cleanup Initiated: Petroleum
7/24/1995 Further Information Needed
5/16/1997 Site Assessment Request
1/29/1998 " Site Assessment Request
3/16/2000 - See Comments
3/17/2000 Site Assessment Request
4/28/2000 SCR Deadline Extension Request Received
5/1/2000 - 8CR Deadline Extension Approval Letter Sent
6/1/2000 Other Notable Reports :
7/7/2000 SA - Site Assessment
8/15/2000 Send Closure Letier - NFA

~ 5/16/2001 Change Status

Log in is for Qil and Public Safety Employees only. For more detailed information

Log In
“ %9 . please contact the Public Records Center to schedule a ﬁle rev1ew at
(303) 318-8521 or (303) 318-8522. ' :

CDLE | Stat

Labor and Employment

i Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

¢ You are currently logged into database COSTIS as Public
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Event

Event Id 9162
Logged By Kathleen Turner

On Wednesday, March 12, .
2003

Reviewer Dawn Anderson

Site Name DISCOUNT TIRE

Locationl 2955 W 72ND AVE

Location2
Location3

City,County,Zip WESTMINSTER, JEFFERSON 80030

Source of Release Tank

Cause of Release

Status Open

Sardonyx Primary ID: USADMDIS
Sardonyx Secondary ID: 001

Activity - Classify

Date
12/6/2002
3/13/2003
6/17/2003
6/19/2003
6/19/2003
712272003
11/10/2003 -
1/29/2004
4/27/2004

- 4/29/2004
7/14/2004
10/17/2004
11/18/2004
1/13/2005
1/13/2005
2/2/2005
3/17/2005
3/17/2005
5/11/2005
5/11/2005
5/12/2005
6/13/2005

8/5/2005
12/19/2005
12/19/2005
12/19/2005
3/8/2006
3/23/2006
3/30/2006
4/3/2006
5/16/2006
5/22/2006
7/6/2006
7/14/2006
10/9/2006
10/12/2006
11/1/2006
12/12/2006 .

:  Confirmed Release Reported
. 88F / SCR Request Letter Sent

Phone Call Received
SCR Final Request Letter Sent
Change Status

~ SSF - Site Summary Form Received

SCR - Site Characterization Report Received
SCR Final Request Letter Sent

SCR Deadline Extension Request Received

SCR Deadline Extension Approval Letter Sent
SCR - Site Characterization Addendum Received
CAP EFS Effective Date

SCR Final Request Letter Sent

SCR Deadline Extension Request Received

SCR Deadline Extension Approval Letter Sent
SCR - Site Characterization Addendum Recelved
CAP Request Letter Sent

Change Status

CAP Deadline Extension Request Received

'CAP Deadline Extension Approval Letter Sent

Electronic EFS Received

. CAP - Corrective Action Plan Received
-CAP EFS in Negotiation

“CAP Approval Letter Sent

. Signed EFS Received

~ Change Status

Monitoring Report Received

CAP Addendum/Modification Received
CAP EFS in Negotiation

Electronic EFS Received

CAP Modification Approval Letter Sent
Signed EFS Received

MTBE Pathway Elimination Letter Sent
Monitoring Report Received

Electronic EFS Received

CAP Addendum/Modification Received
Monitoring Report Received

CAP EFS in Negotiation

Faclllty '

15984 - DISCOUNT TIRE
. 2955 W.72ND AVE

‘WESTMINSTER, CO 80030, ADAMS County
. Category Commercial/Industrial

" Site Classification 32
‘MTBE Classification Pathway
Eliminated
Projected Closure
Date

Activity




1/10/2007 " Monitoring Report Received

5/14/2007 " Monitoring Report Received

8/2/2007 - Monitoring Report Received

9/21/2007 - . 'Signed EFS Received 3
10/1/2007 "~ CAP Modification Approval Letter Sent :_ -
1/9/2008 - Monitoring Report Received '
8/5/2008 -~ .. Monitoring Report Received

10/17/2008 . - Phone Call Received

10/31/2008 © Monitoring Report Received

12/8/2008 Monitoring Report Received

3/17/2009 Monitoring Report Received

‘Log in is for Oil and Public Safety Employees only. For more detailed information

Log n
o ogin. _please contact the Public Records Center to schedule a file review at
{303} 318-8521 or (303) 318-8522.

CDLE | Stat

iabor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc,

You are currently logged into database COSTIS as Public




' | Home | Search | Help |

Event

- Event 1d 4465
Logged By
Reviewer Dawn Anderson

Alt Event Id 9101405-1
On Friday, October 25, 1996

Site Name CONOCO #94137
Locationl 7200 N FEDERAL BLVD
Location2
Location3
City,County,Zip WESTMINSTER, JEFFERSON, 80030

Source of Release Status Open

Cause of Release

E _ Sardonyx Primary ID: USADMWES
Sardonyx Secondary ID: 014

 Activity  Classity

Date
10/25/1996 Monitoring Report
10/25/1996 Confirmed Release Reported
1/27/1997 Monitoring Report
3/26/1997 Request for CAP
5/1/1997 Other Notable Reports
5/27/1997 Monitoring Report
7/30/1997 CAP - Corrective Action Plan
8/22/1997 Monitoring Report
11/10/1997 Monitoring Report
2/9/1998 Monitoring Report
2/26/1998 - CAP Approval Letter Sent
12/11/1998 . Monitoring Report
1/20/1999 .. Other Notable Reports
5/3/2000 - Request for CAP
5/3/2000 . See Comments
6/2/2000 - Monitoring Report
1/19/2001 Monitoring Report Received
-5/18/2001 Change Status
8/28/2001 Monitoring Report Received
2/5/2002 Monitoring Report Received
© 6/18/2002 Monitoring Report Received
1/21/2003 Monitoring Report Received
- 6/4/2003 Monitoring Report Received
" 6/19/2003 CAP Modification Request Sent
. 9/12/2003 CAP Deadline Extension Request Received
9/15/2003 CAP Deadline Extension Approval Letter Sent
10/10/2003 Receive Misc Correspondence
-10/16/2003 CAP Addendum/Modification Received
10/17/2003 Electronic EFS Received
- 10/24/2003 Other Notable Reports Received
13/30/2004 Monitoring Report Received
5/3/2004 Monitoring Report Received
7/14/2004 CAP Approval Letier Sent
10/12/2004 Monitoring Report Received
12/20/2004 Monitoring Report Received
2/22/2005 Monitoring Report Received
3/10/2005 Phone Call Made
1/16/2006 Monitoring Report Received
5/25/2006 Monitoring Report Received
12/6/2006 Phone Call Received

" Facility
13814 - CONOCO #94137

7200 N FEDERAL BLVD
WESTMINSTER, CO 80030, ADAMS County
Category Retail Gas Station

Site Classification 32
MTBRBE Classification 3
Pro;ected Closure

Date

Activity



1/17/2007 ' Phone Call Received

1/31/2007 ‘ Phone Call Received

2/9/2007 Monitoring Report Received

51312007 ' Miscellarieous Correspondence Sent

6/14/2007 Monitoring Report Received

7/31/2007 Monitoring Report Received

3/17/2008 - Monitoring Repoit Received

7/16/2008 * - ‘Monitoring Report Received

10/16/2008 MTBE MARS Report Received

2/13/2009 Monitoring Report Received

2/13/2009 Monitoring Report Received

Log in is for Oil and Public Safety Employees only. For more detailed information

@ Log fn piease contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

" COLE | Stat

labor ond Employment

Copyright © 2000, Celorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public
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Event

Event Id 9134

Logged By Kathleen Turner On Wednesday, February 12,

2003
Reviewer Tina Sandoval

Site Name AUTO POINT
Locationl 3929 W 72ND AVENUE
Location2

Location3
City,County,Zip WESTMINSTER, JEFFERSON, 80030

Source of Release

Cause of Release

Sardonyx Primary ID: USJFRAUT
Sardonyx Secondary ID: 003

Activity  Classify

Date
2/12/2003 - No Further Action Request Report Received
3/14/2003 Closure Letter Sent (LT RBSLs)

(303) 318-8521 or (303) 318-8522.

| Copyright © 2000, Colorade Dept, of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into. database COSTIS as Public

Status Closed

Login
0 o9 please contact the Public Records Center o schedule a file review at

Facility

15958 - STEVEN STARK

3929 W T2ND AVE

WESTMINSTER, CO 80030, ADAMS County
Category Other

.+ Site Classification
. MTBE Classification
Projected Closure
Daie

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

CDLE | Stats

thbr and Empioyment
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Event
~ Event Id 3699 Alt Event Id 7545-1 Facility
.. Logged By On Monday, December 03, 11304 - WESTMINSTER U-PUMP-IT
o 1990 7225 BRADBURN
" Reviewer Dennis Hotovec WESTMINSTER, CO 80030, ADAMS County

e Category Retail Gas Station
-Site Name WESTMINSTER U-PUMP-IT :
Locationl 7225 BRADBURN =~
Location2
Location3
City,County,Zip WESTMINSTER, JEFFERSON, 80030

Source of Release Status Closed B Site Classification
‘ S MTBE Classification
Cause of Release : Projected Closure
Date
Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity Classify

Date ' Activity
12/3/1990 Confirmed Release Reported
12/3/199¢ Site Investigation Completed
12/24/1990 General Correspondence

13/25/1991 CAP - Corrective Action Plan
6/1/1991 LUST Cleanup Initiated: Petroleum
7/25/1997 Send Closure Letter - NFA
7/25/1997 Tank Release Under Control
7/25/1997 Site Cleanup Completed
7/25/1997 CR - No Further Action Required
- 7/25/1997 REV Cleanup Completed

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
e o9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

CDLE | Stat

: Lebor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
" Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public
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Event
EventId 507 Alt Event Id 4597-1 Facility
Logged By On Tuesday, May 26, 1992 1418 - PARKS SHOP
Reviewer Ed LaRock 3950 W 72ND AVE
WESTMINSTER, CO 80030, ADAMS County
Site Name PARKS SHOP : Category State/Local Government
Locationl 3950 W 72ND AVE :
Location2 -
Location3
" City,County,Zip WESTMINSTER, JEFFERSON, 80030
Source of Release Status Closed -~ = o Site Classification
- S MTBE Classification
Cause of Release _ : : Projected Closare
' Date
Sardonyx Primary ID: N
Sardonyx Secondary ID:

Activity Classify

Date Activity
5/26/1992 Confirmed Release Reported
6/5/1992 Site Assessment Request
7/30/1992 CR/FAN 2 - Further Action Neccessary Priority 2
10/1/1992 - LUST Cleanup Initiated: Petroleum
11/4/1992  Site Assessment Request
11/24/1992 . SA/FAN 2 - Further Action Neccessary Priority 2
1/27/1993 Site Assessment Request
4/29/19%4 .CR - No Further Action Required
5/16/1994 Tank Release Under Control
5/16/1994 Site Cleanup Completed
5/17/1994 Send Closure Letter - NFA
- 5/24/1996 REV Cleanup Completed

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
0 ogh please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522,

| CDLE | Stati .

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public
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Facility Registry System (FRS) s

" Recent Additions | Contact Us | Search: OAH EPA @ This Area | B | GOl
" You are here: EPA Home  Envirofactss FRS - Report AR

[ Facility Name:_ | INBOW CLEANERS

[ Location Address: [ 5054 wesT 92ND AVENUE
Supplemental Address: ||

City Name: 1 — WESTMINSTER
| ~ State | ‘ Co .
[ - County Name: ADAMS
| ZIP/Postal Code: || 800316302

EPA Region: I B 08
Congressional District Numb_.] _ 02

_Is?q.i'slative District Number_:—|
HUC Code: [ 10190003

| Federa| Facility: : NO

US Mexico Border Indicator: NO

' Tribal_Land : | NO

i - Latitude: [ 39.863463

L_“JJ__

Longitude: ] ~ -105.050281
| " Method: — |/ADDRESS MATCHING-HOUSE NUMBER]

Reference Point Description: ]I_

| [ DunsNumber: | 144300209 |

[ Registry ID: I 110001965954

o [ Wap this faciity_|

Environmental .Intérests |

—— M—— —— - —

Information Information Environmental Interest |(|Data Last : : Su - lemental
System " ||System ID Type ' Source Updated : %Eny:ronmental
=2vsiem —!—i ype | — Date Interests:

[ ars/ars || 0800100064 | AIR MINOR () | Ars/aFs [ 0370872006 |

CRITERIA AND HAZARDOUS ‘ Al :
NEI NEICO0010964 AIR POLLUTANT NEI
INVENTORY | |
RCRAINFO COD983772823-’|— CORR?E&‘;\E/SCTION RCRAINFO || 07/08/2008

Facility Mailing Addresses




Affiliation Type Delivery Point City Namel[State| Postal|Information
e 1™ Code|{System
{[FACILITY MAILING - _ :
:I \DDRESS 5054 W 92ND AVE WESTMINISTER co  [j80030 ’AIRS/_AFS |
- |[orPERATOR [5054 w 92ND [wesTminsTER lco Jlsoozo jrRcranFO |
REGULATORY CONTACT |[2000 S COLORADO BLYD STE ipenyer co |so222  [[reraInFo
FACILITY MAILING 2000 S COLORADO BLVD STE I ‘ . |
| ADDRESS 5640 DENVER co {80222 RCRAINFO |
e — = = = _ =
flowNER 2000 S COLO BLVD STE 2-640 |\nenyer co |lgo222 RCRAINFO
: COCTR 2 N
_ DATA NOT
OWNER DATA NOT REQUESTED IREQUESTED co [l99999 RCRAINFO
_ NAICS Codes
|Data Sourcel|NAICS Code"Descrlptlon ' Primary|

NEI "DRYCLEANING AND LAUNDRY SERVICES (EXCEPT COIN OPERATED)

L |

812320

SIC Codes

|Data Source"SIC Codelﬁscri tion __ HPrimarg
[ aRs/aFs || 7216 [[DRYCLEANING PLANTS, EXCEPT RUG CLEANING]|

NEL || 7216 |[DRYCLEANING PLANTS, EXCEPT RUG CLEANING||

- Contacts

||Office Phone" Information Syst_e_r_n_“Mailihg' Address|

|[Full Name

Affiliation Type

[REGULATORY CONTACT|[MARGOT ZATERMAN| 3034071707 |[RCRAINFO [ view |
PERMITTING CONTACT I IRCRAINFO | |
|COMPLIANCE CONTACT|[ PETER KAPAFEGES || 3036509277 J|AIRS/AFS | l
Organizations
[affiliation Type|[Name - [DUNS Number][information System||Mailing Address]|
OWNER . |[ - JFRCOLIC . || RCRAINFO View 1
OPERATOR  |IFORMERLY RAINBOW CLEANERS|| __||RcraINFO View

[ owner |

8
g

PETER KAPATAYES |

~ |[rerainFo

Alternative Names

|AIternative_I§ame"Source of Data

[ RAINBOW CLNRS [|  AIRS/AFS |

Query executed on: MAR-20-2009




| | Home | Search | Help |

Event
Event Id 8192 Alt Event 1d Facility

Logged By On Friday, May 05, 2000 2576 - JC PENNEY CO

Reviewer Tim Kelley 5453 W 88TH AVE '

WESTMINSTER, CO 80030, ADAMS County

Site Name JC PENNEY WESTMINSTER MALL Category Commercial/Industrial

Locationl 5453 W 88TH AVE o

Location2

Location3

Clty,County,le WESTMINSTER, JEFFERSON, 80030

S Source of Release ' Status Closed - Site Classification
- ' _ o MTBE Classification
.~ Cause of Release _ ' o Projected Closure
Date
Sardonyx Primary ID:
Sardonyx Secondary ID;

Activity  Classify _
Date '.' Activity

5/12/2000 Confirmed Release Reported
5/25/2000 Send Closure Letter - NFA
5/25/2000 " LUST Cleanup Initiated: Petroleium
5/25/2000 Site Cleanup Completed

51252000 - CR - No Further Action Required

~ Log in is for Oil and Public Safety Employees only. For more detailed information

Legin
0 o8 please contact the Public Records Center to schedule a file review at
{303) 318-8521 or (303) 318-8522.

CDLE | Stat

- Lobaor and Empiovmanf _

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrigr & Russel, Inc.

You are currently logged into database COSTIS as Public




Copyright © 2000, Colorado Dept. of Labor and Employment
BPeveloped by Greenbrier & Russel, Inc.

| Home | Search | Help |

Event

Event Id 6705
Logged By
. Reviewer Robert Shoup

Alt Event Id
On Monday, July 20, 1998

‘Site Name WESTMINSTER POLICE
~ Locationl 8300 SHERIDAN BLVD
Location2
Location3
- City,County,Zip WESTMINSTER, JEFFERSON, 80030

Source of Release : ..Status Closed

Cause of Release

Sardonyx Primary ID: USADMWES
Sardonyx Secondary ID: 021

Activity = Classify

Date .
7/20/1998 Suspected Release
9/17/1998 Other Notable Reports
9/25/1998 Other Notable Reports
10/19/1998 Confirmed Release Reported
10/21/1998 - Other Notable Reports
12/4/1998 SA - Site Assessment
12/4/1998 SA - Site Assessment
12/4/1998 LUST Cleanup Initiated: Petroleum
12/4/1998 - Site Cleanup Completed
4/8/1999 . Send Closure Letter - NFA
4/8/1999 CR - No Further Action Required

Facility
1430 - MUNICIPAL COURT CENTER

‘8800 SHERIDAN BLVD

WESTMINSTER, CO 80030, ADAMS County

. Category State_/_'Local Government .

Site Classification
MTBE Classification

Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed mformatxon :

Login
“ °8 _ please contact the Public Records Center to schedule a ﬁle rev1ew at

-(303) 318- 8521 or (303) 318 8522,

You are currently logged into database COSTIS as Public

CDLE ] Stat
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| Home | Search | Help{ -

Event

Event Id 10470

Logged By Tina Sandoval On Monday, September 24,
2007

Reviewer Bobby Sonnier

_Site Name LIEM CONOCO
" Locationl 9175 HARLAN ST
" Location2
Location3
Clty,County,le WESTMINSTER, JEFFERSON, 80031

~ Source of Release Historical contamination Status Open

Cause of Release

Facility
10616 - LIEM CONOCO
9175 HARLAN ST

WESTMINSTER, CO 80031, JEFFERSON County

Category Retail Gas Station

Site Classification 2.6
MTBE Classification 2
Projected Closure

Date
Sardonyx Primary ID: USJFRCON
Sardonyx Secondary ID: 012
Activity Classify
Date Activity
9/21/2007 Confirmed Release Reported
9/25/2007 SSF / SCR Request Leiter Sent N (‘JOOE
11/7/2007 Receive Misc Correspondence o / \t
11/8/20607 SSF - Site Summary Form Received
11/19/2007 Change Status
- 1/3/2008 SCR Deadline Extension Request Received
1/8/2008 SCR Deadline Extension Request Received
1/14/2008 Receive Misc Correspondence
1/22/2008 SCR Deadline Extension Approval Letter Sent
2/26/2008 SCR Deadline Extension Request Received
3/6/2008 Receive Misc Correspondence
3/11/2008 Phone Call Received
3/12/2008 Phone Caill Made
- 4/17/2008 SCR Deadline Extension Approval Letter Sent
4/28/2008 Phone Call Made
5/6/2008 SCR Deadline Extension Request Received
5/7/2008 SCR Extended Due Date
5/28/2008 SCR Deadline Extension Approval Letter Sent
6/6/2008 SCR Extended Due Date
- 6/6/2008 SCR - Site Characterization Report Received
- 8/15/2008 Chénge Status
8/15/2008 CAP Request Letter Sent
8/25/2008 Monitoring Report Received
10/14/2008 CAP - Corrective Action Plan Received
11/4/2008 Electronic EFS Received
~11/10/2008 Moenitoring Report Received
12/1/2008 CAP EFS in Negotiation
1/7/2009 Phone Call Made
1/7/2009 " CAP Denial Letter Sent
1/28/2009 Phone Call Made
2/4/2009 CAP Extended Due Date
2/4/2009 Other Notable Letters Received
2/5/2009 Miscellaneous Correspondence Sent
2/6/2009 Receive Misc Correspondence
2/106/2009 CAP Deadline Extension Approval Letter Sent
3/2/2009 CAP Extended Due Date
3/4/2009 Phone Call Received
3/4/2009 CAP Deadline Extension Request Received
3/4/2009 CAP Deadline Extension Approval Letter Sent




3/9/2009 .. CAP Extended Due Date

3/9/2009° Electronic EFS Received
3/11/2009 Monitoring Report Received
3/11/2009 CAP Addendum/Modification Received

3/19/2009 Phone Call Received .

" Log in is for Oil and Public Safety Employees only. For more detailed information

Login ;
0 °9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

CDLE | Stat

T iabor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




NATIONAL RESPONSE CENTER 1-800-424-8802

*%% For Public Use *#*¥%

Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 541129

INCIDENT DESCRIPTION

*Report taken at 18:23 on 05-SEP-00

Incident Type: FIXED

Incident Cause: EQUIPMENT FAILURE

Affected Area: STORM DRAIN

The incident was discovered on 05-SEP-00 at 15:30 local time.

Affected Medium: WATER STORM DRAIN

SUSPECTED RESPONSIBLE PARTY

Organization: CHINA CUISINE
WESTMINSTER, CO 80031

Type cof Organization: PRIVATE ENTERPRISE

INCIDENT LOCATION
SOUTH WEST CORNER OF 88TH AVE County: JEFFERSON
AND SHERETCN BLVD
City: WESTMINSTER State: CO

RELEASED MATERIAL({S)
CHRIS Code: NCC Official Material Name: NO CHRIS CODE
Also Known As: RAW SEWAGE
Qty Released: 300 GALLON(S) Qty in Water: 150 GALLON(S)

DESCRIPTION OF INCIDENT

A GERESE TRAP SYTEM AT A RESTURANT BACKED UP CAUSING THE MATERTAT, TO LEAK INTO A

STORM DRATIN.

INCIDENT DETAILS

Package: N/A

Building ID:

Type of Fixed Object: OTHER
Power Generating Facility: NO
Generating Capacity:

Type of Fuel:

NPDES :

NPDES Compliance: UNKNOWN

=-==-WATER INFORMATION---

Body of Water: STORM DRAIN
Tributary of: LITTLE DRY CREEK
Nearest River Mile Marker:
Water Supprly Contaminated: NO

DAMAGES
Fire Involved: NO Fire Extinguished: UNEKNOWN
INJURIES: NO Hospitalized: Empl /Crew: Passenger:
FATALITIES: NO Empl /Crew: Passenger: Occupant:
EVACUATIONS: NO Who Evacuated: Radius/Area:

Damages: NO




Length of
Closure Type Description of Closure : Closure
BAir: N
Road: N

Waterway: N

Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN
Media Interest: NONE Community Impact due to Matexial: NO

Direction of

Closure

REMEDIAL ACTIONS

CONTRACTOR HAS BEEN HIRED

Release Secured: YES
Release Rate:
Estimated Release Duration:

WEATHER

_Weather: SUNNY, B892F Wind direction: SE

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: STATE/COUNTY HEALTH DEPT.
State/Local On Scene:

State Agency Number:

NOTIFICATIONS BY NRC
ATSDR CO ATTN: JANET JONES (PRIMARY)
05-SEP-00 18:32

U.S. EPA VIILI (PRIMARY)
05-SEP-00 18:49

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
05-SEP-00 18:32

CO OIL & GAS CONSERVATION COMM (PRIMARY)
05-SEP-00 18:32

DOI/OEPC DENVER (PRIMARY)
05-SEP-00 18:32

ADDITIONAL INFORMATTION
THE CALLER HAD NO ADDITIONAL INFORMATION.

*** END INCIDENT REPORT # 541129 bl

Major
Artery:




NATIONAL RESPONSE CENTER 1-800-424-8802

*¥%% For Public Use ***%*

Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 541245

INCIDENT DESCRIPTION

*Report taken at 13:49 on 06-SEP-00
Incident Type: FIXED

Incident Cause: EQUIPMENT FAILURE
Affected Area: STORM DRAIN & LOCAL CREEKS
The incident occurred on 06-SEP-00 at 11:00 local time.

Affected Medium: WATER LITTLE DRY CREEK

SUSPECTED RESPONSIELE PARTY

Organization: CHINA CUISINE
j WESTMINISTER, CO 80031

Type of Organization: PRIVATE ENTERPRISE

INCIDENT LOCATION
88TH AVE AT INTERSECTION OF County: JEFFERSON
SHERIDAN BLVD. '

City: WESTMINISTER State: CO Zip: 80031

ON B0 THE STREET AND ENTERED A NEARBY STORM DRAIN

RELEASED MATERTAL(S)
CHRIS Code: NCC Official Material Name: NO CHRIS CODE

Also Known As: RAW SEWAGE
Qty Released: 300 GALLON(S) Qty in Water: 150 GALLON(S)

DESCRIPTION OF INCIDENT

RESTAURANT HAD A RAW SEWAGE RELEASE INTO THE STREET AND NEARBY STORM DRAIN DUE TO A
BACKUP OF THE GREASE TRAP.

INCIDENT DETAILS

Package: N/A

Building ID: RESTAURANT

Type of Fixed Object: OTHER
Power Generating Facility: NO
Generating Capacity:

Type of Fuel:

NPDES:

NPDES Compliance: UNKNOWN

=-==-WATER INFORMATION---

Body of Water: STORM DRAIN & LOCAL CREEKS
Tributary of: LITTLE DRY CREEK

Nearest River Mile Marker:

Water Supply Contaminated: NO

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: NO Hospitalized: Empl/Crew: Passenger:
FATALITIES: NO Empl/Crew: Passenger: Occupant:

EVACUATIONS: NO Who Evacuated: Radius/Area:

Damages: NO




Length of
Clogure Type Description of Closure - Closure
Air: N
Road: N
Watexrway: N
Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN
Media Interest: NONE Community Impact due to Mater1a1 NO

Direction of

.Closure'

REMEDIAL ACTIONS

MATERIAL CONTAINED, SHUTDOWN SYSTEM, CLEAN UP CREW ON-SITE,CLEAN UP
UNDERWAY, CONTRACTOR HAS BEEN HIRED

Release Secured: YES

Release Rate:

Estimated Release Duration: 0.5 HOUR

WEATHER

Weather: CLEAR, 89°F

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: COUNTY AND STATE HEARLTH DEPTS.:
State/Local On Scene:

State Agency Number:

NOPIFICATIONS BY NRC
ATSDR CO ATTN:JANET JONES (PRIMARY)
06-SEP-00 14:23

U.S. EPA VIII (PRIMARY)}
06-SEP-00 14:25

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
06-SEP-00  14:23

CO OIL & GAS CONSERVATION COMM (PRIMARY)
06-SEP-00  14:23 '

DOI/QEPC DENVER (PRIMARY)
06-SEP-00 14:23

ADDITIONAL INFORMATION

**% END INCIDENT REPORT # 541245 *R%

Major

Artery; N
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| Home | Search | Help |

| Facility
! 18476 - 7-ELEVEN #34036 Category: Retail Gas Station
i Type: Retail |
E 6990 CHURCH RANCH BLVD Tot?l Tanks: 2 i
! WESTMINSTER, CO 80021 Active Tanks: 2 |
i JEFFERSON County : Facility Creation Date: 2/21/2008 8:55:04 AM |
: ' : Street Map: e L
- _ T .~ Topo Map:
! " Facility Telephone:* ' _ S o - Sardonyx Primary ID :

Contact Name:* : ' R " Sardonyx Secondary ID :

AST/UST Inspector: Jack Sarver OPS-5 ' - Delivery Prohibition Date :

W&M/LPG Inspector: Chris Dufex OPS-1 -

*To be added using Coﬁtacts tab. For further information see Help Menu

Processes  Tanks

: . . Deliver
Install Registration Lelvery . Date  Closure
Tank Tag Status Type Date Date P;;c;ltl;b Product Capacity (joced Method
18476-1 Currently nUse ~ UST  5/13/2008 o 1- Unleaded 15000

Regular (RUL) :
‘ 18476-2 Currently In Use UST 5/12/2008 3 - Unleaded 10000
Premium (PUL) '

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
@ °9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

]

CDLE | Stat

Lobor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel. Inc.

5 You are 6urrently logged into database COSTIS as Public




| HomeJ Search | Help |

Event
“Event Id 9479 Facility
.. Logged By Tina Sandoval On Friday, April 16, 2004 6848 - ANDERSON AMOCO FOOD SHOPS
- Reviewer Dawn Anderson 7007 CHURCH RANCH BLVD
L BROOMFIELD, CO 80021, BROOMFIELD County

© Site Name ANDERSON AMOCO FOOD SHOPS Category Retail Gas Station
Locationl 7007 CHURCH RANCH BLVD
Location2
Location3

City,County,Zip BROOMFIELD, BROOMFIELD, 80021

Source of Release : _..Status Closed - . © Site Classification
. SRR o MTRBE Classification
Cause of Release § _ : g Projecied Closure

Date
Sardonyx Primary ID: USBRMAND '
Sardonyx Secondary ID: 001

Activity Classify

Date 5 Activity
4/16/2004 . Suspected Release Reported
. 4/19/2004 ~ Miscellaneous Correspondence Sent
- 6/30/2004 - SCR - Site Characterization Report Received
6/30/2004 : Confirmed Release Reported
19/7/2004 "© Closure Denial Letter Sent
10/7/2004 Closure Request Received

: 1(_)/25_/2004_ Closure Letter Sent (LT RBSLs)

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
“ %9 please contact the Public Records Center to schedule a file review at
{303) 318-8521 or (303) 318-8522.

CDLE | Stat

tﬂbér and Empicymaent

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public




S SelN Z | 0 P

AT \(/\/\Jw\ﬁj\\
Jﬂlozﬂ ﬁgh\ogz‘ NOSHIAGNV _

N N

Alod - iypue ouoisiH vH
Yea]juel vH - *

Nue|l vH

}si] dnues|) 8jels vH
juiod - s|iids vH

lojessuag) |lews VYO VYH
9)se MZeH Jayjo VHOH VH
Jojessuan) ablie] vyoo VH
JOY 9Alj0810D VHOY VH
OOS 1dwex3 puo) VYO VH
dvd4N VH

Julod - 1s17 Ajold }eN vH
llypue] vH

SIT0¥30 WH

A
—fe

(

/ Aﬂdﬂhur-.

Z 4 ¥ © ©n W T T

B\

Dz_ >Z<&E°0 .FZWEHG(Z‘E NOITINg _V,

1 _Imudﬁc._.ﬂ OEWZWQ
=
Uz_ ZO_._.O..-I._.mZOO i ﬂ \

a131dNo0ud 104D\

r’< HLOLE

< W ‘ ONIAISIY LVAIN aIIANOoNS .—.SOJ.

3§
4 E s j’\v ﬁ
by W / / |

4

pleAajnog UJIOMSPEA\ PUE 9¢ SN-6 aInbi4






Facility Registry System (FRS)

Search: OAll EPA .Thss Areal R
Enwrofacts FRS © Report . . L

~ Recent Additions | Contact Us |
You are here: EPA Home -

Facility Name: |lBULLION MANAGEMENT COMPANY INC]
Location Address: | 11575 N WADSWORTH BLVD - |
Supplemental Address: " L l
City Name: I - BROOMFIELD ]
e 2 — —
County Name: i BROOMFIELD B
ZIP/Postal Code: | 80020 - |
EPA Reqion, " 08 |
Congressional District Number:" 02 l .
[ Legislative District Number;: | ]
HUC Code: I 10190003 |
Federal Facility; -
'US Mexico Border Indicator: NO
N Tribal Land ; NO
[ Latitude: 39.904642
' Longitude: | -105.080096
~_ Method: — |[ADDRESS MATCHING-HOUSE NUMBER
|_ReErence Point Description: || PLANT ENTRANCE (GENERAL) I
| Duns Number: Il I
| Registry.ID: Il 110002967834

|

Map this facility. .

.]

Environmental Interests

Information |Information Environmental Data Last Updated Supplemental h lemental
System System ID Inte t Tvpe Sourc Date Environmental
SySstem system 1D inierest fype i .
neres € Interests:
UNSPECIFIED
I RCRAINFO COD067301473 UNIVERSE (INACTIVE) RCRAINFO 11/18/1980

Facility Mailing Addresses
1 Affiliation Type I

|State||Postal Code

Delivery Point" City Name Information System

[REGULATORY CONTACT ___|[P O BOX 149 _|[BROOMFIELD|[cO|[80020 RCRAINFO |
[FACILITY MAILING ADDRESS|[P 0 BOX 149 |lBROOMFIELDI[CO  |[80020 RCRAINFO |




NAICS Codes

:|Data Source”NAICS CodeHDescrlptlon S - : |lPrimary|

[ rcrAINFO || 332999 |[ALL OTHER MISCELLANEOUS FABRICATED METAL PRODUCT MANUFACTURING.|| |

| RcraINFO | 335929 | OTHER COMMUNICATION AND ENERGY WIRE MANUFACTURING. . || |

RC’RA’INFO:’.H' dassi | : . — :..,,._ — | ] : 

SIC Codes

No SIC Codes returned.

Contacts
!Affiliation Type [Eull Name”Offlce Phone”Informatlon SVStem"Mallmg Address

PERMITTING CONTACT [ [RCRAINFO

REGULATORY CONTA'CT” BILL REID i 3034695343 |[RCRAINFO T view

‘Organizations

No Organizations returned.

Alternative Names

- No Alternative Names returned.

"7 Query executed on: MAR-20-2009 - -

EPA Home | Privacy and Security: Notice -|:Contact Us - o

Last updated on Friday, March 20th, 2009,
http://caspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in=C0D0673014738pgm_sys_acrnm_in=RCRAINFO
Print As-Is - . :

Thns document will now print as it appears on screen when you use the File » Prmt command
. Use View » Refresh to return to origmai state




Facility Registry System (FRS) share

Recent Additions | ContactUs |  Search: (Al EPA @ This Area I EIGOE
You are here: EPA Home  Envirofacks FRS  Report

Facility Name: || - PRIVATE RESIDENCE |
Location Address: || 11600 OLD WADSWORTH |
Supplemental Address: ___I_ : |
City Name: [ BROOMFIELD |
o o
County Name: L 3eFFERSON
ZIP/Postal: Code: - 80021 |
EPA Region: HE ' 08
" HlCongressional District Number:” 02
Legislative District Number: || '
[ HUCCode: | 10190003
I_ Federal Facility: ' || ,
US Mexico Border Indicator: || NO
_ I__ Tribal Land ; |l NO :
[ Latitude: I ' 39.907052 [
L Longitude: |  -105.085879 ]
| Method: [ADDRESS MATCHING-HOUSE NUMBER]
Reference Point Description: || _ 2 ' I
Duns Number: I ~ ' 3 ]
| Registry ID: I 110009563329 |

[ Map this facility |

Environmental Interests

Information |Information Environmental Data Last Updated Supplemental
System System ID Interest Type Sour Date Environmental
- — ] preres ' olree Interests:
I ' ' UNSPECIFIED
RCRAINFO ” COD983789140_|| UNIVERSE (INACTIVE) RCRAINFO || 12/17/1991

Facility Mailing Addresses

No Facility Mailing Addresses returned.

NAICS Codes



No NAICS Codes returned.

SIC Codes
No SIC Codes returned.
Contacts
- ||affiliation Type |[Full Name][office Phone][Information System|[Mailing Address]|
|| PERMITTING CONTACT || B ' IRCRAINFO I R |
IREGULATORY CONTACT][ | . lIRcrRAINFO - | ol
Organizations

"~ No Organizations returned.

_Alterné"tive Nam'es

" No Alternative Names returned.

- . Query executed on: MAR-20-2009

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Friday, March 20th, 2009,
http://oaspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in=C0D983789140&pgam_sys_acrnm_in=RCRAINFO
Print As-Is

This document wnll now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to onglnal state.




http: //oaspélb ep?:gog/eora\%%ro/fu - query_dtl.disp_program_ faglltyé?_
pgm_sys_id_in D Sm@a@nwwrmmﬁﬁ@m\ i}
Facility Registry System (FRS .

You are here: EPA Home Envirofacts FRS Report:

» Facility Detail Report

[ Facility Name: | GENERIC STORAGE |
| Location Address: |~ 7600 WEST 116TH AVENUE ]
r Supplemental Address: ” ' ‘ |
| City Name: | WESTMINSTER |
| State co |
L County Name: BROOMFIELD ]
[ ZIP/Postal Code: || 800202701 ]
| " EPA Region: o 08 B l
ICongressional District Number:|| - 02 |
I Legislative District Number: || L |
| HUCCode: -~ || . 10190004 l
| Federal Facility: I - |
| US Mexico Border Indicator: || NO: |
| Tribal Land : - || - NO [
| Latitude: I 39.906907 |
| Longitude: -105.081065 |
| Method: ADDRESS MATCHING-HOUSE NUMBER|
| Reference Point Description: || |
| Duns Number: ” H
Registry ID: 110002973907

[ ~ Map this facility: ]

Environmental Interests

. . . ' Last Supplemental
Information |Information Environmental Data b
. e s s PR Updated Environmental
System System 1D Interest Type Source Date Interests:

UNSPECIFIED
RCRAINFO COD980955736 UNIVERSE RCRAINFO|| 06/10/1987
' : {(INACTIVE) '
Facility Mailing Addresses
Affiliation Tvpé. 'Delivery Point City Name"State PostaljInformation

-Code||System

REGULATORY CONTACT |[7620 W 116TH AVE |WESTMINSTER [co]8oo30  |[RCRAINFO

Ok L WAILING 7620 W 116TH AVE |WESTMINSTER  [Ico  [|80030 "RCRAINFO




||OWN ER ||

DATA NOT DATA NOT

 |[atfiliation Type

- NAICS Codes
~No NAICS Codes returned.

~ SIC Codes
No SIC _Codes retur_n'ed:.

Contacts

|FuII Name||0fflce Phone|| nformatlon S¥stem]|Ma|I|ng Addressl'
[PERMITTING CONTACT |

RCRAINFO

[REGULATORY CONTACT]

[Affiliation Type|[Name

AL BECKER|| 3034202553 [IRCRAINFO | View l

Organlzatlons

| OWNER [IGEN

_ [DUNS Number|Information System"Mallmg Address||
ERIC STORAGE" '

||RCRAINFO ]l _View |

Alternative Nam'es
No Alternative Names returned.

Query executed on: MAR-20-2009 -




.5. ENVIRONMENTAL PROTECTION AGENCY
Superfund Information Systems 0

el

Recent Additions | Contact Us | Search L m

EPA Home > Superfund > Sites > Superfund Informauon Svstems > Search Superfund Site Informat:o > Search Results >
GENERIC STORAGE SITE

Superfund Slte Information

GENERIC STORAGE slTE | - ANWAP

Actions

Site Info | Aliases | Operable Units | Contacts
Actions | Contaminants | Site-Specific Documents

OU Action Name . . Qualifier "Lead Actual Start Actual
- o _ . Completion
"~ 00 _DISCOV_ERY . - F 08/03/1987
| ‘00 ARCHIVE SITE o o EP : 02/12/1991
" 00 PRELIMINARYASSESSMENT = .. N - . 8 02/12/1991
Retu_rn to Search Results . ' ':- : " Return to Search Superfund Site Information
' : DISCLAIMER:
Be advised
that the data
contained in

_ these profiles
are intended
solely for
informational
purposes use
by employees
of the U.S.
Environmental
Protection
Agency for

- management

~ofthe
Superfund
program.
They are not
intended for
use in
calculating
Cost
Recovery
Statutes of
Limitations
and cannot be
relied upon to
create any
rights,
substantive or
procedural, -
enforceable
by any party
in litigation
with the
United States.
EPA reserves
the rightto -
change these
data at any
time without
public notice.

OSWER Home | Superfund Home



EPA Home | Privacy and Security Notice | Contact Us

URL: http:llcfpub.epa.gov/subercp'a'dlcursiteslcacitinfo.cfm
This page design was last updated on Tuesday, August 08, 2006
Content is dynamically g_énera_ted by CoIdF_usic_m .




| Home | Search | Help |

. Event
Event Id 5208 Alt Event Id 6333-2 Facility :
Logged By : On Tuesday, May 31, 1994 7462 - CDOT BROOMFIELD
Reviewer Robert Shoup 11600 HWY 121 -
BROOMFIELD, CO 80020, BROOMFIELD County
Site Name CDOT BROOMFIELD Category- State/Local Government
Locationl 11600 HWY 121
Location2
Location3

Clty,County,le BROOMFIELD BOULDER, 80020

Source of Release Status Closed Site Classification
B : T S MTBE Classification
. Cause of Release o Projected Closure
' B Date

Sardonyx Primary ID: USBRMCOL
Sardonyx Secondary ID: 001

T ome ey

Date - Activity \
5/31/1994 Confirmed Release Reported Q’ QCD
8/8/1994 CR/FAN 2 - Further Action Neccessary Priority 2 -
8/25/1994 Send Closure Letter - NFA
8/25/1994 LUST Cleanup Initiated: Petroleum
8/25/1994 Site Cleanup Completed
8/25/1994 CR - No Further Action Required

Log in is for Oil and Public Safety Employees only. For more detailed information

Log in
° °8 please contact the Public Records Center to schedule a file review at
(303) 318- 8521 or (303) 318-8522.

CDLE | Stat

Lobor and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel. Inc.

You are curren_t[y logged into database COSTIS as Public




|Home | Search | Help |

Event

Event Id 3999
Logged By

Reviewer Doug Pratto

Alt Event Id 1194-1 Facility

On Wednesday, August 11, 1180 - B T CONSTRUCTION INC
1993 11605 WADSWORTH BLVD

BROOMFIELD, CO 80020, BROON[FIELD County
Category Commerc:lalfindustrlal

Site Name B T CONSTRUCTION INC
Location1 11605 WADSWORTH BLVD

Location2
Location3-

City,County,Zip BROOMFIELD, BOULDER, 80020

Source of 'R_elease '

Cause 6_1' Release

Status Closed

Sardonyx Primary ID: USJFRB T
Sardonyx Secondary ID: 001

Activity Classify

Date
8/11/1993
9/15/1993
9/15/1993
9/15/1993

" 10/4/1993
11/19/1993
4/18/19%94
4/18/1994
4/18/1994
4/18/1994
5/26/1994

Log in is for Oil and Pubhc Safety Employees only. For more detailed mformatmn

Activity
Confirmed Release Reported
CR/FAN 2 - Further Action Neccessaty Priority 2
LUST Cleanup Initiated: Petroleum
Tank Release Under Control
CR/FAN 2 - Further Action Neccessary Priority 2
Genersl Correspondence
CR - No Further Action Required
LUST Cleanup Initiated: Petroleum
Tank Release Under Control
Site Cleanup Completed
Send Closure Letter - NFA

Log in
0 9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc,

You are currently logged into database COSTIS as Public

o Laber and Empioyment

Site Classification
MTBE Classification
Projected Closure
Date

Q\Gﬁéf

TS~

CDLE | Stat:




| Home | Search | Help |

Event

Event 1d 508
Logged By

Reviewer LT

_Alt Event Id 5978-1 Facility
: On Wednesday, August25, = 6263 - JOE L. GEBAUER PROPERTY
1993 © 11515 WADSWORTH BLVD

" BROOMFIELD, CO 80020, BROOMFIELD County
Category Commerc:lalflndustrlal

Site Name JOE L GEBAUER
Locationl 11515 WADSWORTH BLVD

Location2
Location3

City,Comity,Zip BROOMFIELD, BOULDER, 80020

Source of Release

Cause of Release

Status LUST Trust

Sardonyx Primary ID: USBRMGER
Sardonyx Secondary ID: 001

“Activity Classify
Date
8/25/1993
8/25/1993
11/12/1993
8/22/1997
8/22/1997
8/22/1997
4/7/1998
12/21/1999
10/3/2001
4/24/2003
8/2/2004
12/5/2005 -

Log in is for Oil and Public Safety Employees only ‘For more detailed mformatlon

Activity
SA/FAN 2 - Further Action Neccessary Priority 2
Confirmed Release Reported
Request for CAP
Further Information Needed
SA/FAN 2 - Further Action Neccessary Pnorxty 2
REV Cleanup Completed
Further Information Needed

- Site Assessment Request

Change Status

SSF / SCR Request Letter Sent
Miscellaneous Correspondence Sent
Change Status

Log In
o o9l please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

¢ Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

Site Classification 31
MTBE Classification
Projected Closure

Date '

CDLE | Staty

Labor and Employment
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" |Home | Search | Help |

. Event

Event Id 8018
Logged By
Reviewer Jane Bral

Alt Event Id
On Thursday, January 20, 2000

Site Name BROOMFIELD AUTO SERVICE CENTER
Locationl 50 BROOMFIELD SHOPPING CENTER
Location2
Location3

City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release . Status Closed

Cause of Release

Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity Classify

Datg
12/7/1999 Other Notable Reports
1/28/2000 General Correspondence
1/28/2000 SA - Site Assessment -
3/24/2000 SA - Site Assessment
7/19/2000 Send Closure Letter - NFA
7/19/2000

CR - No Further Action Required

Facility

14755 - BROOMFIELD AUTO SERVICE CENTER INC
50 BROOMFIELD SHOPPING CENTER 1ST AND
NICKEL WEST

BROOMFIELD, CO 80020, BROOMFIELD County
Category Other

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Qil and Public Safety Employees only. For more detailed information

Log In
« °9 please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public™

CDLE | Statu

Labor and Empioyment







Facility Registry System (FRS) |

Recent Additions | Contact Us | Search: (O Al EPA ® This Area l '_ e t GO!

You are here: EPA Home  Envirofacts FRS ~ Report R

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailable
intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience,

Facility Detail Report

Facility Name: | CENTER LINE MACHINECO |

Location Address: || 3400 INDUSTRIAL LN UNIT 11 A |
Supplemental Address: _|| _ |
City Name: || BROOMFIELD

State 1 co |

County Name: I BROOMFIELD |

ZIP/Postal Code: I 80020 |

| EPA Region: ” 08 1

|Congressional District Number:| = 02 |

1| Legislative District Number: || |

HUC Code: I 10190005 - |

Federal Facility: " |

| US Mexico Border Indicator-:.'_" - “ o -NO I

| Tribal Land : R NO |

[ Latitude: || 39.923928 |

| Longitude: I -105.107122 |

| Method: ADDRESS MATCHING-HOUSE NUMBER]

Reference Point Description: PLANT ENTRANCE (GENERAL)
| . Duns Number: "

[ Registry ID: I 110009558102

| Map this facility__ |

Environmental Interests

Information ||Information Environmental Data Last Updated i:ﬂr::‘::::;l
System System ID Interest Type Source [[Date Interests: )
UNSPECIFIED
RCRAINFO COD035540822 UNIVERSE (INACTIVE): RCRAINFO | 11/03/1993 "
e i —1 |

Facility Mailing Addresses

] Il 11 rostaifuotormation



Affiliation Type ” Delivery Point " City Name"State” CodeliSystem l
FACILITY MAILING : '
ADDRESS P O BOX 1150 BROOMFIELD CO ||80038 . ' {|RCRAINFO .
REGULATORY CONTACT P O BOX 1150 BROOMFIELD CO  [|80038 RCRAINFO -

DATA NOT DATA NOT '
I;V—\-!NER REQUESTED REQUESTED CO }|99999 RCRAINFO

NAICS Codes

- No NAICS Codes returned.

SIC Codes

No SIC Codes returned.

‘Contacts

[atfiliation Type ~ |[Full Name - ||Office Phone|[Information System|[Mailing Address]

[REGULATORY CONTACT||GARY-G HOWARD|| 3034699208 |[RCRAINFO

!

| View

| PERMITTING CONTACT ||

| |IRCRAINFO

Organizations

|Affiliation Type||Name

|IDUNS Numberi|[Information System||Mailing Address

|  OWNER [lGARY G. HOWARD|| - |[rRcrAINFO

|

View

Alternative Names

No Alternative Names returned.

Query executed on: MAR-27-2009

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Friday, March 27th, 2009.
http://oaspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in=C0OD035540822&pgm_sys_acrnm_in=RCRAINFO

Print As-Is

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.




| Home | Search | Help |

Event

Event Id 1704 Alt Event 1d 277-1 Facility
Logged By On Friday, May 19, 1995 9181 - 7-ELEVEN #18671
Reviewer Cindy Silva- _ 1951 W 5TH AVE
Burbach . BROOMEIELD, CO 80020, BROOMFIELD County
' ' Category Retail Gas Station

_Site Name 7-11 #18671
Locationl 1951 W 5TH AVE
Location2
: Location3
.City,County,Zip BROOMFIELD, BOULDER, 80020

-~ Source of Release _— Status Closed ' Site Classification
: MTBE Classification
Cause of Release Projected Closure
' Date

: Sardonyx Primary ID: USBRMSEV
| Sardonyx Secondary II: 001

Activity Classify
Date Activity
5/19/1995 Suspected Release
5/23/1993 Site Assessment Request
6/9/1995 Other Notable Reports .
6/21/1995 Site Assessment Request
10/13/1995 SA - Site Assessment
12/27/1995 Send Closure Letter - NFA
12/27/1995 CR - No Further Action Required

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
w °g please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522. ' :

CDLE | Staty

tebhor and Employmeant

Copyright © 2000, Celorado Dept. of Labor and Employment
Developed by Greenbricr & Russel, Inc.

You are currently logged into database COSTIS as Public







Superfund Site
Information

Site Documents

Data Element
Dictionary (DED)

Order Superfund
Products

U.5. ENVIRONMENTAL PROTECTION AGENCY
Superfund Information Systems

Recent Additions | Contact Us | Print Version ~ Search:

EPA Home > Superfund > Sites > Superfund 1nformat|on Svstems > Search Sugerfund Slte informatlo > Search Resulfs >
AERO PROPELLER )

~ Superfund Site Information

AERO PROPELLER

Site Information

Site Info | Aliases | Operable Units | Contacts
Actions | Contaminants | Site-Specific Documents

This site has been archived from the inventory of active sites.

Site Name: AERO PROPELLER
Street: 120TH AVENUE,1/2 MILE W.OF COLO.HWY. 121
City / State / ZIP: BOULDER, CO 80303

NPL Status: Not on the NPL
Non-NPL Status: NFRAP

EPA ID: CODg81548977

EPA Region: 08
County: BOULDER

- -Federal Facility Flag: Not a Federal Facility

Return to Search Results Return to Search Superfund Site information
DISCLAIMER: The data contained in these reports are intended solely for use by employees of the
U.S. Environmental Protection Agency (EPA) for management of the Superfund program.They are
not intended for use in calculating Cost Recovery Statutes of Limitation and cannot be relied upon to
create any rights, substantive or procedural, enforceable by any party in litigation with the United
States. EPA preserves the right to change these data at any time without public notice.

Data elements may not be updated. In accordance with the Superfund Program Implementation

- manual (SPIM), not all actions require a start date or a completicn date. Search capabilities may

differ from other Superfund site search query pages and EPA’s Envirofacts. The Envirofacts
database is administered by the Office of Environmental Information, and Superfund Information
Systems may contain mformatlon which is different, or not present in Envirofacts.

OSWER Home | Superfund Home

L
' EPA Home | Privacy and Security Notice | Contact Us

URL: htip://cfpub.epa.gov/supercpad/cursites/csitinfo.cim
This page design was last updated on Monday, December 01, 2008
Content is dynamically generated by ColdFusion






|Home | Search | Help |

Event

Event Id 10558
Logged By Tina Sandoval

On Friday, January 04, 2008
Reviewer Cynthia Isham .

Site Name PARK PLAZA MIDWAY
Location] 2005 MIDWAY BLVD
Location2
: Location3
City,County,Zip BROOMFIELD, BROOMFIELD, 80020

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID: USBRMPAR
Sardonyx Secondary ID: 002

Activity Classify

Date .
1/3/2008 No Further Action Request Report Received
1/3/2008 Confirmed Release Reported
1/24/2008 Closure Letter Sent (LT RBSLs)

Facility

18446 - PARK PLAZA MIDWAY

2005 MIDWAY BLVD

BROOMFIELD, CO 80020, BROOMFIELD County
Category Other

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

ﬂLt}g in

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

please contact the Public Records Center to schedule a file review at

CDLE | Stat

VS S o —
tabor and Employment

|






‘__Fadlity Registry System (_FRS) : | | share

Recent Additions | Contact Us ] Search: (OAIl EPA @ This Area | iGOl
You are here: EPA Home  Envirofacts FRS  Report o

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailable
] intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience.

% Facility Detail Report

| | Facility Name: I CENTURY. 1 CHEVROLET I
| | Location Address: I 2005 MIDWAY BLVD |
1 Supplemental Address: || I
| City Name: I BROOMFIELD T
| St || ca—
| | | - County Name: I BROOMFIELD B L{O Qun
| Z1P/Postal Code: I ~ 80020 7
| EPA Region: I 08 | 1o vyl
.|Congressional Ristrict Number:" . 02 J
| Legislative District Number: |[ e
- HUC Code; I 10190003
: 1 Federal Facility: I
| US Mexico Border Indicator; || NO
; | Tribal Land : | NO
! 1 Latitude: I 39.922141
| Longitude: I -105.091736
Method: |ADDRESS MATCHING-HOUSE NUMBER
Reference Point Description: ] PLANT ENTRANCE (GENERAL}
Duns Number: | |
Registry ID: | 110002962731 |
| [ Map this facilty ]
Environmental Interests
Inforhation Information Environmental Data Last Up. dated 593_9_"9““3—“@—'
System System ID Interest Type Source Date w
RCRAINFO || COD002802767 UNSPECIFIED || RCRAINFO || 11/29/1993

UNIVERSE (INACTIVE)

Facility Mailing Addresses

II [ || [ | rosoffomormation |




Affiliation Type || Delivery Point ” City Name”State” g_o_d_?_l_gystem

FACILITY MAILING 2005 W MIDWAY.

ADDRESS BLVD : BROOMFIELD co |iso020 RCRAINFO

REGULATORY CONTACT gﬁgg W MIDWAY BRO'OMFIELD' ' |lco |fgooz20 RCRAINFO
DATA NOT DATA NOT

OWNER REQUESTED REQUESTED ||co ”99999 RCRAINFQ

NAICS Codes

No NAICS Codes returned.

SIC Codes
. No SIC Codes returned.
Contacts
|Affiliation Type ~ [IFull Name ||0ff|ce Phone||Information System|Mailing Address||
6 [REGULATORY CONTACT|[MARTY EMGE| _|IRCRAINFO - view |
" PERMITTING CONTACT” | |[RCRAINFO B |
‘ gl B o ' '

| Organizations

|affiliation Type||Name ' lDUNS Number|[Tnformation System|[Mailing Address

S
OWNER  ||CLARKS CLEANERS|| |[RcrAINFO ~ [ View l

Alternative Names

No Alternative Names returned.

. Query executed on: MAR-27-2009 _

EPA Home I Privacy and Security Notice | Contact Us

Last updated on Friday, March 27th, 2009,
http://oaspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in=COD002802767&pgm_sys_acrnm_in=RCRAINFO
Print As-Is

This document will now print as it appears on screen when you use the File » Print command.
: ‘ Use View » Refresh to return to ongmal state. '




| Home | Search | Help |

Event

Event Id 2543
Logged By
" Reviewer Dennis Hotovec

Alt Event Id 1522-1
On Wednesday, June 13, _1990

Site Name HEARTS JIFFY STOP
Locationl 1765 MIDWAY BLVD
Location2
Location3
City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID;
Sardonyx Secondary ID:

Activity Classify

Date

6/13/1990 Confirmed Release Reported
7/10/1990 CR - No Further Action Required
5/1/1997 Send Closure Letter - NFA
5/1/1997 LUST Cleanup Initiated: Petroleum
5/1/1997 Tank Release Under Control
5/1/1997 Site Cleanup Completed

5/171997 REV Cleanup Completed

Facility

2416 - HUSKEY SERVICE STATION

1765 MIDWAY BLVD

BROOMFIELD, CO 80020, BROOMFIELD County
Category Retail Gas Station

Site Classification
MTBE Classification
Projected Closare
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
a 9 please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

. Copyright © 2000, Colorado Dept. of Labor and Employment

X Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

CDLE | Stat

Tabor and Employment




| Home{ Search | Help |

Event

- Alt Event Id
On Friday, January 23, 1998

Event Id 6219
Logged By
Reviewer Cotter

Site Name BROOMFIELD CITY SHOPS
Locationl 225 COMMERCE ST
Location2
Location3
City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID: USBRMBRO
Sardonyx Secondary ID: 003

Activity Classify

Date

11/14/1997 Confirmed Release Reported
11/14/1997 Tank Release Under Control
11/18/1997 Site Assessment Request

5/4/1998 LUST Cleanup Initiated: Petroleum

5/4/1998 Site Cleanup Completed

5/4/1998 CR - No Further Action Required

Send Closure Letter - NFA

5/11/1998

Facility ]
8837 - CITY OF'BROOMEIE MAINTENANCE

FACILL

225 COMMERCE ST
BROOMFIELD, CO 80020, BROOMFIELD County
Category State/Local Government

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

@Log In

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Diept. of Labor and Employment
Ceveloped by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

please contact the Public Records Center to schedule a {ile review at

CDLE | Statu

© Labor and Employment



:.fFacility Registry System (FRS) - s

You are here: EPA Home  Envirofacts FRS  Report

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailabie

intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apeologize for any incon_venience.

Facility Detail Report

| Legislative Districkt Number:
: | . - HUC Code: || 10120003
' | Federal Facility. ”

|
| EPARedior |
|Congressional District Number: 02 ]
|
|
:|
|

B | US Mexico Border Indicator: NO
| Tribal Land . NO |
| Latitude: ] 39.917365 |
| Longitude: ' -105.088752 |
| Method: ADDRESS MATCHING-HOUSE NUMBER|

Reference Point Description: | PLANT ENTRANCE {GENERAL)
Duns Number: "

Registry ID: I 110009561045

[+ -Map this facility: |-

Environmental Interests

'Recent Additions | Contact Us | Search: (O All EPA @ This Area | _.G° _

| Facility Name: BROOMFIELD--CITY OF GARAGE _|
[ Location Address: 225 COMMERCEST |
Supplemental Address: —l

City Name: BROOMFIELD *

v . R = {3( Z«%ZX(QV\

County Name: BROOMFIELD | T ‘\)“\'b .
Z1P/Postai Code: 1 ' 80020 : ﬂo
EPA Region: 08 -

- . . .
Information  ||Information Environmental Data Last Updated |Supplemental

System System ID Interest Type Saurce Date Environmental

Interests:

UNSPECIFIED

RCRAINFO COD981552094 UNIVERSE (INACTIVE)

RCRAINFO “ 03/16/2007

Facility Mailing Addresses

|| || || [ T eestafxatormation




| Affiliation Type ” belivery Point " City NameuState" Code” System

|REGULATORY CONTACT 3001 W 124TH AVE |[BROOMFIELD l]co lsoo20 |lRCRAINFO
- . DATANOT  ~  |IDATA NOT
IOPERATOR REQUESTED - - ||REQUESTED "99999 RCRAINFO
FACILITY MAILING
ADDRESS "3001 W 124TH AVE  (|BROOMFIELD 80020 RCRAINFO
DATA NOT DATA NOT
OWNER ||REQUESTED REQUESTED [cO  [le9992 RCRAINFO
NAICS Codes
No NAICS Codes returned.
SIC Codes
No SIC Codes returned.
A e ~  Contacts
! |Affilfati’6'|"; Type ”Full Name ||0ff|ce Phon_g”;g_f_m;m_at on System”Ma:lmg Address
A=
*/ U§|[REGULATORY CONTACT]|[MARK CLAPPER|| 3034693301 [[RCRAINFO _ View
| PERMITTING CONTACT || i IRCRAINFO -
Organizations
IAff:Ilat:on Type”Nam me - HDUNS Numbert!!nformation SVStem“Mailing Address
| OWNER |[cITY OF BROOMFIELD)|| |[RcRAINFO B View
| OPERATOR _||cITY OF BROOMFIELD| IRCRAINFO [ View

. Alternative Names

‘No Alternative Names returned.

Query executed on: MAR-27-2009

EPA Home | Privacy and Security Notice i Contact Us

Last updated on Friday, March 27th, 2009.
http://oaspub.epa. gov/en\rlro/ﬂ_query_dtl disp_program_facility?pgm_sys_id_in= COD9815520948pgm_sys_acrnm_ in= RCRAINFO
© Print As-TIs :

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to retumn to original state.




Facility Registry System (FRS) R

Recent Additions | Contact Us | Search: (Al EPA @ This Area 1 | Go
You are here: EPA Home  Envirofacts FRS  Report

The EPA Web site is undergoing maintenance this w_eekend.-Some services will be unavailable
intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience.

Facility Detail Report

| - FEacility Name: | EG&G ROCKY FLATS PU&D WHSE

[ Location Address: 224 COMMERCE ST

|
Supplemental Address: ' | .

' | City Name: BROOMFIELD

‘1 " "\00
r\o \'h) o\o‘k\b nS

State CO
‘ County Name: - BROOMFIELD
1 ZIP/Postal Code: - 80020
| __EPARegion: 08 _
: |Congre551onal District Number: L
| Legislative District Number: "
[ HUCCode: 1 10190003 |
Federal Facility: |
US Mexico Border Indicator: NO

Latitude: 39.91736 . |

|
|
| Tribal Land : - NO ]
|
|
|

Longitude; ~105.088708
Method: ADDRESS MATCHING-HOUSE NUMBER]|
Reference Point Description: || PLANT ENTRANCE (GENERAL)
Duns Number: || 1
“Registry ID: I 110003003892 ]

[ Map this facility |

Environmental Interests

Information ||Information Environmental Data Last Updated [[2uRPlemental
System System ID Interest Tvpe Source Date Environmental
System 1D Interest Type
| Interests:
UNSPECIFIED
RCRAINFO COT000644195 ” UNIVERSE (INACTIVE) RCRAINFO " 11/08/2000

Facility Mailing Addresses

Affiliation Type ] Delivery Point ” City Name”State"Postal Code”Informat:on Svstem||




|FactLITY MAILING ADDRESS||PO BOX 464 [eoen  |ico |leo402  [lrcranFo |

REGULATORY CONTACT PO BOX 464 GOLDEN co |[so402 |[RcraINFO
[ownER 80 GARDEN CENTER|[BROOMFIELD|[co [[goo20  |[rcrainFo

NAICS Codes

No NAICS Codes returned.

SIC Codes
No SIC Codes returned.
~ Contacts
|Affi|iation Type Full Name : ||Office Phone|Information System|Mailing Address
REGU{ ATORY)CONTACT||[ANDREW ROSENMAN|| 3034651064 |[RCRAINFO ‘ View
¢ i |, |[PERMITTING CONTACT][ ] RCRAINFO
. | Organizations |
|Affi!iation Type"Namg__ - DUNS Number"Information System"MaiIing Addrems_.gil
| OWNER  ][COMMANDER LEASING CO - |lrcraInFO | view |

Alternative Names

‘No Alternative Names returned.

. Query executed on: MAR-27-2009

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Friday, March 27th, 2009.
http://oaspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in=CCOT000644195&pgm_sys_acrnm_in=RCRAINFO
- Print As-Is . E

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.




Fa(:ility Registry System (FRS) | B .'-'s'“‘?‘"-*-:j;

Recent Additions | Contact Us | Search: (OAll EPA ® This Area I . G0|
You are here: EPA Home  Envirofacts FRS  Report

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailable
intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience.

, Facility Detail Report

| ‘Facility Name: |IK INTREX CORPORATION - |
[ Location Address: || 175 COMMERCE ST 1 .

' | Supplementa| Address.: L . ' L
| | ity Name: | BROOMFIELD ' p{é a (0N
| L State co S
[ County Name: . || JEFFERSON Kf"&d\ _
| ZIP/Postal Code: || 80021 o N
| -~ [___EpaRegion: | 08 o

‘ IConqressional District Number: ' 02
Legislative District Number:
HUC Code: ' 10190003 |
Federal Facility: I ' |
US Mexico Border Indicator: || NO
Tribat Land : ” NO
Latitude: I 39.916539
Longitude: I -105.088669
"Method: ||ADDRESS MATCHING-HOUSE NUMBER
Reference Point Description: " PLANT ENTRANCE (GENERAL)
| Dung Number: ————_—-_l
| Registry ID: § 110006490519 |
[ Map this facility |

Environmental Interests

Information Information Environmental Data Last Updated Supplemental . lemental
Environmental

\'d lnterest jype a0urce Date
IS stem System ID Interest Type Source Date Interests:

UNSPECIFIED
I RCRAINFQ COD983800210 || )\ 1vERSE (INACTIVE, || RCRAINFO || 10/31/2000

Facility Mailing Addresses

|| Affiliation Type || Delivery Point City Name"State"Postal Code”Information System |




[REGULATORY CONTACT [|175 coMMERCE ST ||[BrOOMFIELD|[cO  {|8oo20 ||reraInFO |
[FACILITY MAILING ADDRESS|[1815 BOXELDER ST|LOUISVILLE |[cO |[80027 lrcramnee ]
lowNER [l175 COMMERCE  |[BROOMFIELD|icO  [[80020 ||RERAINFO |

NAICS Codes

No NAICS Codes returned.

SIC Codes
No SIC Codes returned.
| ~ Contacts
Affiliation Type . |[Full Name Office Phone||Informat|on Svstem”Mallmg Address |
PERMITTING CONTACT o |[RCRAINFO | |
_[REGULATORY CONTACT|[THOMAS MCBRIDE]| 3036651154 |RCRAINFO - ||~ view |
| Organizations
Affiliation Typel[Name = |[DUNS Number|Information System|{Mailing Address
OWNER  [lINTREX cORP IRCRAINFO f View

Alternative Names

No Alterpative Names returned.

' Query executed on: MAR-27-2009 .

EPA Home | Privacy and Security Notice ~ | Contact Us

Last updated on Friday, March 27th, 2009.
http://oaspub.epa.gov/enviro/fii_query_dtl. dlsp_program _facility?pam_sys_id_in= COD983800210&pgm sys_acrnm_in=RCRAINFO
Print As-Is

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.




Facility Registry System (FRS) | shore

Recent Additions | Contact Us | Search: OAll EPA @ This Area I |'-G°|

You are here: EPA Home  Envirofacts

ERS

Report

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailable
intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience.

Facility Detail Report

1 Facility Name: - ||STORAGE TECHNOLOGY CORPORATION]|-

[ Location Address: |

Supplemental Address:

2115 ABBOT STREET

City Name: BROOMFIELD ]
|l State | Co
b County Name: | BOULDER
ZIP/Postal Code: I 80038
| EPA Region: || 08
|Congressiona| District Number:" 02

| Legislative District Number: "

| HUC Code: |

10190003

| Federal Facility: |

| US Mexico Border Indicator: ” NO i

l ‘Tribal Land : " NO I
[ Latitude: | 39.920196 |

| Longitude: || -105.09319 |

|

| Method: " ADDRESS MATCHING-HOUSE NUMBER

Reference Point Description: |[

Buns Number:
Registry ID:

~110008297333

[ - Map this facility ]

Environmental Interests

: - - - pp _h_LALL . L}

Information Information Environmental Data Last Updated Su . lemental

System System ID Interest Type Source Date Envirenmental

inieresc rype source pvate
ystem =ystem 2D E N Interests:
UNSPECI_EIED :
RCRAINFO COD000644211 || UNIVERSE (f3I-NA,_ RCRAINFO || 01/18/19%4 ||
Facility Mailing Addresses
Affiliation Type I Delivery Point City Namel|[State||Postal Code||Information Svstem||




[FACILITY MAILING ADDRESS||2270 S 88TH STREET MD N5|LoutsviLLE[co  [|so027 lRcrAINFO

|REGULATORY CONTACT 2270 S 88TH STREET MD N5[ILOUISVILLE[|cO  [80027 IRCRAINFO

NAICS Codes

No_ NAICS Codes returned.

SIC Codes
No SIC Codes returned. -
Contacts
IAffiIiation Type -||Ful| Name ||0ffice Phone”lnformation Svstem“MaiIing Addressi
[ PERMITTING CONTACT]| I lrcrainF0 = | |
[REGULATORY CONTACT|[PAUL EMERSON][ 3036734355 |[RCRAINFO ] View |

Organiz'a'tiOns |

" 'No Organizations returned.

.'Altérnative Names

No Alternative Names returned.

-Query executed on: MAR-27-2009

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Friday, March 27th, 200S.
http://oaspub.epa.gov/enviro/fii_query_dtl.disp_program_facility?pgm_sys_id_in= COD000644211&pgm sys_acrnm_in=RCRAINFO
Print As-Is :

This document will now print as it appears on screen when you use the File » Print command
Use V:ew » Refresh to retum to orlgmai state.




| Home | Search | Help |

Event

Event Id 2345
Logged By
Reviewer Jane Bral

Alt Event Id 6064-3
On Tuesday, April 12, 1994

Site Name AMOCO OQIL #5490
Locationl 425 W HWY 287
Location2
Location3
City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release

Cause of Release

Sardonyx Primary ID;: USBLDAMO
Sardonyx Secondary ID: 016

Activity - Classify

Date
4/12/1994 Confirmed Release Reported
- 8/4/1994 SA/FAN 1 - Further Action Neccessary Priority 1
11/16/1994 LUST Cleanup Initiated; Petroleum
11/22/1994 Site Assessment Request
5/31/1995 Monitoring Report
6/29/1995 Site Assessment Request
2/13/1998 See Comments
6/11/1998 CR/FIN - Further Information Needed
10/10/1999 See Comments
2/28/2000 SA - Site Assessment
6/14/2000 Send Closure Letter - NFA
6/14/2000 CR - No Further Action Required

Status Closed

Facility

6571 - CIRCLE K STORE #2709873

425 N HWY 287

BROOMFIELD, CO 80020, BROOMFIELD County
Category Retail Gas Station

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detaited information

Log In
@ 8 please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Diept. of Labor and Employment

i Developed by Greenbrier & Russel. Inc.

You are currently logged into database COSTIS as Public

CDLE | Statu

Labor and Employment




| Home | Search | Help |

Event
Event Id 4950 Alt Event Id 5132-1 Facility
Logged By On Wednesday, February 28, 3405 - A-B PETROLEUM #31
. 1990 525 HWY 287
Reviewer Joe'l Lambe : BROOMFIELD, CO 80020, BROOMFIELD County

Category Retail Gas Station w/ LPG
Site Name EXXON CO USA RAS #63864
Locationl 525 HWY 287
Location2
Location3
City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release : Status Closed Site Classification
. MTBE Classification
Cause of Release . Projecied Closure
Date -
Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity - Classify

Date Activity
; 2/28/1990 Confirmed Release Reported
2/28/1990° Fund Application Received
10/5/1990 SA - Site Assessment
10/5/1990 LUST Cleanup Initiated: Petroleum
10/5/1990 Site Investigation Completed
11/7/1990 General Correspondence
7/5/1991 Tank Release Under Control
7/5/1991 Site Cleanup Completed
7/8/1991 General Correspondence
10/16/1991 Request for CAP
3/2/1993 Send Closure Letter - NFA
3/2/1993 LUST Cleanup Initiated: Petroleum
3/2/1993 Tank Release Under Control
3/2/1993 Site Cleanup Completed
1/13/1997 CR - No Further Action Required

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
0 °8 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522. '

_ CDLE | Stat

Labor ﬁnd Employment

. Copyright © 2000, Colorado Dept. of Labor and Employment
- Developed by Greenbrier & Russel. Ing,

You are currently logged into database COSTIS as Public




|Home ! Search | Help|

Event
Event Id 7231 Alt Event 1d Facility
Logged By On Tuesday, February 02, 1999 9123 - MIDWAY 66
Reviewer Jane Bral 1760 W MIDWAY BLVD o
. BROOMFIELD, CO 80020, BROOMFIELD County
Site Name PHILLIPS 66 #27244 Category Retail Gas Station |
Locationl 1760 W MIDWAY BLVD |
Location2
Location3

City,County,Zip BROOMFIELD, BOULDER, $0020

Source of Release Status Closed © . Site Classification
' MTBE Classification
Cause of Release ' Projected Closure
Date

Sardonyx Primary ID: USBRMPHI
Sardonyx Secondary ID: 001

Activity . Classify

Date Activity
1/28/1999 Confirmed Release Reported

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
@ 8 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522,

CDLE | Stat

\aber and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc,

You are currently logged into database COSTIS as Public






Share

(o]

Facility Registiry System (FRS)

 Search: QO Al EPA @ This Areal
Report

Recent Additions | Contact Us |

You are here: EPA Home

‘Envirofacts  ERS

'Facility Name: I

BALL AEROSPACE & TECH CORP

Location Address: ||

10 LONGS PEAK DRIVE

THT

] EPA Region:
[Con ressional District Number;

Suppiemental Address: ||
City Name: | BROOMFIELD
State I Co
] County Name:; JEFFERSON
] ZIP/Postal Code; 800212510

s

| Leqislat?\.-f_e District Number:

| HUC Code:

| Federal Facility:

| US Mexico Border Indicator: " "NO
_ | Tribal Land : " ' NO )
1 Latitude: N 39.909578
| longitude: || -105.098196

Method:

| _ [ADDRESS MATCHING-HOUSE NUMBER
| Reference Point Description:

______—__——.l .

110006489237 ]

- Duns Number:

Registry ID: -

[ Map this facility .|

Environmental Interests

- - - )

; Information |Information lEnvnronmental Interest Data Source lL.las(.:ate d ““Ramm::vir:::::::“
I [IM System 1D Type Date Interests:

' ICIS-08-2000-0327

ENFORCEMENT/COMPLIANCE FORMAL

1S 644 ACTIVITY | IS 06/16/2002 | ENFORCEMENT
o | ] ACTION
ICIS-08-2000-0327
FORMAL ENFORCEMENT FORMAL
ICIS 644 ACTION ICIS 04/16/2001 || L\ concemenT
ACTION
| NOTIFICATION




][ RCRAINFO || cOD981552755 || CESQG (ACTIVE) | reray | os/17/1998 ]|

Facility Mailing Addresses

| Affiliation Type Delivery Point City Name"State Postal Code|Infermation Svsteml
|REGULATORY CONTACT 10 LONG PEAK DR BROOMFIELD"CO 80020 RCRAINFO |
OWNER 10 LONGS PEAK DRIVE BROOMFIELD"C_O -~ |lsooz20 RCRAINFO

FACILITY MAILING ADDRESS|{10 LONG PEAK DR

BROOMFIELD|[CO  |l80020 “RCRAINFO | g

NAICS Codes
- No NAICS Codes returned.
- SIC Codes
'No SIC Codes returned.
Contacts o
|Aff|!|at|on Type ”Full Name ||0ff|ce Phone”lnformat on System”Mallmg Addressl
[REGULATORY CONTACT][LAURA DAVIS|| 3034602718 |[RCRAINFO | View |
[PERMITTING CONTACT|| i IRCRAINFO - 3 ]

‘Organizations

|Affiliation Type||Name |IDUNS Number|[Information System”MaiIing Address|
|  OWNER  |[BALL CORPORATIONI| |IRCRAINFO |

- Alternative Names
Alternative Name

[Source of Data
BALL CORPORATE HEADQUARTERS (BCH)|(NOTIFICATION (RCRA)!

Query executed on: APR-03-2009

EPA Home | Privacy and Security Notice | Contact Us

- Last updated on Friday, April 3rd, 2009.
http://oaspub.epa. gov/envuro/ﬂ query_dtl. d15p_program _facility?pgm_sys_id_in=C0OD%81552755&pgm_sys_acrnm_in=RCRAINFQ
Print As-Is

This document will now print as it appears on screen when you use the File » Print command
: o Use View » Refresh to return to original state.




Facility Registry System (FRS) | share

Recent Additions | Contact Us | Search: () All EPA @ This Area | || Go
You are here: EPA Home  Envirofacts FRS  Report '

The EPA Web site is undergoing maintenance this weekend. Some services will be unavailable
intermittently between 6:00 am and 4:00 pm ET Saturday, March 28. We apologize for any inconvenience.

Facility Detail Report '

. Facility Name: | JEMCO SEAL CORPORATION
Location Address: I 3001 INDUSTRIAL LN #1
Supplemental Address: _
[ City Name: 'BROOMFIELD
[ State | co
County Name: | BROOMFIELD
ZIP/Postal Code: I 80020
EPA Region: | 08
‘lICongressional District Number:]| ' |
Legislative District Number: || |
. HUC Code: || |

| Federal Facility: ||

I
| US Mexico Border Indicator: || NO |

B Tribal Land : L o NO

[ Latitude: | 39.92232

[ Longitude: I -105.104001

| Method:  ||ADDRESS MATCHING-HOUSE NUMBER

Reference Point Description: ||

|
Duns Number: __"__ _——I

Registry ID: T 110022473599 |

|_._Map this facility . ]

Environmental Interests

B . ) i T — I e l
Information Information Environmental Data Last Updated Supplemental g ementa
Environmental

System System ID Interest Type Source Date Interests: |

UNIVERSE (INACTIVE)

| RCRAINFO " COR000211375 UNSPECIFIED ~ J ncraINFO || 06/21/2005 "

Facility Mailing Addresses

No Facility Mailing Addresses returned.




- NAICS Codes

No NAICS Codes returned.

SIC Codes
No SIC Codes returned.
Contacts | |
- 3 |Affi|iation Type ”Full Name”Office PhoneuInformation Sy&tg;m‘|Mailing Address
| PERMITTING CONTACT | I IRCRAINFO |
[REGULATORY CONTACT]| I IRCRAINFO I
~Organizations

‘No . Organizations. returned.

Alt_érnative Names

No Alternative Names returned.

| .. Query executed on: MAR-27-2009

EPA Home | Privacy and Security Notice | Contact Us

.Last. updated on Friday, March 27th, 2009.
http://oaspub.epa.gov/enviro/fii_query_dtl. dlsp_program _facility?pgm_sys_id_in= COR000211375&pgm sys_acrnm_ in=RCRAINFO
: Print As-Is

This document will now print as it appears on screen when you use the File » Prmt command.
. Use Vlew » Refresh to return to orlgmai state.




Recent Additions | Contact Us |

You are here: EPA Home  Envirofacts FRS

Search: (Al EPA @ This Area!

Report

Facility Registry System (FRS) share

[Go]

Facility Name: || SUNCOR - 2706174 ___ ||
Location Address; 1760 WEST MIDWAY BOULEVARD)|
Supplemental Address: : |
City Name: BROOMFIELD
State I co
County Name: I BROOMFIELD |
ZIP/Postal Code: I 800202043 |
EPA Regign: || 08 |
Congressional District Number:!i 02 |
Legislative District Number: |] |
HUC Code: | 10190003 |
Federal Facility: I |
US Mexico Border Indicator: 1| NO I
Tribal Land : I NO |
: _ Latituder | 39.922222 |
[ Longitude: ] -105.09 |
| Method: ] | _
: | Reference Point Description: |
Duns Number: ”_|___
Registry ID: [

110001390726 ]‘

|- .Map this facility. |

Environmental Interests

] . i . pp
Information Information Environmental Interest |(|Data Last Su , lemental
System System ID Type Source - gm Environmental
2ystem _ : . w0 || Date. Interests:
| AIRs/AFS || 0801400317 | AIR MINGR () AIRS/AFS || 06/13/2008 ||
CRITERIA AND HAZARDQUS : '
NEI NEI2C0O014317 AIR POLLUTANT NEI
L INVENTORY
NEI NEIC00130317 CRITERIA AND HAZARDOUS NEI -
T : AIR POLLUTANT _




| i INVENTORY I I
UNSPECIFIED UNIVERSE
RCRAINFOQ || CON983795204 || GRACTIVE): II RCRAINFO " 08/01/2000

Facility Mailing Addresses

| Affiliation Type

”Delivery Point” City Name!]State"Po_s“;;! Codej[Information Systeml.
[FACILITY MAILING ADDRESS|[PO BOX 2400 |BARTLESVILLE|loK _[l74005 RCRAINFO |
|OWNER |lPO BOX 2400 ||[BARTLESVILLE[[OK [[74005 RCRAINFO |
IFACILITY MAILING ADDRESS|[PO BOX 2400 ||BARTLESVILLE[joK {74005 AIRS/AFS ]
[REGULATORY CONTACT  |lPO BOX 2400 |[BARTLESVILLE|/loK  [[74005 RCRAINFO |
NAICS Codes
Data Source ‘NAI_C_S_Code"Descrmtlon Pr;marv"
NEI 4471 || I
SIC Codes
!Data Source"SIC Code!]Description iPrimﬁy

NEI

| 5541 ||GASOLINE SERVICE STATIONS||

| AIRs/AFS || 5541 |lGASOLINE SERVICE STATIONS|

NEI

| 5541

|\GASOLINE SERVICE STATIONS||

- Contacts
|Affi|iation Type "Full Name |9ffice Phone|(Information Systemjﬁ\flailing Addresg|
COMPLIANCE CONTACT][THOMAS H KOSEL][ 9186617439 [[AIRS/AFS I |
PERMITTING CONTACT RCRAINFO I |
REGULATORY CONTACT|| THOMAS KOSEL || 9186617439 ||RCRAINFO | View |
Organizations

Affiliation Type lName

OWNER

PHILLIPS PETROLEUM COMPANY

DUNS Number"Information SVStem"Mali ing Addressl

| RCRAINFO

| view |

Alternative Names

|Alternat|ve Name

[Source of Data

S.66 STATION. 27244

MANUAL ENTRY}

PHILLIPS PETROLEUM CO  AIRS/AFS
‘PHILLIPS PETROLEUM CO SS# 27244| RCRAINFO

| PHILLIPS 66 NUMBER 27244

AIRS/AFS




| Home | Search | Help |

Event

Event Id 9507
Logged By Kathleen Tuymer
Reviewer Jennifer Steffes

On Monday, May 24, 2004

Site Name BROOMFIELD FUELING STA
Locationl 1600 HWY 287
Location2
Location3
City,County,Zip BROOMFIELD, BROOMFIELD, 80020

Source of Release Historical contamination Status State Lead

Cause of Release

Sardonyx Primary 1ID: USBLDBRO -
Sardonyx Secondary ID: 004

Activity Classify

Date

3/10/2000 Other Notable Reports Received
5/14/2000 Confirmed Release Reported
6/26/2003 SSF / SCR Request Letter Sent

; 5/24/2004 Miscellaneous Correspondence Sent

\ 10/20/2004 Phone Call Received

:" 10/25/2004 Receive Misc Correspondence
8/14/2006 Change Status
3/20/2008 Monitoring Report Received
6/23/2008 Monitoring Report Received
10/17/2008 Monitoring Report Received
14772009 Other Notable Letters Received
1/20/2009 Moenitoring Report Received
2/24/2009 Monitoring Report Received

0 Log In

- please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522, B

- Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

. Youare currently logged into database COSTIS as Public

Facility

8734 - BROOMFIELD FUELING STA

1600 HWY 287

BROOMFIELD, CO 80020, BROOMFIELD County
Category State/Local Government

2.7

Site Classification
MTBE Classification
Projected Closure
Date '

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

, CDLE | Stat
loymant

La:hor and Emp







: }_-mméj Search | Help |

Event

Event Id 548 Alt Event Id 3934-1 _
Logged By On Tuesday, July 25, 1989
Reviewer Vinny Secondo

Site Name CONOCO
. Locationl 1601 HWY 287
- Location2

Location3
City,County,Zip BROOMFIELD, BROOMFIELD, 80020

Source of Release Status Open

Cause of Release

Sardonyx Primary ID: USBRMCON
Sardenyx Secondary ID; 001

Activity Classify

Facility

10255 - CONOCO #06370

1601 HWY 287
BROOMFIELD, CO §0020, BROOIV[F[ELD County

- Category Retall Gas Station

- Site Classification 2.7
- ' MTBE Classification .Pathway
: Eliminated
- . Projected Closure
"~ Date

Date
7/19/1989 Confirmed Release Reported
8/4/1989 Site Assessment Request S
10/10/1989 SA/FAN 1 - Further Action Neccessary Priority 1
10/10/1989 LUST Cleanup Initiated: Petroleum
11/27/1950 Site Assessment Request
10/6/1992 CR/FAN 1 - Further Action Neccessary Prlorlty 1
11/24/1992 Site Assessment Request
3/1711993 Request for CAP
4/21/1993 Request for CAP
2/24/1994 Other Notable Reports
4/8/1994 Request for CAP
4/15/1994 Other Notable Reports
3/24/1995 Request for CAP
9/18/1995 SA/FAN 1 - Further Action Neccessary Priority 1
11/22/1995 General Correspondence
12/8/1995 Other Notable Reports
3/8/1996 CAP - Corrective Action Plan
6/3/1996 CAP Denial Letter Sent
8/16/19%6 CAP - Corrective Action Plan
9/3/19%96 Request for CAP
10/16/1996 General Correspondence
10/24/1996 Other Notable Reports
11/21/1996 CAP - Corrective Action Plan
12/31/1996 CAP Conditional Approval Letter Sent
1/28/1997 Other Notable Reports
3/21/1997 Other Notable Reports
6/6/1997 Monitoring Report
8/15/1997 Monitoring Report
10/23/1997 Monitoring Report
2/17/1998 Monitoring Report
3/4/1998 Other Notable Reports
5/14/1998 Monitoring Report
8/21/1998 Monitoring Report
10/21/1998 Request for CAP
11/18/1998 Monitoring Report
2/2/1999 Request for Extension
2/18/1999  Monitoring Report
3/15/1999 CAP - Corrective Action Plan

9/24/1999 Monitoring Report



5/22/2000
10/17/2000
12/14/2000
4/5/2001
4/5/2001
5/17/2001
5/17/2001
8/27/2001
12/12/2001
3/15/2002
5/29/2002
7/26/2002
10/8/2002
11/18/2002
2/6/2003
2/21/2003
' 4/4/2003
4/7/2003
5/29/2003
9/5/2003
9/11/2003
10/1/2003
10/1/2003
10/6/2003
10/6/2003
10/9/2003
10/10/2003
11/25/2003
12/12/2003
12/16/2003
12/23/2003
3/8/2004
5/3/2004
6/2/2004
10/1/2004
10/18/2004
12/8/2004
12/20/2004
3/7/2005
5/23/2005
8/22/2005
11/23/2005
12/28/2005
3/10/2006
5/22/2006
5/22/2006
6/21/2006
7/5/2006
11/24/2006
12/26/2006
2/22/2007
3/9/2007
3/27/2007
7110/2007
8/14/2007
11/1/2007
11/1/2007
11/1/2007
11/13/2007
11/15/2007
12/6/2007
 2/8/2008
| 6/25/2008

. Monitoring Report Received

Monitoring Report

- Monitoring Report Received
‘Monitoring Report Received

~ Other Notable Reports Received

* Monitoring Report Received

Change Status

Monitoring Report Received

Moenitoring Report Received

Monitoring Report Received

Monitoring Report Received

Site Visit - RSIP

Monitoring Report Received

Monitoring Report Received

CAP Modification Request Sent
Monitoring Report Received

CAP Deadline Extension Request Received
CAP Deadline Extension Approval Letter Sent
Monitoring Report Received

Phone Call Made

CAP Final Request Letter Sent

CAP Deadline Extension Request Received
CAP EFS Effective Date

Miscellaneous Correspondence Sent
CAP Deadline Extension Request Received
CAP Deadline Extension Approval Letter Sent
Receive Misc Correspondence
Monitoring Report Received

Site Visit - RSIP

CAP Addendum/Modification Received
Flectronic EFS Received

Monitoring Report Received

Monitoring Report Received

CAP EFS in Negotiation

CAP Modification Approval Letter Sent
Monitoring Report Received

Site Visit - RSIP

Monitoring Report Received
Monitoring Report Received-
Monitoring Report Received

Monitoring Report Received

Monitoring Report Received

Site Visit - RSIP

Monitoring Report Received

MTBE MARS Report Requested
Monitoring Report Received

Other Notable Reports Received
Electronic EFS Received

Monitoring Report Received

CAP Addendum/Modification Received
Electronic EFS Received

Monitoring Report Received

CAP EFS in Negotiation

CAP Modification Approval Letter Sent
Monitoring Report Received

Phone Call Received

CAP Addendum/Modification Received
CAP EFS in Negotiation

CAP Modification Approval Letter Sent
Receive Misc Correspondence
Miscellaneous Correspondence Sent
Monitoring Report Received

MTBE MARS Report Received




- 8/6/2008
- 10/13/2008
12/8/2008
12/15/2008
1/28/2009
1/28/2009
1/29/2009
1/29/2009
1/29/2009
3/4/2009

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
0 o9 please contact the Public Records Center to schedule a file review at

MTBE Pathway Elimination Letter Sent
Monitoring Report Received
Monitoring Report Received
Miscellaneous Correspondence Sent
Receive Misc Correspondence
Miscellaneous Correspondence Sent
Phone Call Received

Monitoring Report Received
Miscellancous Correspondence Sent
Meeting Held

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc.

. You are currently logged into database COSTIS as Public

Labor ond Employment

CDLE | Stat







'Home | Search | Help |

Event
Event Id 1660 Alt Event Id 9100556-1 Facility
Logged By On Wednesday, June 23, 1993 12867 - COSCAN COMMERCIAIL, PROPERTIES INC
Reviewer Edgar Ethington 2100 INDUSTRIAL LN
BROOMFIELD, CO 80020, BROOMFIELD County
Site Name COSCAN COMMERCIAL PROPERTIES INC ' C_ategory Other
Locationl 2100 INDUSTRIAL LANE '
Location2
Location3

City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release Status Closed Site Classification
MTBE Classificaticn
Cause of Release Projected Closure
Date
Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity Classify

-~ Date Activity
6/23/1993 Confirmed Release Reported

10/13/1993 _ CR - No Further Action Required

11/16/1993 LUST Cleanup Initiated: Pefroleum

11/16/1993 Tank Release Under Control

11/16/1993 Site Cleanup Completed

11/18/1993 Send Closure Letter - NFA

' Log in is for Oil and Public Safety Employees only. For more detailed information

: Log In
« 8 please contact the Public Records Center to schedule a file review at
3 (303) 318-8521 or (303) 318-8522.

CDLE | Stat

lm and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & _Russe!, Inc.

You are currently logged into database COSTIS as Public
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Hazardous Materials and Waste Management Division

Site Reports
Voluntary Cleanup Site Reports
Individual Application Report Monday, March 30, 2009
L. ... ... VewinExcel . .. o]
] APP Number: VA-00303 B __Type:NAD
N COWBOY CLEANERS
| Site Number: VS-00263 | COWBOY CLEANERS l
© [1305 W 4TH AVE
BROOMFIELD, CO
80020-2021 L ~
| [County: BROOMFIELD [010522-1 ~ |
|Ma]0r Contaminants: __j
[Project Manager: MARK WALKER [Review Cost: $2,000.00 |
Received: 5/22/2001 __ |Extension: 578 Days __|[Due: 2/4/2003 |
Decision: APPROVED Date of Decision: 2/4/2003 |
Tax Jobs Residences Acres
Credit Created Created Remediated
$0.00 I 0 1
Other Issues:
ISOLVENTS
B Media Affected I |
GROUND WATER |Details: Volatile Organic Compounds(VOCs) |
| Land Use Restrictions . ||
] ‘Ié%nﬁllgESMIXED ) _IID: 1 Covenant: WI:Tf)ne ||

Data last updated on: 4/1/2008

For more information on a given site please contact the Iazardous Materials and Waste

. Management Division Record Center to conduct a complete records review.

The Hazardous Materials and Waste Management Division (HMWMD) has attempted, to the
best of its ability, to ensure that this information is correct. However, it is possible that some

of the information shown here is not correct. The HMWMD is not responsible for uses made
of this information and shall not be l1ab1e to the user of this information or to any other party

- for any reason whatsoever.



Hazardous Materials and Waste Management Division

Site Reports
Voluntary Cleanup Site Reports
Individual Application Report Monday, March 30, 2009
APP Number: VA-00022 || Type: NAD |

sl GENEVA PHARMACEUTICALS |
. Site Number: VS-00018 || GENEVA PHARMACEUTICALS

2655 MIDWAY BLVD
BROOMFIELD, CO
80020-1672

County: BOULDER [950821-1 . B
|Ma_]or Contaminants: ' |

- [Project Manager: MARKWALKER [Review Cost: $3,752.67 |
Received: 8/21/1995 Extension: 78 Days |Due 12/22/ 1995
Decision: APPROVED Date of Decision: 12/22/1995 I

Tax Jobs Residences Acres
Credit Created Created Remediated
| $0.00 | 0 I 0 | 4.4 |
Other Issues: :
Upgradient Source

Medla Affected o |

GROUND WATER Details: Metals. Volatile Organic. Organic Compounds(VOCs) from
offsite source. )

Land Use Restrictions ~ _—_I
|Land_Use. INDUSTRIAL ID: 1 !Cover_l_e_l_nt. None __]

| Data last updated on: 4/1/2008

For more information on a given site please contact the Hazardous Materials and Waste
. Management Division Record Center to conduct a complete records review.

The Hazardous Materials and Waste Management Division (HMWMD) has attempted, to the
best of its ability, to ensure that this information is correct. However, it is possible that some
of the information shown here is not correct. The HMWMD is not responsible for uses made
of this information and shall not be liable to the user of this information or to any other party
for any reason whatsoever



Superfund Site
Information

Site Documents

Data Element
Dictionary (DED)

Order Superfund
Products

U.5, ENVIRONMENTAL PROTECTION AGENCY
Superfund Information Systems | )

Recent Additions | Contact Us | Print Version  Search: |

EPA Home > Superfund > Sites > Superfund Information Svstems > Search Sugerfund Site Information > Search Results >
GENERIC STORAGE SITE

Superfund Site Information

GENERIC STORAGE SITE

S'ite Information

Site Info | Aliases [ Operable Units | Contacts
Actions | Contaminants | Site-Specific Documents

This site has been archived from the inventory of active sites.

Site Name: GENERIC STORAGE SITE
Street: 7620 W. 116 TH AVENUE
City / State / 21P: BROOMFIELD, CO 80226

NPL Status: Not on the NPL
Non-NPL Status: NFRAP;:?_.;=

EPA ID: COD980955736

EPA Region: 08
County: BROOMFIELD

Federal Facility Flag: Not a Federal Facility
Incident Category: Abandoned

Return to Search Resuits Return to Search Superfund Site Information

DISCLAIMER: Be advised that the data contained in these profiles are intended solely for informational purposes use by
emp[oyees of the U.S. Environmental Protection Agency for management of the Superfund program. They are not intended for
use in calculating Cost Recovery Statutes of Limitations and cannot be relied upon to create any rights, substantive or
procedural, enforceable by any party in litigation with the United States. EPA reserves the right to change these data atany
tlme without public nofice.

QSWER Home | Superfund Home

L]
EPA Home | Privacy and Security Notice | Contact Us

URL: hitp:/icfpub.epa.govisupercpad/cursites/csitinfo.cfim
This page design was last updated on Monday, December 01, 2008
i Content is dynamically generated by ColdFusion
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Dictionary (DED)

Order Superfund
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U.5. ENVIRONMENTAL PROTECTION AGENCY

k)

Superfund Information Systems )

"

Recent Additions | Contact Us | Print Version ~ Search:: . [EEl

EPA Home > Superfund > Sites > Superfund Information Systems :Searchisugerfund Site Information > Search Results >
SUN CHEM CORP - GPI DIV :

Superfund Site Information
‘SUN CHEM CORP - GPI DIV

Site Information

Site Info | Aliases | Operable Unjts | Contacts
Actions | Contaminants | Site-Specific Documents

This site has been archived from the inventory of active sites.

Site Name: SUN CHEM CORP - GPI DIV
Street: 2310 W MIDWAY BLVD
City / State / ZIP: BROOMFIELD, CO 80020

NPL Status: Not on the NPL
Non-NPL Status:NE

EPA ID: COD085277754

EPA Region: 08
County: BROOMFIELD

Federal Facility Flag: Not a Federal Facility
Return to Search Resuits Return to Search Superfund Site Information

DISCLAIMER: Be advised that the data contained in these profiles are intended solely for informational purpeses use by
employees of the U.S. Environmental Protection Agency for management of the Superfund program. They are not infended for
use in calculating Cost Recovery Statutes of Limitations and cannot be relied upon to create any rights, substantive or
procedural, enforceable by any party in litigation with the United States. EPA reserves the right to change these data at any
time without public notice.

OSWER Home | Superfund Home

L ]
. EPA Home | Privacy and Security Notice | Contact Us

URL: http:/cfpub.epa.govisupercpadicursites/csitinfo.cfm
This page design was last updated on Monday, December 01, 2008
: Content is dynamically generated by ColdFusion



Page 1 of 2

NATIONAL RESPONSE CENTER 1-800-424-8802

#%% For Public Use *%%*

Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 383033

INCIDENT DESCRIPTION

*Report taken at 17:41 on 08-APR-97

Incident Type: FIXED

Incident Cause: QPERATOR ERROR

Affected Area:

The incident occurred on 08-APR-97 at 00:01 local time.

Affected Medium: LAND ASPHALT/STORM DRAIN

SUSPECTED RESPONSIBLE PARTY

Organization: UNITED VAN LINES
FENTON, MO 63026

Type of Organization: PRIVATE ENTERFPRISE

INCIDENT LOCATION
6028 EAST COUNTY LINE RD County: DOUGLAS
City: HIGHLAND RANCH State: CO

RELEASED MATERIAL(S)
CHRIS Code: 0ODS Official Material Name: OIL: DIESEL

Also Known As:
Qty Released: 50 GALLON(S) Qty in Watexr: 0 NONE

DESCRIPTION OF INCIDENT

SOURCE: SADDLE TANK (TANK CAPACITY: 100 GALS)/CAUSE: DRIVER RAN INTOA CURE AND
PUNCTURED A HOLE IN THE TANK CAUSING THE SPILL '

INCIDENT DETAILS

Package: N/A

Building ID:

Tyvpe of Fixed Object: UNKNOWN
Power Generating Facility: UNKNOWN
Generating Capacity:

Tvype of Fuel:

NPDES:

NPDES Compliance: UNKNOWN

DAMAGES

Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: UNKN Hospitalized: Empl /Cxrew: Passenger:
FATALITIES: UNKN Empl /Crew: Passenger: Qccupant:

http://www.nre.uscg.mil/reports/rwservlet?standard web+inc_seq=383033 | ; ' 3/30/2009




Page 2 of 2

EVACUATIONS: NO Who Evacuated: Radius/Area:
Damages: NO
Length of Direction of
Clogure Type Degcription of Closure _ Closure Closure
Alrx: -
N
. . M
Road: N o 21
Waterway: N
Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN
Media Interest: Community Impact due to Material: NO

REMEDIAL ACTIONS
DIRT AND ABSORBENT MATERIAL WAS USED TO CLEAN UP THE SPILL. 35 GALS OFDIESEL/WATEF
MIXTURE WAS PUMPEPD FROM THE STORM DRAIN. '
Release Secured: UNKNOWN
Release Rate:
Estimated Release Duration:

WEATHER

ADDITIONAL AGENCIES.NOTIFIED
Federal: :

State/Local:

State/Local On Scene:
State Agency Number:

_ NOTIFICATIONS BY NRC
ATSDR CO ATTN:CHRYSTINE KELLY (PRIMARY)

08-APR-97 00:00

U.5. EPA VIII (PRIMARY)
08-APR-97 17:47

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
08-APR-97 00:00

CO OIL & GAS CONSERVATION CCMM (PRIMARY)
08-APR-97 00:00

DOI/OEPC DENVER (PRIMARY)
08~-APR-387 00:00

ADDITIONAL INFORMATION

*%% END INCIDENT REPORT # 383033 *kk

http://www.nre.uscg.mil/reports/rwservlet?standard_web+inc_seq=383033 13/30/2009




NATIONAL RESPONSE CENTER 1-800-424-8802

} *** For Public Use *#*

! Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 639176

INCIDENT DESCRIPTION

*Report taken at 22:55 on 11-MAR-03

Incident Type: FIXED

Incident Cause: OTHER

Affected Area:

The incident occurred on 11-MAR-03 at 13:30 local time.

Affected Medium: AIR ATMOSPHERE

SUSPECTED RESPONSIBLE PARTY

Tvpe of Organization: UNKNOWN

INCIDENT LOCATION
11800 OLDE WADSWORTH BLVD County: JEFFERSON
City: BROOMFIELD State: CO

PRIVATE RESIDENCE

RELEASED MATERIAL(S)
CHRIS Code: NCC Official Material Name: NO CHRIS CODE

Also Known As: PHOSPHINE GAS
Qty Released: 0 UNEKNOWN AMOUNT

DESCRIPTION OF INCIDENT

CALLER STATED THAT THERE WAS A METH LAB INSIDE A TRAILER. A WARRANT WAS ISSUED AND
CARRIED OUT ON 11 MAR 03. THERE WERE AIR EMISSION RELEASES OF VARIOUS SUBSTANCES
DURING THE MANUFACTURING OF THESE ILLEGAL PRODUCTS.

INCIDENT DETAILS

Package: N/A

Building ID:

Type of Fixed Object: PRIVATE RESIDENCE
Power Generating Facility: NO
Generating Capacity:

Type of Fuel:

NPDES :

NPDES Compliance: UNKNOWN

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: NO Hospitalized: Empl/Crew: Passenger:
FATALITIES: NO Empl/Crew: Passenger: Qecupant:
EVACUATIONS: NO Who Evacuated: Radius/Area:

Damages: NO

Length of Direction of

Ml asnra Tuna Nascrintioam af Clasnra Ol asura 1 asnra




Air: N

Road: N Major
: Artery: N
Waterway: N o

Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN
Media Interest: LOW Community Impact due to Material: NO

REMEDIAL ACTIONS

CLEANUP COMPLETED

Release Secured: YES
Release Rate:

Estimated Release Duration:

WEATHER

Weather: CLEAR, 65°F Wind speed: 30 MPH Wind direction: NE

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local:
State/Local On Scene:

State Agency Number:

NOTIFICATIONS BY NRC

ATSDR CO ATTN:JANET JONES (PRIMARY) '
11-MAR-03 23:04

CHEMICAL SAFETY BOARD - AFTER HRS (PRIMARY)
11-MAR-03 23:06

EPA OFFICE OF EMERG RESPONSE(OERR) (PRIMARY)
11-MAR-03 23:09

U.S. EPA VIIT (PRIMARY)
11-MAR-03 23:08

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
11-MAR-03 23:04

CO OIL & GAS CONSERVATION COMM (PRIMARY)
11-MAR-03 23:04

DOI/OEPC DENVER (PRIMARY)
11-MAR-03 23:04

ADDITIONAL INFORMATION
CALLER WILL NOTIFY HEALTH DEPARTMENT NEXT.

**%* END INCIDENT REPORT # 639176 TRk
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Dictionary (DED)

Order Superfund
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U.S, ENVIRONMENTAL PROTECTION AGENCY

Superfund Information Systems ;

-

Recent Additions | Contact Us | Print Version ~ Search: B2

EPA Home > Superfund > Sites > Superfund Information Systems » é;;ﬁ;:HVSuperfund Site Information > Search Results >
CHEMICAL HANDLING CORP

Superfund Site Information

CHEMICAL HANDLING CORP

Site Information

Site Info | Aliases | Operable Units | Contacts
Actions | Contaminants | Site-Specific Documents

Site Name: CHEMICAL HANDLING CORP
Streef: 11811 UPHAM STREET
City / State / ZIP: BROOMFIELD, CO 80020

NPL. Status: Not on the NPL
Non-NPL Status::NERAP-

EPA |D: CODS982598047

EPA Region: 08
County: BROOMFIELD

Federal Facility Flag: Not a Federal Facility

Incident Category: Other

Return to Search Results Return to Search Superfund Site Information

DISCLAIMER: Be advised that the data contained in these profiles are intended solely for informational purposes use by
employees of the U.S. Environmental Protection Agency for management of the Superfund program. They are not intended for
use in calculating Cost Recovery Statutes of Limitations and cannet be relied upon to create any rights, substantive or
procedural, enforceable by any party in litigation with the United States. EPA reserves the right to change these data at any

~ time without public notice.

OSWER Home | Superfund Heme

L ]
- EPA Home | Privacy and Security Notice | Cantact Us

URL: http:/cfpub.epa.gov/supercpad/cursitesi/csitinfo.cfm
This page design was last updated on Monday, December 01, 2008
Content is dynamically generated by ColdFusion



Superfund Site
Information

Site Documents

Data Element
Dictionary (DED)

Order Superfund
Products

U.5. ENVIRONMENTAL PROTECTION AGENCY
-,

Superfund Information Systems ;

-

Recent Additions | Contact Us | Print Version ~ Search: -

EPA Home > Superfund > Sites > Superfund [nformation Systems > Sre'a"\rch Superfund Site Information > Search Resuits >
CHEMICAL HANDLING CORP

Superfund Site Information
CHEMICAL HANDLING CORP

Site Information

Site Info | Aliases | Operable Units | Contacts
Actions | Contaminants | Site-Specific Documents

Site Name: CHEMICAL HANDLING CORP
Street: 11811 UPHAM STREET
- City / State / ZIP: BROOMFIELD, CO 80020

NPL Status: Not on the NPL
Non-NPL Status: NFRAP

EPA iD: COD982588047

EPA Region: 08
County: BROOMFIELD

Federal Facility Flag: Not a Federal Facility
Incident Category: Other

Return to Search Resulis Return to Search Superfund Site Information
DISCLAIMER: The data contained in these reports are intended solely for use by employees of the

U.S. Environmental Protection Agency (EPA) for management of the Superfund program.They are
not intended for use in calculating Cost Recovery Statutes of Limitation and cannot be relied upon to
create any rights, substantive or procedural, enforceable by any party in litigation with the United
States. EPA preserves the right to change these data at any time without public notice.

Data elements may not be updated. In accordance with the Superfund Program Implementation
manual {SPIM), not all actions require a start date or a completion date. Search capabilities may
differ from other Superfund site search query pages and EPA’s Envirofacts. The Envirofacts

database is administered by the Office of Environmental Information, and Superfund Information

Systems may contain information which is different, or not present in Envirofacts.
QSWER Home | Superfund Home

oAb ]
EPA Home | Privacy and Security Notice | Contact Us

URL.: hitp:/fefpub.epa.govisupercpad/cursites/csitinfo.cfm
This page design was last updated on Monday, December 01, 2008
Content is dynamically generated by ColdFusion



Facility Registry System (FRS)

Recent Additions | Contact Us |
You are here: EPA Home

Envirofacts = FRS Report

Search: OAIl EPA @ This A_real

‘Facility Name:
Location Address:

" Supplemental Address;:

[ CHEMICAL HANDLING CORPORATION
11811 UPHAM STREET

City Name: BROOMFIELD
[ State co
County Name: | BROOMFIELD |
ZIP/PostalCode: || 800202753

EPA Region: i 08

Conaressional District Number:u 02

Legisiative District Number: "

HUC Code: || 10190003 ]

[ Federal Facility: || NO ]
[ US Mexico Border Indicator: || NO ]
Tribal Land : | NO ]
Latitude: || 39.9115 |

Longitude; | -105.078146 ]

"~ Method: |[ADDRESS MATCHING-HOUSE NUMBER]

. Reference Point Descrigtion:__J

: [ --Duns Number; —I

PLANT ENTRANCE (GENERAL)

110000621505

Al  Registry ID: . . ||

15

| Map this facility . |

Environmental Interests

Information | Information Environmental Data Lﬁate d Sﬁp'nlem_ental Environmental
System System ID Interest Type Source SI;T Interests:
| cercuis ][ copos2s9soaz SUPERFUND || CERCLIS I |
1 o RCRAINFO-COD982581050
TSD
ECOMAP COMOC0000848 STATE MASTER ECOMAP- RCRAINFO-COD982581050
ENFORCEMENT/COMPLIANCE
ACTIVITY

FORMAL

ICIS-08-15996-0058
FORMAL ENFORCEMENT ACTION
ICIS-08-1997-0261




ICIS 3771

ENFORCEMENT
ACTION

ICIS 02/28/2002

FORMAL ENFORCEMENT ACTION
ICIS-08-1999-0083
FORMAL ENFORCEMENT ACTION

I_RC RAINFO

€ODS82581050

CORRECTIVE
ACTION (ACTIVE)

RCRAINFOQj 04/07/1997

RCRAINFO

€0Dbo82598047

UNSPECIFIED
UNIVERSE
(INACTIVE)

RCRAINFO|| 08/21/2001

-]

Facility Mailing Addresses

[ Affiliation Type

|

Delivery Point “_H City Nama"State"Postal Code

Information Svstem|

[FACILITY MAILING ADDRESS]

11811 UPHAM ST UNIT-B||BROOMFIELD||CO

IREGULATORY CONTACT  |(PO BOX 1325 |[BROOMFIELDf[cO  {[80038 |RCRAINFO |
l[owNER ~__|poBox 1044  |[BrooMrIELD]lco ][80038 RCRAINFO l
[FACILITY MAILING ADDRESS|[PO BOX 1325 |lBROOMFIELD|[cO _ [|80038 [RCRAINFO |

NAICS Codes

No NAICS Codes returned.

lsoo20  |[rcrainro |

SIC Codes
lData Source||SIC Code||Description _ ”_Primanz
[ 1cs 5169 |[CHEMICALS AND ALLIED PRODUCTS, NOT ELSEWHERE CLASSIFIED)||
Contacts
Affiliation Type [[Eull Name [office Phone|[information System|[Mailing Address|
| PERMITTING CONTACT | | | __|rcramnvo | |
[REGuLATORY conTACT|[ I —_[lRcrainFo I
[REGULATORY CONTACT]|JAMES ROBERTSON]| 3034601000 ||RCRAINFO View |
[PERMITTING CONTACT]| | [RCRAINFO |
Organizations

e

lDUNS Number

Affiliation Type|[Name
[ owner |

Information System"Mailing Address

[MELICHAR RA PRESIDENT]|

RCRAINFO I View

Alternative Names

"Source of Data

Alternative Name

CHEMWEST CORPORATION||

RCRAINFO

Query executed on: APR-03-2009




http: //oaspélb .epa. gm(.r)/_ieémro/fn_query dtl.disp_program_facility?
pam_sys_id_in=COD07835380 1 SRaBy_sySEASEY AR RERAINDG.
Facmty Registry System (FRS)

. You are here: EPA Home Envirofacts FRS Report

,' = Facility Detail Report

| Facility Name: |IMICROSEMI CORPORATION COLORADO|
[ Location Address: || 800 HOYT STREET |
| Supplemental Address: || ‘ ]
- City Name: I BROOMFIELD |
State o
County Name: ~ BROOMFIELD

| ZIP/Postal Code: I 800206774
y EPA Region: I 08

ICongressionaI District Number: " 02

) IL_e_ gislative District Number: || l

o HUC Code: [ 10190003 |

' ] " Federal Facility: I |

[ Us Mexico Border Indicator: || - ~______No |

| Tribal Land: || ~___NO ]

oo T Latitudes | 39.929296 ]
A Longitude: [ ~-105.102295 I
B Method: | ADDRESS MATCHING-HOUSE NUMBER]|

| Reference Point Description: | PLANT ENTRANCE (GENERAL) |

|_ Duns Number: "
Registry ID: [ 110000466576

... Map this facility .|

Environmental Interests

. . . Last
Informat:onl Information Envnronmentall Py Supplemental
System Svstem ID Interest Type M _ ga::l:ted Environmental Interests:
AIRS/AFS " 0801400324 AIRMSIL%TRH(E)TIC" * AIRS/AFS  ||03/31/2008
[ AIRS/AFS | 0801401327 ][ AIR MINOR () || _AIRS/AFS__][03/31/2008] |
' ' RCRAINFO-COD078353901
: LQG
ECOMAP COM000000484 ||STATE MASTER ECOMAP RCRAINFO-COD078353901
= _ ENFORCEMENT/COMPLIANCE
ACTIVITY
RITERIA AND
NEI NEI1368 CHA;ARDOUS NET
AIR POLLUTANT :




L | | nvenTory || L <l
CRITERIA AND |
' HAZARDOUS -
NEI NEI2C00324 || a1k oororanT NEI
INVENTORY |
RCRAINFO || COD078353901 " LQG (ACTIVE) NOT(IFE(I:%T)ION 10/03/2008l
' HAZARDOUS
WASTE
RCRAINFO | COD078353901 BIENNIAL RCRAINFO [|12/31/2005
REPORTER
(ACTIVE)
- CORRECTIVE
RCRAINFO [ coRrogo012443 ACTION RCRAINFO {|09/26/2005
L (ACTIVE)
RCRAINFO || COR000012443 |l SQG (ACTIVE) || RCRAINFO |[09/26/2005
TRI
TRIS  [180020MCRSM800HO|| TR REPORTER | REPORTING [|06/26/2008
FORM

Facility Mailing Addresses

] Affiliation Type Delivery Point ||_City Name|[State|[Postal CodeInformation System|
[OWNER [2381 MORSE AVE |[IRVINE lca Jjo2614 ][RCRAINFO |
FACILITY MAILING ADDRESS|[800 HOYT ST __|[BROOMFIELDI|[CO _][80020 IRCRAINFO |
FACILITY MAILING ADDRESS|[800 HOYT ST ||BROOMFIELD|[cO  [[80020 [TrIS |
OWNER l802 HOYT STREET|[BROOMFIELD|jcO  |[80020 |[RCRAINFO |
REGULATORY CONTACT PO BOX 1442  lFoLsoMm CA_|lo5630 IRCRAINFQ |
[FACILITY MAILING ADDRESS|[PO BOX 1442 FOLSOM CA _ ]l95630 [[RCRAINFO
[FACILITY MAILING ADDRESS|[800 HOYT ST BROOMFIELD|[cO__][80020 [|ATRS/AFS
|[OPERATOR 1800 HOYT ST BROOMFIELD|[CO  [[80020 [RCrRAINFO
IREGULATORY CONTACT __ 1|800 HOYT ST BROOMFIELD|[CO _ [|80020 [[RCRAINFO

NAICS Codes

[Data Source[NAICS Code|[Description . [lPrimary]
RCRAINFO 334413 |{SEMICONDUCTOR AND RELATED DEVICE MANUFACTURING. |
NEI 334413 |[SEMICONDUCTOR AND RELATED DEVICE MANUFACTURING.| |
: SIC Codes
IData Source||SIC Code|Description |[Primary]|
. TRIS | 3471 |[ELECTROPLATING, PLATING, POLISHING, ANODIZING, AND COLORING|| |
| NEI || 3674 | SEMICONDUCTORS AND RELATED DEVICES I |
| AIRS/AFS | 4959 || SANITARY SERVICES, NOT ELSEWHERE CLASSIFIED |
[ TRIS . || 3671 || ELECTRON TUBES ]
[ TrRIS || 3674 || SEMICONDUCTORS AND RELATED DEVICES ]
l NEI - |- 3674 || SEMICONDUCTORS AND RELATED DEVICES
[ AaIRs/AFS || 3674 | SEMICONDUCTORS AND RELATED DEVICES

Contacts



||Affiliation Type [Full Name __|[Office Phone|[Information System|[Mailing Address|
REGULATORY CONTACTI CHUCK EPSTEIN 9169830648_| RCRAINFO | View

PERMITTING CONTACT|| | [RCRAINFO | [
COMPLIANCE CONTACT][RICH KENT | 3034692161 ||JAIRS/AFS | |

PERMITTING CONTACT ]| ] [RCRAINFO I |
PUBLIC CONTACT || MARTIN BIRCH || 3034692161 |[TRIS I
REGULATORY CONTACT|| MARTIN BIRCH ][3034692161x|[RCRAINFO I View
Organizations

Affiliation Name " |louns Information Mailing
e S B Number System Address

| OWNER MICROSEMI CORPORATATION _ || |IRCRAINFO View
MICROSEMI CORPORATION .

OPERATOR ) COLORADO RCRAINFO View
MICROSEMI CORPORATION .

| OPERATOR COLORADO RCRAINE:O View

| OWNER MICROSEMI OF COLORADO __|[ IRCRAINFO I View

Alternative Names

|Alternative Name — __I
_] MICROSEMI CORP CO | AIRS/AFS |
[ MICROSEMI CONSORTIUM INOTIFICATION (RCRA)]

[ MICROSEMI CORP CO I _NEI |

[MICROSEMI CONSORTIUM, C/O FMC CORPORATIO|| AIRS/AFS |

Query executed on: APR-03-2009

Additional information for CERCLIS or TRI sites:

This information resource is not maintained, managed, or owned by the Environmental Protection Agency
(EPA) or the Envirofacts Support Team. Neither the EPA nor the Envirofacts Support Team is responsible for
their content or site operation. The Envirofacts Warehouse provides this reference only as a convenience to
our Internet users.

* National Library of Medicine (NLM) EEEEEEY Toxmap







| Home | Search | Help|

Hvent
Event Id 5159 Alt Event Id 9101461-1 Facility
Logged By On Tuesday, July 15,1997 . - .- 13871 - SILL-TERHAR FORD
Reviewer Jennifer Steffes 1480 W 1ST AVE
BROOMFIELD, CO 80020, BROOMFIELD County

Site Name SILL-TERHAR FORD Category Other

.Locationl 1480 W 1STAVE
" Location2 =~ -

Location3

City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release Historical contamination Status State Lead ' ~ Site Classiftcation 2.7
' MTBE Classification Pathway
~ Eliminated
Cause of Release Projected Closure -
' Date

Sardonyx Primary ID: USBRMSIL
Sardonyx Secondary ID: 002

Activity Classify

Date Activity
4/1/1997 Site Assessment Request
4/1/1997 Suspected Release
7/14/1999 SCR - Site Characterization Report Received
7/14/1999 Confirmed Release Reported
8/29/2000 Need for Confirmation Letter Sent
1/4/2001 Need for Confirmation Letter Sent
5/18/2001 Change Status
6/7/2001 Need for Confirmation Letter Sent
2/12/2002 Meeting Held
2/14/2003 Meeting Held
5/27/2003 CAP Approval Letter Sent
8/22/2003 CAP - Corrective Action Plan Received
8/26/2003 Electronic EFS Received
11/20/2003 Monitoring Report Received
12/3/2003 CAP Approval Letter Sent
4/6/2004 CAP Addendum/Modification Received
4/8/2004 Electronic EFS Received
4/19/2004 Monitoring Report Received
5/10/2004 CAP Modification Approval Letter Sent
5/28/2004 Change Status
6/24/2004 Monitoring Report Received
11/9/2004 Monitoring Report Received
- 1/6/2005 Monitoring Report Received
5752005 Monitoring Report Received
8/30/2005 Monitoring Report Received
12/27/2005 Monitoring Report Received
2/14/2006 Monitoring Report Received
6/29/2006 Monitoring Report Received
8/30/2006 Monitoring Report Received
1/3/2007 Monitoring Report Received
57172007 Monitoring Report Received
11/15/2007 Monitoring Report Received
1/23/2008 Monitoring Report Received
3/25/2008 MTBE MARS Report Received
4/4/2008 Monitering Report Received
6/10/2008 MTBE Pathway Elimination Letter Sent
7/8/2008 Monitoring Report Received
10/16/2008 Monitoring Report Received

12/22/2008 : Monttoring Report Received



2/26/2009 ~ Monitoring Report Received

Log in is for Oil and Public Safety Emponees only. For more detalled mfonnatlon

Log in
o °9 please contact the Public Records Center to schedule a file review at
(303) 318 8521 or (303) 318-8522.

__CDLE | Staty

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc. '

You are currently logged into database COSTIS as Public




| | Home | Se_arch | Help |

Event - .
Event Id 10576 - Facility

Logged By Tina Sandoval On Monday, February 04, 2008 6639 - DIAMOND SHAMROCK 1133

Reviewer Bobby Sonnier © 1004 HWY 287

BROOMFIELD, CO 80020, BROOMFIELD County

Site Name DIAMOND SHAMROCK 1133 Category Retail Gas Station

Locationl 1004 HWY 287

Location2

Location3

City,County,Zip BROOMFIELD, BROOMFIELD, 80020

Source of Release Submersible pump Status Open Site Classification 32
MTBE Classification 2
Cause of Release Install Problem Projected Closure
Date :

Sardonyx Primary ID: USBRMDIA
Sardonyx Secondary ID: (02

Activity Classify

Date _ Activity
1/14/2008 Suspected Release Confirmed
1/30/2008 Suspected Release Reported
| - 1/31/2008 Confirmed Release Reported
i 2/5/2008 - SSF/ SCR Request Letter Sent
5 3/13/2008 SSF - Site Summary Form Received
3/18/2008 Change Status
3/31/2008 Phone Call Made
5/1/2008 SCR Deadline Extension Request Received
5/5/2008 Receive Misc Correspondence
5/6/2008 SCR Deadline Extension Approval Letter Sent
5/16/2008 . Other Notable Letters Received
6/12/2008 Phone Call Received
6/12/2008 Miscellaneous Correspondence Sent
6/23/2008 SCR Deadline Extension Request Received
6/26/2008 SCR Deadline Extension Approval Letter Sent
7/3/2008 SCR Extended Due Date
8/12/2008 Monitoring Report Received
8/18/2008 SCR Deadline Extension Request Received
8/20/2008 Receive Misc Correspondence
8/21/2008 Phone Call Made
8/21/2008 SCR Deadline Extension Approval Letter Sent
9/1/2008 SCR Extended Due Date
9/25/2008 SCR Deadline Extension Request Received
9/29/2008 Monitoring Report Received
9/30/2008 SCR Deadline Extension Approval Letter Sent
10/1/2008 SCR Extended Due Date
11/26/2008 SCR - Site Characterization Report Received
12/1/20608 SCR Extended Due Date
1/15/2009 SCR Final Request Letter Sent
1/15/2009 Phone Call Made
'3/5/2009 Phonre Call Received
3/13/2009 SCR - Site Characterization Report Received

Log in is for Oil and Pubhc Safety Employees only. For more detailed information

Log In
0 °9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318 8522,
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I Home | Search | Help |

Event
Event 1d 508 Alt Event Id 5978-1 Facility
Logged By On Wednesday, August 25, 6263 - JOE L GEBAUER PROPERTY
1993 11515 WADSWORTH BLVD
Reviewer LT - BROOMFIELD, CO 80020, BROOMFIELD County

Category Commercial/Industrial
Site Name JOE L. GEBAUER
Locationl 11515 WADSWORTH BLVD
Location2
Location3
City,County,Zip BROOMFIELD, BOULDER, 80020

Source of Release Status LUST Trust Site Classification 3.1
MTBE Classification
Cause of Release Projected Closure
Date

Sardonyx Primary ID: USBRMGEB
Sardonyx Secondary ID: 001

Activity Classify

Date Activity
8/25/1993 SA/FAN 2 - Further Action Neccessary Priority 2
8/25/1993 Confimmed Release Reported
11/12/1993 Request for CAP
8/22/1997 Further Information Needed
8/22/1997 SA/FAN 2 - Further Action Neccessary Priority 2
8/22/1997 REV Cleanup Completed

4/7/1998 Further Information Needed
12/21/1999 Site Assessment Request
10/3/2001 Change Status
4/24/2003 SSF / SCR Request Letter Sent
8/2/2004  Miscellaneous Correspondence Sent
12/5/2005 Change Status :

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
a °8 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522,

CDLE | Statu

Labor and Employmant

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

. Yonare currently logged info database COSTIS as Public




| Home | Search | Help |

Event
Event Id 1500 Alt Event Id 9000972-1 Facility
Logged By On Tuesday, March 03, 1992 2920 - CSP - BROOMFIELD #49121
; Reviewer Tim Kelley : 7701 W 120TH AVE
BROOMFIELD, CO 80020, BRCOMFIELD County
Site Name BROOMFIELD STATE PATROL (CDOT) Category State/Local Government
Location1 7701 W 120TH .
] Location2
Location3

Clty,County,Z:p BROOMFIELD, BOULDER, 80020

Source of Release Dispensers - other fittings _ Status Open Site Classification 3.1
' o . MTBE Classification
Cause of Release 8 t(osed . Projected Closure
N ’ Date
Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity Classify

Date Activity
1/16/1992 Confirmed Release Reported
3/3/1992 CR/FAN 1 - Further Action Neccessary Priority 1
3/3/1992 LUST Cleanup Initiated: Petroleum
3/10/1992 Tank Release Under Control
5/19/1992 Request for CAP
8/21/1992 Other Notable Reports
9/6/1992 Request for CAP
3/18/1997 Request for CAP
3/3/1998 SA/FAN 1 - Further Action Neccessary Priority 1
3/3/1998 SA/FAN 1 - Further Action Neccessary Priority 1
- 3/10/1998 General Correspondence
4/9/1998 Other Notable Reports
10/28/1998 SA/FAN 2 - Further Action Neccessary Priority 2
11/19/1998 Other Notable Reports
3/24/2000 See Comments
5/15/2001 Change Status
6/24/2002  Miscellaneous Correspondence Sent
6/24/2002 Change Status
7/1/2002 SSF / SCR Request Letter Sent
7/5/2002 Other Notable Reports Received
12/20/2002 * Other Notable Reports Received
3/25/2003 SCR Final Request Letter Sent
6/5/2003 SCR Deadline Extension Request Received
6/6/2003 SCR Deadline Extension Approval Letter Sent
6/27/2003 SCR Deadline Extension Request Received
6/30/2003 SCR. Deadline Extension Approval Letter Sent
8/28/2003 SCR - Site Characterization Addendum Received
12/11/2003 Closure Denial Letter Sent

;MT é?ii'b'os’“‘“'"‘“‘“) Monitoring Report Received

LN p—
Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
0 9 please contact the Public Records Center to schedule a file review at
{303) 318-8521 or (303) 318-8522.

K, SR

CDLE | Stat
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Facility Registry System (FRS)

Recent Additions |

Contact Us |

You are here: EPA

Home

Envirofacts

Search: () All EPA @ This Area I
FRS :

Report

| Facility Name: lCALIFORNIA_DEVICES INC]|
| Location Address: || 500 CENTRAL AVE. |
' | Supplemental Address: |
City Name: LOUISVILLE |
State co

County Name: - BOULDER
ZIP/Postal Code: 800270280 |
EPA Region: T 08 |
Congressional District Number: 02 | |
Legislative District Number: |
HUC Code: 10190005 |
Federal Facility: L |
US Mexico Border Indicator| NO |
Tribal Land : L NO |
Latitude: ] 39.95443 |
Longitude: ' -105.166653 |
[ Method: UNKNOWN |
Reference Point Descriptign: UNKNOWN |
Duns Number: ' |

Registry ID:

|

110002135662 |

[ Map this facility |

Environmental Interests

——

N 3 . Last Supplemental
Information Information Environmental —— Ny
Svstem ““—"”""_S stem ID Interest Type Data Source ||Updated Environmental
=ystem sysiem 10 snlerest lvpe Date Interests:
UNSPECIFIED
RCRAINFO COD980N955603 UNIVERSE RCRAINFO 09/ 12/1985
(INACTIVE)
TRI
TRIS 80027CLFRN500CE TRI REPCRTER REPORTING 07/31/1988
FORM

Facility Mailing Addresses

ml)

13




| Affiliation Type Delivery Point || City Name|[state||Postal Codel|tnformation System|
[FACILITY MAILING ADDRESS|[500 CENTRAL AVE|[LouIsVILLE|[co  |[80027-0280 |[rris |

[REGULATORY CONTACT PO BOX 280 LoutsviLLE|lco  |[soo27 [lrcrAINFO 1
[FACILITY MAILING ADDRESS|[PO BOX 280 LoulsviLLE|jco  J[eooz7 IRCRAINFO |

NAICS Codes

No NAICS Codes returned.

SIC Codes
Data Source”SIC Code"Description ' Hgn_m_amd
[ TRiIs ][ 3674 |[SEMICONDUCTORS AND RELATED DEVICES]| |
~ Contacts
Affiliation Type Full Name |loffice Phone|[Information Systemi|Mailing Address
REGULATORY CONTACT||ROBERT SPRIGGS || 3036733155 |[RCRAINFO | View
PERMITTING CONTACT I |IRCRAINFO I
PUBLIC CONTACT _||HARRY HUNSAKER|[ 3036658111 |[TRIS I

Organizations

No Organizations returned..

‘Alternative Names

No Alternative Names returned.

Query executed on: MAR-30-2009 -

Additional information for CERCLIS or TRI sites:

This information resource is not maintained, managed, or owned by the Environmental Protection Agency (EPA) or the
Envirofacts Support Team. Neither the EPA nor the Envirofacts Support Team is responsible for their content or site
operation. The Envirofacts Warehouse provides this reference only as a convenience to our Internet users.

National Library of Medicine (NLM) E3EEEES ToxmAp

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Monday, March 30th, 2009.
http://oaspub.epa.gov/enviro/fii_query_dt.disp_program_facility?pgm_sys_id_in=C0D980855603&pgam_sys_acrnm_in=RCRAINFO
Print As-Is




Recent Additions | Contact Us | Search: (O AIl EPA @ This Area I ?LGOI
You are here: EPA Home  Envirofacts FRS  Report .

L Facility Name: PORTRAIT INNOVATIONS |
[ Location Address: 406 CENTER DR SUITE H&I |
*|L__Supplemental Address: || - |
[ cityName: || SUPERIOR
1B State I co
| County Name: | _ BOULDER
ZIP/Postal Code: : : 80027
EPA Region: 08
|Congressional District Number:

| Legislative District Number: - '_
| HUC Code:

| Federal Facility:
[ US Mexico Border Indicator: NO

[ Tribal Land : i NO
] Latitude: ] 39.957497

i

| Longitude: | -105.170255
| Method: ADDRESS MATCHING-HOUSE NUMBER

| Reference Point Description:
] Duns Number:

|
| B
Registry ID: l 110022821455

L

[ Map this facility -]

Environmental Interests

. . . pp
Information Information Environmental Data Last Updated Eu ) lemental
PR Environmental
System System ID Interest Type Source Date Interests:
[ RrcraiNFo [ cOR000211789 || CESQG (ACTIVE) J|RCRAINFO|[ 04/01/2008 ||
Facility Mailing Addresses
s . . . PostaliInformation
Arriliation 1ype Delivery Point City Name|
Affiliation Type Delivery Point City Name||State Co ‘le_l Svstem

&REGULATORY CONTACT 38(1)6 AYRSLEY TOWN BLVD STE |\ piotrElinG 28273 _"RCRAINFO

| 11 1 ]




FACILITY MAILING 2016 AYRSLEY TOWN BLVD STE
ADDRESS 200

NAICS Codes

No NAICS Codes returned.

”CHARLO'ITEHNC |28273 “RCRAINFO

SIC Codes
No SIC Codes returned.
S Contacts
IIAffiliation Type . |[FullName |[Office PhonellInformation System||Mailing Address|
[REGULATORY CONTACT][DANNA BROOM][ 7044999300 J[RCRAINFO View I
| PERMITTING CONTACT |} ' I |IRCRAINFO | |
- Organizations

_N'o'_Organizations returned. .

Alternative Names

... No Alternative Names returned.

Query executed on: MAR-30-2009

. EPAHome |Privacy and Security Notice | Contact Us

Last updated on Monday, March 30th, 2009.
http://oaspub.epa.gov/enviro/fil_query_dtl.disp_program_facility?pgm_sys_id_in=COR000211785%&pg
. : Print As-Is

m_sys_acrnm_in=RCRAINFO

This document will now print as it appears on screen when you use the File » Print command.

Use View » Refresh to return to original state.




NATIONAL RESPONSE CENTER 1-800-424-8802

***%* For Public Use **%*

Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 637205

INCIDENT DESCRIPTION

*Report taken at 11:58 on 19-FEB-03

Incident Type: FIXED

Incident Cause: OTHER

Affected Area:

The incident was discovered on 19-FEB-03 at 06:20 local time.

Affected Medium: LAND SOIL

SUSPECTED RESPONSIBLE PARTY

Organization: STORAGE TECH
LOUISVILLE, CO 80028

Type of Organization: PRIVATE ENTERPRISE

INCIDENT LOCATION
10 STORAGE TECH DR. County: BOULDER
City: LOUISVILLE State: CO

RELEASED MATERIAL(S)
CHRIE Code: NCC Qfficial Material Name: NO CHRIS CODE
Also Known As: RAW SEWAGE
Qty Released: 16250 GALLON(S)

DESCRIPTION OF INCIDENT :
CALLER IS REPORTING MATERIAL RELEASED FROM A SEWER DUE TO THIRD PARTY DAMAGE.

INCIDENT DETAILS
Package: N/a -
Building ID:
Type of Fixed Object: OTHER
Power Generating Facility: NO
Generating Capacity:
Tvpe of Fuel:
NPDES :
NEDES Compliance: UNKNOWN

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: NO Hospitalized: Empl /Crew: Passenger:
FATALITIES: NOC Fmpl /Crew: Passenger: Occupant:
EVACUATIONS: NO Who Evacuated: Radius/Area:
Damages: NG

Length of Direction of

Closure Type Description of Closure Closure Closure

Air: N




Road: N

Waterway: N
Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNENOWN

Media Interest: NONE Community Impact due to Material: NO

. REMEDTAL ACTIONS
EXCAVATED SOIL, REPAIRS MADE, ISOLATED AREA, INVESTIGATION UNDERWAY

Release Secured: YES
Release Rate:
Estimated Release Duration:

WEATHER

Weather: CLEAR, 35°2F

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local: EMERGENCY HOTLINE, HEALTY DEPT
State/Local On Scene: '
State Agency Number: 2003-070

NOTIFICATIONS BY NRC
ATSDR CC ATTN: JANET JONES (PRIMARY)}

19-FEB-03 12:02

U.S. EPA VIII (PRIMARY)
19-FEB~-03 12:02

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
19-FEB-03 12:02

CO OIL & GAS CONSERVATION COMM (PRIMARY)
19-FEB-03 12:02

DOI/OEPC DENVER (PRIMARY)
19-FEB-03 12:02

ADDITIONAL INFORMATION
CALLER WILL NOTIFY LOCAL AGENCIES.

**% END INCIDENT REPORT # 637205 ek

Major
Artery:




| Home | Search | Help |

Event
Event Id 6007 Alt Event Id ' Facility-
Logged By On Tuesday, October 21, 1997 6779 - CONOCQPHILLIPS SITE 6529
Reviewer CRAIG _— 191 MCCASLIN BLVD
Workman LOUISVILLE, CO 80027, BOULDER County

Category Retail Gas Station
Site Name CONOCO #6447 -
Locationl 191 MCCASLIN BLVD !
Location2

Location3
City,County,Zip SUPERIOR, BOULDER, 80027

H

Source of Release Status Closed Site Classification
MTBE Classification
Cause of Release Projected Closure
Date

Sardonyx Primary ID:
Sardonyx Secondary ID:

Activity Classify 6!) QVL C(S?w
5

Date Activity
8/21/1997 Confirmed Release Reported
9/1/1997 Site Cleanup Completed
9/1/1997 LUST Cleanup Initiated: Petroleuwmn
9/4/1997 CR - No Further Action Required

Log in is for Oil and Public Safety Employees only. For more detailed information

L in
e °9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

CDLE | Stati

Labor and Empburym_eni

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Pubilic




"‘ | Home | Search | Help |

Event

Event Id 9645

Logged By Tina Sandoval On Thursday, November 04,
2004
Reviewer Tim Kelley

Site Name DIAMOND SHAMROCK 4564
Locationl 90 MCCASLIN BLVD
Location2

Location3
City,County,Zip SUPERIOR, BOULDER, 80027

Source of Release Overfill - device override Status Closed

Cause of Release

Sardonyx Primary ID: USBLDDIA
Sardonyx Secondary ID: 016

Activity Classify

Date

11/3/2004 Suspected Release Reported

11/4/2004 Miscellaneous Correspondence Sent
11/5/2004 Confirmed Release Reported

11/5/2004 SSE / SCR Request Letter Sent
12/15/2004 SSF - Site Summary Form Received
12/21/2004 Change Status

1/31/2005 SCR Deadline Extension Request Received
2/1/2005 SCR Deadline Extension Approval Letter Sent
2/11/2005 SCR - Site Characterization Report Received

5/5/2005 SCR Final Request Letter Sent

5/9/2005 Monitoring Report Received

6/29/2005 SCR Deadline Extension Request Received
6/29/2005 SCR Deadline Extension Approval Letter Sent
7/27/2003 Monitoring Report Received

9/14/2005 SCR Deadline Extension Request Received
9/14/2005 SCR Deadline Extension Approval Letter Sent
16/17/2005 SCR Deadline Extension Request Received
10/17/2005 SCR Deadline Extension Approval Letter Sent
11/1/2005 SCR - Site Characterization Report Received
2/15/2006 Monitoring Report Received

4/13/2006 Closure Request/Monitoring Report Received
6/12/2006 Closure Request Received

9/20/2006 Closure Lefter Sent (GT RBSLs)

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorade Dept. of Laber and Employment
Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

Log In
« 8 please contact the Public Records Center to schedule a file review at

Facility

15410 - DIAMOND SHAMROCK 4564

90 MCCASLIN BLVD

SUPERIOR, CO 80027, BOULDER County
Category Retail Gas Station

Site Classification
MTBE Classification
Projected Closure
Date

RVN2S

Activity '\,\';\_3

Log in is for Oil and Public Safety Employees only. For more detailed information

CDLE | Stats

~ Labor and Employment



|Home | Search | Help |

Event

Event Id 2745 Alt Event Id 2060-1

Logged By
Reviewer Dennis Hotovec

On Tuesday, July 15, 1997

Site Name STORAGE TECHNOLOGY CORP

Locatiorl 2270 S 88TH ST
Location2
L.ocation3

City,County,Zip LOUISVILLE, BOULDER, 80027

Source of Release

Cause of Release

Sardoayx Primary ID: USBLDSTO

Sardonyx Secondary ID: 001

Activity Classify

Status Closed

Date

10/15/1988 Confirmed Release Discovered
10/15/1988 Confirmed Release Reported
10/21/1988 Miscellaneous Correspondence Sent
11/23/1988 Other Notable Letters Received

4/6/1989 Miscelianeous Correspondence Sent
4/11/1989 Other Notable Reports Received
5/10/1989 Miscellaneous Correspondence Sent
5/15/1989 Other Notable Letters Received
5/19/1989 Other Notable Letters Received
5/26/1989 Other Notable Letters Received

6/7/1989 Other Notable Letters Received
1/17/1992 Other Notable Reports Received

6/8/1992 CAP - Corrective Action Plan Received
7/17/1992 CAP Denial Letter Sent

7/28/1992 Other Notable Letters Received
7/29/1992 Miscellaneous Correspondence Sent
8/18/1992 CAP Addendum/Modification Received
7/15/2003 Closure Letter Sent (LT RBSLs)

Facility

4231 - STORAGE TANK TECHNOLOGY INC
1048 INDEPENDENT AVE A-106

GRAND JUNCTION, CO 81505, MESA County
Category Other

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
@ °8 please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303} 318-8522.

Copyright © 2000, Colorade Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc.

. You are currently logged into database COSTIS as Public

CDLE | Statt

i lubor and Employment



" |Home | Search | Help |

Event

Alt Event Id
On Tuesday, February 01, 2000

Event Id 3032
Logged By
Reviewer Scott Winters

Site Name CHARTER BHS CENTENNIAIL PEAKS
Locationl 2255 S §8TH
Location2
Location3
City,County,Zip LOUISVILLE, BOULDER, 80027

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID: USBLDCHA
Sardonyx Secondary ID: 004

Activity Classify

Date
1/25/2000 SA - Site Assessment
3/24/2000 General Correspondence
4/24/2000 CR - No Further Action Required

Facility

5478 - CHARTER BEHAVIORAL HEALTH SYSTEM
22558 §8TH ST

LOUISVILLE, CO 80027, BOULDER. County
Category Other

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
w °s please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

: Copyright © 2000, Colorado Dept. of Labor and Employment
~ Developed by Greenbrier & Russel, Inc.

- You are currently logged into database COSTIS as Public

" CDLE | Stats

Labor ond Empioyment
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| | Home | Search | Help |

Event

Event Id 3510 Alt Event Id 9100740-2 . Facility o _ _
Logged By On Wednesday, July 06, 1994 9096 - 1 D's AUTO CENTER AND GAS

Reviewer Zach Hope 5190 S BOULDER RD

BOULDER, CO 80303, BOULDER County

Site Name TURNPIKE TEXACO Category Retail Gas Station w/ LPG
Locationl 5190 SOUTH BOULDER RD
Location2
Location3

City,County,Zip BOULDER, BOULDER, 80303

Source of Release Tank Status Closed o Site Classification

MTBE Classification
Cause of Release : _ : Projected Closure

Date
Sardonyx Primary ID: USBLDTUR .
Sardonyx Secondary ID: 001

o"

Activity Classify S 0{0'\33 o
Date i Activity o
5/4/1994 Confirmed Release Discovered o :
5/24/1994 Confirmed Release Reported
7/6/1994 Confirmed Release Reported
7/6/1994 Monitoring Report
9/6/1994 SA/FAN 3 - Further Action Neccessary Priority 3
12/1/1994 LUST Cleanup Initiated: Petroleum
12/2/1994 Further Information Needed
9/8/1997 Further Information Needed
9/8/1997 REV Cleanup Completed
3/29/2000 See Comments
5/15/2001 Change Status
5/16/2001 Phone Call Made
: 3/21/2002 SSF / SCR Request Letter Sent
4/16/2002 Receive Misc Correspondence
4/17/2002 Phone Call Made
5/16/2002 SCR Deadline Extension Request Received
5/23/2002 SCR Deadline Extension Approval Letter Sent
7/10/2002 Change Status
7/23/2002 Monitoring Report Received
1/27/2003 SCR - Site Characterization Report Received
5/8/2003 SCR Final Request Letter Sent
7/7/2003 SCR Deadline Extension Request Received
7/21/2003 Monitoring Report Received
9/4/2003 SCR Deadline Extension Request Received
10/2/2003 Monitoring Report Received
- 10/22/2003 _ SCR Deadline Extension Request Received
12/24/2003 - . ° - SCR Deadline Extension Request Received
1/5/2004 ~ SCR Deadline Extension Approval Letter Sent
2/6/2004 Monitoring Report Received
2/19/2004 SCR - Site Characterization Report Received
5/26/2004 CAP Request Letter Sent
5/26/2004 Change Status
6/14/2004 Monitoring Report Received
6/17/2004 Receive Misc Correspondence
7/14/2004 Receive Misc Correspondence
7/15/2004 CAP - Corrective Action Plan Received
7/19/2004 Electronic EFS Received
3/28/2005 CAP EFS in Negotiation
4/4/2005 CAP Denial Letter Sent

4/19/2005 Receive Misc Correspondence




4/22/2005 ~ Phone Call Made

6/14/2005 Meeting Held
6/28/2003 Phone Call Received
7/13/2005 Phone Call Received
8/16/2005 Receive Misc Correspondence
8/16/2005 Phone Call Made
8/19/2005 Monitoring Report Received
9/1/2005 CAP HFS Effective Date
9/2/2005 CAP Deadline Extension Request Received
9/6/2005 CAP Deadline Extension Approval Letter Sent
11/2/2005 Phone Call Received
11/25/2005 Electronic EFS Received
12/1/2005 CAP - Corrective Action Plan Received
1/4/2006 CAP Approval Letter Sent
2/23/2006 " Monitoring Report Received
6/20/2006 : Monitoring Report Received
7/1/2006 CAP Addendum/Modification Received
9/14/2006 Monitoring Report Received
10/26/2006 CAP EFS in Negotiation
11/8/2006 Change Status
11/8/2006 "~ CAP Approval Letter Sent
1/3/2007 - Monitoring Report Received
3/26/2007 : Monitoring Report Received
4/11/2007 MTBE Pathway Elimination Letter Sent
7/13/2007 Monitoring Report Received
10/17/2007 Monitoring Report Received
11/27/2007 Monitoring Report Received
2/28/2008 Phone Call Received
5/1/2008 Closure Request/Monitoring Report Received
8/5/2008 Phone Calt Made
8/6/2008 Phone Call Received
8/6/2008 Phone Call Made
8/6/2008 Phone Call Received
8/12/2008 Miscellaneous Correspondence Sent
8/12/2008 Closure Denial Letter Sent
9/22/2008 Phone Call Received
9/22/2008 Phone Call Made
10/15/2008 No Further Action Request Report Received
12/8/2008 Closure Letter Sent (GT RBSLs)
12/15/2008 Receive Misc Correspondence
12/30/2008 Other Notable Reports Received

Log in is for Oil and Public Safety Employees only. For more detailed information

Log in
@ o9 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

1 @ ]
i CDLE | Stat

Laber and Employment

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel. Inc.

You are currently logged into database COSTIS as Public



| Home | Search | Help|

Event

Event Id 9444

Logged By Tina Sandoval On Monday, March 01, 2004
Reviewer Dawn Anderson

Site Name PDQ 8001
Locationl 5200 MANHATTAN CIR
Location2

Location3
City,County,Zip BOULDER, BOULDER, 80303

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID; USBLDPDQ
Sardonyx Secondary ID: 002

Activity Classify

Date
2/23/2004 Confirmed Release Reported
4/8/2004 SSF - Site Summary Form Received
5/28/2004 SCR - Site Characterization Report Received
11/2/2004 Change Status
11/5/2004 Closure Letter Sent - No Release

Activity

Facility

8803 - PDQ 8001
5200 MANHATTAN CIR

BOULDER, CO 80303, BOULDER County

Category Retail Gas Station

Site Classification
MTBE Classification
Projected Closure
Date

o
&(5\5

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
a o9 please contact the Public Records Center to schedule a file review at

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment
Developed by Greenbrier & Russel, Inc.

| Youare currently logged into database COSTIS as Public
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Facility
3295 - EXXON RAS 6 2509

. 5324 S BOULDER RD
i BOULDER, CO 80303
BOULDER County

Facility Telephone:*

Contact Name:*

AST/UST Inspector: Ralph Acierno OPS-3
W&M/LPG Inspector; Chris Dufex OPS-1

*To be added using Contacts tab. For further information see Help Menu

Log n
: 0 please contact the Public Records Center to schedule a file review at
’ (303)318-8521 or (303) 318-8522,

Copyright © 2000, Colorado Dept. of Labor and Employment
: Developed by Greenbrier & Russel, Inc,

You are currently logged into database COSTIS as Public

Category: Retail Gas Station
Type: Retail

Total Tanks: 4

Active Tanks: 0
Facility Creation Date:
Street Map:
Topo Map:
Sardonyx Primary ID :
Sardonyx Secondary ID :
Delivery Prohibition Date :

Processes Tanks
: . Delivery
Tank Tag Status Type I;:)stali Registration Prohib Product Capacity
afe Date Date
3295-1 Permanently Closed UST 5/1/1969 Gasoline 6000
3295-2 Permanently Closed UST 5/1/1969 Gasoeline 6000
3295-3 Permanently Closed UST 5/1/1969 Gasoline 4000
3295-4 Permanently Closed UST 5/1/1981 6 - Used Oil 1000
(Waste Qil)

Log in is for Oil and Public Safety Employees only. For more detailed information

Date

Closed

8/5/1987
8/5/1987
8/5/1987
8/5/1987

Closure
Method

Removed
Removed
Removed
Removed

CDLE | Stat

lnbor.and Employment
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Event

Event Id 3517 Alt Event Id 9100740-1

Logged By On Friday, May 20, 1994
Reviewer NA

Site Name TURNPIKE TEXACO
Locationl 5190 S BOULDER RD
Location2
Location3

City,County,Zip BOULDER, BOULDER, 80303

Source of Release Status Closed

Cause of Release

Sardonyx Primary ID: USBLDTUR
Sardonyx Secondary ID: 00}

Activity Classify

Date

5/31/1994 Confirmed Release Reported
5/31/1994 Monitoring Report

5/31/1994 LUST Cleanup Initiated: Petroleum
6/30/1994 CR - No Further Action Required
9/6/1994 SA - Site Assessment

12/1/1994 Tank Release Under Control
12/1/1994 Site Cleanup Completed
12/2/1994 Send Closure Letter - NFA
6/30/1993 REV Cleanup Completed
8/1/1996 See Comments

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment
. Developed by Greenbrier & Russel, Inc.

T You are currently logged into database COSTIS as Public

Log in
0 o9 please contact the Public Records Center to schedule a file review at

Facility

9096 - 1 D's AUTO CENTER AND GAS
5190 S BOULDER RD

BOULDER, CO 80303, BOULDER County
Category Retail Gas Station w/ LPG

Site Classification
MTBE Classification
Projected Closure
Date

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

CDLE | Stat

Labor and Employment
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Event )
Event 1d 5244 Alt Event Id 616-1 Facility
Logged By On Friday, March 28, 1997 10353 - DEEP FARM PIT
Reviewer Steve Noel 4800 TABLE MESA DR
BOULDER, CO 80303, BOULDER County
Site Name DEEP FARM PIT Category Commercial/Industrial
Locationl 4800 TARLE MESA DR
Location2
Location3

City,County,Zip BOULDER, BOULDER, 80303

Source of Release Status Closed

Site Classification
MTBE Ciassification
Cause of Reicase Projected Closure
Date
Sardonyx Primary ID:
Sardonyx Secondary ID:
Activity Classify
Date Activity e\ 9 A
3/28/1997 Confirmed Release Reparted c\ofyg_
5/23/1997 SA/FAN 1 - Further Action Necogssary Priority 1
8/12/1997 SA/FAN 2 - Further Astion Neceessary Priority 2
8/12/1997 CAP - Corrective Action Plan
9/4/1997 Send Closure Letter - NFA
9/4/1957 CR - No Further Action Required
9/4/1897 Tank Release Under Control
5/4/1997 _ Site Investigation Completed
0/4/1997 LUST Cleanup Initiated: Petroleum
9/4/1997 Site Cleanup Completed

 Log in is for Oil and Public Safety Employees only. For more detailed information

Legin please contact the Public Records Center to schedule a file roview at
(303) 3188521 or (303) 318-8522,

S lenls 5 i Alitsion - LHE
Tabot GRA Smpoyment o ‘ '

Copyright © 2000, Colorade Dept. of Labor and Employimient
Developed by Greenbrier & Russel, Inc,

You are cuirently logged into database COSTIS as Public
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Event

Event Id 3848
Logged By
Reviewer NA

Alt Event Id 6026-1
On Friday, January 19, 1990

Site Name AMOCO OIL #2111
Locationl 4742 TABLE MESA DR

Location2
Location3

City,County,Zip BOULDER, BOULDER, 80302

Source of Release

Cause of Release

Status Closed

Sardonyx Primary ID: USBLDAMO
Sardonyx Secondary ID: 015

Activity Classify

Date
1/19/1990
7/27/1990
7/27/1990

9/9/1992
8/29/1994
11/3/1994
11/4/1994
2/5/1995
2/14/1995
2/15/1995
7/3/1995
8/9/1995
11/3/1995
1/26/1996
4/22/1996
5/31/1996
11/1/1996
12/16/1996
12/16/1996
12/31/1996
1/13/1997

Confirmed Release Reported

Site Investigation Completed
SA/FAN 1 - Further Action Neccessary Priority 1
Request for CAP

CAP - Corrective Action Plan
Tank Release Under Control
CAP Conditional Approval Letter Sent
General Correspondence
Monitoring Report

Other Notable Reports
Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

Fund Application Received
Monitoring Report

Send Closure Letter - NFA

REV Cleanup Completed

Site Cleanup Completed

CR - No Further Action Required

‘ Log in
-? ﬁ please contact the Public Records Center to schedule a file review at
{303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

i Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIS as Public

Facility

6438 - K & G STORE #3536

4742 TABLE MESA DR

BOULDER, CO 80302, BOULDER County
Category Retail Gas Station

Site Classification
MTBE Classification
Projected Closure
Date

O gen
WSS

Activity

Log in is for Oil and Public Safety Employees only. For more detailed information

COLE
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Event

Event Id 6759
Logged By

Location2
Location3

Cause of Release

| Activity  Classify

Date
7/30/1998
8/4/1998
8/14/1998
8/21/1998
9/9/1998
9/30/1998
10/20/1998
11/6/1998
4/9/1999
8/9/1999
9/14/1999
10/20/1999
1/11/2000
3/20/2000
4/11/2000
7/28/2000
8/10/2000
8/25/2000

-9/8/2000
/2272000
10/2/2000
3/13/2001
5/23/2001
7/9/2001
7/10/2001
7/12/2001
8/27/2001
8/30/2001
1/16/2002
3/19/2002
5/16/2002
7/22/2002
8/20/2002
9/24/2002
10/23/2002
10/23/2002
11/25/2002
2/12/2003
6/2/2003
9/4/2003

Reviewer Zach Hope

Site Name TEXACO
Locationl 2877 BASELINE RD

Source of Release Line - rupture on tank 542-3

Alt Event Id

On Monday, August 03, 1998

City,County,Zip BOULDER, BOULDER, 80303

Sardonyx Primary ID: USBLDTEX
Sardonyx Secondary ID: 002

Confirmed Release Reported
Site Assessment Request
Other Notable Reports

Other Notable Reports

Other Notable Reports

See Comments

See Comments

SA/FAN 1 - Further Action Neccessary Priority 1
SA/FAN 1 - Further Action Neccessary Priority 1

Request for CAP
Monitoring Report

CAP - Corrective Action Plan

Monitoring Report
Monitoring Report
Monitoring Report
Monitoring Report
CAP Denial Letter Sent
Other Notable Reports
Request for Extension
Mcnitoring Report

CAP Deadline Extension Request Received

Moenitoring Report Received
Monitoring Report Received
Change Status

CAP Deadline Extension Request Received
CAP Deadline Exiension Request Received

Monitoring Report Received

CAP - Corrective Action Plan Received

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Change Status

Monitoring Report Received
Monitoring Report Received

CAP Conditional Approval Letter Sent

Change Status

Other Notable Reports Received

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received

Status Open

Facility .

542 - CIRCLE K STORE #2709861

2877 BASELINERD

BOULDER, CO 80303, BOULDER County
Category Retail Gas Station

Site Classification 2.7
- MTBE Classification
. - Projected Closure
. Date

Activity



11/13/2003
1/22/2004
5/3/2004
8/6/2004
11/8/2004
2/4/2005
5/4/2005
7/25/2005

12/27/2005
4/4/2006
6/22/2006
8/28/2006
9/21/2006

10/16/2006

10/25/2006
1/19/2007
4/11/2007
9/24/2007

12/19/2007
4/9/2008
6/25/2008

10/10/2008

10/10/2008

12/15/2008

12/19/2008

12/19/2008

12/29/2008
1/7/2009
1/8/2009
1/15/2009
1/27/2009
1/25/2009
3/5/2009
3/26/2009

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received

Phone Call Made

Phone Call Received

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received

CAP Addendum/Modification Received
Electronic EFS Received

Miscellaneous Correspondence Sent
CAP EFS in Negotiation

Electronic EFS Received

Monitoring Report Received
Miscellaneous Correspondence Sent
MTRBE Pathway Elimination Denial Letter Sent
Miscellaneous Correspondence Received
Miscellaneous Correspondence Sent
Monitoring Report Received

CAP Addendum/Modification Received

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
@ o8 please contact the Public Records Center to schedule a file review at
(303) 318-8521 or (303) 318-8522.

CDLE | Stat

. .I..t_l-b;l-’.t.llld Eﬁﬁ:hymenl .

Copyright © 2000, Colorado Dept. of Laber and Employment

Developed by Greenbrier & Russel., Inc.

You are currently logged into database COSTIS as Public




1 | Home | Search | Help |

Event

Event Id 7258
Logged By

Alt Event Id
On Tuesday, February 16, 1999

Reviewer Dawn Anderson

Site Name AMOCO 8617
Locationl 2990 BASELINE

Loeation2
Location3

City,County,Zip BOULDER, BOULDER, 30301

Source of Release

Cause of Release

Status Open

Sardonyx Primary ID: USBLDAMO
Sardonyx Secondary ID: 007

Activity - Classity

Date
8/31/1990
8/31/1990
9/19/19%0

0/8/1992
10/6/1992
11/4/1992
6/24/1993
1/20/1994
4/6/1994
4/20/1994
5/10/1994
6/9/1994
6/16/1994
6/21/1994
7/14/1994
7/18/1994

10/28/1994

1/11/1995
4/27/1995

8/1/1995
11/3/1995
1/18/1996
4/19/1996
6/26/1996
7/15/1996
7/19/1996
7/15/1997
12/22/1997

1/4/1999

8/4/1999
1/21/2000
2/7/2001
5/16/2001

2/8/2002
10/3/2002
11/21/2002
11/22/2002
12/20/2002
12/20/2002
1/31/2003

Confirmed Release Reported

Fund Application Received

Site Assessment Request

SA/FAN 1 - Further Action Neccessary Priority 1
LUST Cleanup Initiated: Petroleum

Request for CAP

General Correspondence

SA/FAN 1 - Further Action Neccessary Priority 1
Request for CAP

CAP - Corrective Action Plan

CAP Denial Letter Sent

CAP - Corrective Action Plan

Tank Release Under Control

CAP Conditional Approval Letter Sent

CAP - Corrective Action Plan

CAP Approval Letter Sent

Menitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report

CAP - Corrective Action Plan

CAP Conditional Approval Letter Sent
Monitoring Report

Monitoring Report

Other Notable Reports

Monitoring Report

Monitoring Report

Monitoring Report

Monitoring Report Received

Change Status

Monitoring Report Received

CAP Modification Request Sent

CAP Deadline Extension Request Received
CAP Deadline Extension Approval Letter Sent
CAP Deadline Extension Request Received
CAP Deadline Extension Approval Letter Sent
Other Notable Reports Received

Facility

10497 - K & G STORE #520

2990 BASELINE RD

BOULDER, CO 80302, BOULDER County
Category Retail Gas Station

Site Classification 32
MTBE Classification 2
Projected Closure

Date

Activity



2/6/2003
3/10/2003
4/7/2003
4/9/2003
6/12/2003
7/22/2003
1/14/2004
2/5/2004
2/12/2004
3/11/2004
4/27/2004
5/3/2004
6/1/2004
7/15/2004
9/9/2004
11/4/2004
12/8/2004
1/20/2005
3/30/2005
10/7/2005
11/17/20035
12/22/2005
3/20/2006
4/28/2006
0/6/2006
10/20/2006
11/9/2006
11/9/2006
11/14/2006
3/14/2007
4/8/2007
5/8/2007
5/14/2007
5/23/2007
7/19/2007
10/22/2007
11/7/2007
12/4/2007
1/15/2008
1/17/2008
6/28/2008
7/2/2008
7/3/2008
9/36/2008
11/10/2008
11/12/2008
2/20/2009
3/10/2009

Log in is for Oil and Public Safety Employees only. For more detailed information

Log In
a o9 please contact the Public Records Center to schedule a file review at

CAP Modification Request Sent

CAP EFS Effective Date

Electronic EFS Received

CAP Addendum/Modification Received
CAP Denial Letter Sent

Monitoring Report Received

Phone Call Received

CAP Addendum/Modification Received
Flectronic EFS Received

Other Notable Reports Received
Monitoring Report Received

CAP Modification Approval Letter Sent
Change Status

Monitoring Report Received

Other Notable Reports Received
Monitoring Report Received

Site Visit - RSIP

Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received
Monitoring Report Received

MTBE MARS Report Requested
Monitoring Report Received

CAP Modification Request Sent
Monitoring Report Received

CAP Deadline Extension Request Received
CAP Deadline Extension Approval Letter Sent
Monitoring Report Received
Monitoring Report Received

CAP Deadline Extension Request Received
Monitoring Report Received

CAP Addendum/Medification Received
Electronic EFS Received

CAP EFS in Negotiation

Electronic EFS Received

Monitoring Report Received

Signed EFS Received

CAP Modification Approval Letter Sent
CAP Implementation Report Received
Electronic EFS Received

Monitoring Report Received

CAP Addendum/Modification Received
CAP EFS in Negotiation

CAP Denial Letter Sent

Monitoring Report Received
Monitoring Report Received

Phone Call Received

(303) 318-8521 or (303) 318-8522.

Copyright © 2000, Colorado Dept. of Labor and Employment

Developed by Greenbrier & Russel, Inc.

You are currently logged into database COSTIES as Public
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NATIONAL RESPONSE CENTER 1-800-424-8802
k%% For Public Use #%*
Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 462736

INCIDENT DESCRIPTION

*Report taken at 11:59 on 05-NOV-98

Incident Type: FIXED

Incident Cause: OTHER

Affected Area:

The incident occurred on 04-NOV-98 at 15:00 local time.

Affected Medium: WATER BEAR CANYON CREEK

SUSPECTED RESPONSIBLE PARTY

Organization: UNIV. OF COLORADO
BOULDER, CO 80309

Tvpe of Qrganization: PRIVATE ENTERPRISE

INCIDENT LOCATION
37TH AND BASE LINE County: BOULDER
City: BOULDER State: CO

RELEASED MATERIAL(S)
CHRIS Code: CSS Official Material Name: CAUSTIC SODA SOLUTION
‘Also Known As:
Oty Released: 55 GALLON(S) Qty in Water: 55 GALLON({S)

CHRIS Code: HCL Qfficial Material Name: HYDROCHLORIC ACID
Also Known As:

Qty Released: 2000 POUND(S) Qty in Water: 2000 POUND(S)

DESCRIPTION OF INCIDENT
BOTLER THAT WAS BEING ACID CLEANED WHICH WAS DUMPED DOWN SEWER

INCIDENT DETAILS

Package: N/A

Building ID:

Tvpe of Fixed Object: UNKNOWN
Power Generating Facility: UNKENOWN
Generating Capacity:

Type of Fuel:

NPDES :

NPDES Compliance: UNKNOWN

DAMAGES
Fire Involved: NO Fire Extinguished: UNKNOWN
INJURIES: UNEKN Hospitalized: Empl /Crew:
FATALITIES: UNKN Empl/Crew: Passenger:
EVACUATIONS: NO Who Evacuated: Radius/Area:

Damages: NO.

Length of

Passenger:
Occupant:

Direction of




Closure Type Descripticon of Closure Closure Closure
Air: N

Road: N . Major

' " Arxtery:
Waterway: N
Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNEKNOWN
Media Interest: Community Impact due to Material: NO

REMEDTAL ACTIONS

FIRE DEPT BOOMED CREEK AND DIKE INFLOW WHICH WERE NOT EFFECTIVE /STOPPED PUMPING /
SPILL SECURED / THERE WAS A FISH KILL

Release Secured: UNKNOWN

Release Rate:

Estimated Release Duration:

WEATHER

ADDITIONAL AGENCIES NOTIFIED

Federal:

State/Local:
State/Local On Scene:

State Agency Number:

NOTIFICATIONS BY NRC
ATSDR CO ATTN:JANET JONES (PRIMARY)
05-NOV-98 00:00 '

U.S. EPA VIII (PRIMARY)
05-NOV-98 12:08

NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)
05-NOV-98 00:00

CO OIL & GAS CONSERVATION COMM (PRIMARY)
05-NOV-88 00:00

DOI/OEPC DENVER (PRIMARY)
05-NOV-98 00:00

ADDITIONAL INFORMATION

*** END INCIDENT REPORT # 462736 bl



NATIONAL RESPONSE CENTER 1-800-424-8802
*%% Tor Public Use **¥
Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 448301

INCIDENT DESCRIPTICN

*Report taken at 16:20 on 30-JUL-58

Incident Type: FIXED

Incident Cause: EQUIPMENT FAILURE

Affected Area:

The incident was discovered on 30-JUL-98 at 13:00 local time.
Affected Medium: WATER STORM DRAIN > UNKNOWN CREEK

SUSPECTED RESPONSIBLE PARTY

Organization: TEXACO
DENVER, CO 80237

Type of Qrganization: PRIVATE ENTERPRISE

INCIDENT LOCATION

2877 BASELINE County: BOULDER
City: BOULDER State: €O Zip: 80303

RELEASED MATERIAL(S)

CHRIS Code: GAS Official Material Name: GASOLINE: AUTOMOTIVE (UNLEADED)

Also Known As:
Qty Released: 50 GALLON(S) Qty in Water: 0 UNKNOWN AMOUNT

DESCRIPTION OF INCIDENT

UNDERGROUND PIPING SYSTEM AT FUELING STATION / MATERIAL IS SPILLING DUETQ A LEARY

FITTING

INCIDENT DETAILS

Package: N/A

Building ID:

Tvpe of Fixed Object: UNKNOWN
Power Generating Facility: UNKNOWN
Generating Capacity:

Type of Fuel:

NPDES:

NPDES Compliance: UNKNOWN

DAMAGES

Fire Inveolved: NO Fire Extinguished:
INJURIES: UNKN Hospitalized: Empl/Crew:
FATALITIES: UNKN Empl/Crew: Passenger:
EVACUATIONS: NO Who Evacuated: Radius/Area:
Damages: NO

Length of
Closure Tyvpe Degcription of Closure Closure

Passenger:

Occupant:

Direction of
Closure

Air: N



Road: N

Waterway:
Track:

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN

Media Interest: Community Impact due to Material:

REMEDIAL ACTIONS

Release Secured:
Release Rate:
Estimated Release Duration:

WEATHER

ADDITIONAL AGENCIES NOTIFIED

Federal:
State/Local:

State/Local On Scene:
State Agency Number:

NOTIFICATIONS BY NRC
ATSDR CO ATTN:JANET JONES (PRIMARY) '

30-JUL-98  00:00
U.S. EPA VIII {PRIMARY)

30-JUL-98  16:27 _
NOAA 1ST CLASS BB RPTS FOR CO (PRIMARY)

30-JUL-98 00:00 '
CO OTL & GAS CONSERVATION COMM (PRIMARY)

30-JUL-98  00:00 ' '
DOI/OEPC DENVER (PRIMARY)

30-JUL-98  00:00

ADDITIONAL INFORMATION

*#%*% END INCIDENT REPORT # 448301

* k&

Major
‘Artery:



NATIONAL RESPONSE CENTER 1-800-424-8802
#%% For Public Use **%*
Information released to a third party shall comply with any

applicable federal and/or state Freedom of Information and Privacy Laws

Incident Report # 56685

INCIDENT DESCRIFPTION

*Report taken at 16:27 on 26~-JAN-91
Incident Type: FIXED

Incident Cause: OPERATOR ERROR
Affected Area:
The incident occurred on 26-JAN-91 at 11:20 local time.

Affected Medium: LAND CONCRETE

SUSPECTED RESPONSIBLE PARTY

Organization: US DEP OF COMMERCE
BOULDER, CO 80303

Type of Organization: FEDERAL GOVERNMENT

INCIDENT LOCATION

325 BROADWAY County: BOULDER
City: BOULDER State: CO Zip: 80303

RELEASED MATERIAL(S)
CHERIS Code: OTF Official Material Name: OIL, MISC: TRANSFORMER
Also Rnown As:

Qty Released: 8 GALLON(S) Qty in Water: 0 NONE

DESCRIPTION OF INCIDENT
TRANSFORMER / TRANSFORMER WAS BEING REMOVED AND CRACKED A VALVE.

INCIDENT DETATLS

Package: N/A

Building ID:

Type of Fixed Object: UNKNOWN
Power Generating Facility: UNKNOWN
Generating Capacity:

Tvpe of Fuel:

NPDES:

NPDES Compliance: UNKNOWN

DAMAGES

Fire Involved: NO Fire Extinguished: UNENOWN
INJURIES: UNEN Hospitalized: Empl /Crew:
FATALITIES: UNKN Empl/Crew: Passenger:
EVACUATIONS: NO Who Evacuated: Radius/Area:
Damages: NO

Length of
Closure Type Description of Closure Clogure

Passenger:
Occupant:

Pirection of
Closure

Air: N




Road: N Major

Artery: N

Waterway: N
Track: N

Passengers Transferred: UNKNOWN
Environmental Impact: UNKNOWN

Media Interest: Community Impact due to Material: NO

REMEDIAL ACTIONS
FLOOR DRY AND SORBENT PADS WERE USED BY CONTRACTORS.
Release Secured: UNKNOWN
Release Rate:
Estimated Release Duration:

WEATHER

ADDITIONAL AGENCIES NOTIFIED

Federal:
State/Local:

State/Local On Scene:
State Agency Number:

NOTIFICATIONS BY NRC

AGCY TOXIC SUBST (PRIMARY)
. 26-JAN-91 16:36

U.S. EPA VIII (PRIMARY)
26-JAN-91 16:36

ADDITIONAL INFORMATION
RELEASE HAS BEEN SECURED. :

**% END INCIDENT REPORT # 56685 kR




>WILLIAM'S VILLAGE CLEANERS

_ Cleanup Home
- Basic Information
Where You Live

Newsroom

More Details

Laws/Statutes l L LIAM'S VI L LAG E
I Regulations/Standards C LEAN E Rs
ID: (COD039508510)

Facility Information (Facility Reqistry System)
Waste Process Report

Eacility Classification Report
Engineering/Institutional Controls and Industry
Classification Report

! Policy/Guidance

Enforcement his profile is meant to provide you with basic information on Qther Name_s for th!s Sitg
EPA Programs EPA’s cleanup progress at this RCRA facility. Please use the

Involved with

Cleanup

GrantsI'Funding

Science/Technology

Partners

What You Can Do

Cleanup Progress Summary

Environmental impact Summary

Hazardous wastes are managed

If this corrective action site has

Publications under the Resource Conservation been examined to determine if
: and Recovery Act. When these human exposures to contaminants
Related Links wastes contamnate the land, water are under control and the migration
or air they must undergo "carrective of contaminated water is under
Calendars action.” control, that information is provided
Glossary o ' '
RCRA Corrective -~

Action Home

Get an interactive map

Background i
Information EPA Regicn 8 implements and
enforces the RCRA corrective
RCRAInfo action program for Colorado,
RCRA Montana, North Dakota, South
Where You Live Dakota, Utah, Wyoming and Tribal At this site, there is currently
Nations A final remedy has been selected insufficient information to
Cleanups In for this corrective action site. determine whether human
My Community Site Address: exposures are under control.

WILLIAM'S VILLAGE CLEANERS

679 30TH ST
BOULDER, CO 80302
County: BOULDER

US Congressional District: 2
Population within 1 mile:

For further information on this
corrective action site, contact region
or state in which this sile is located.

View detailed list of cleanup
activities >> '

View information on what controls

are in place to protect human health
and the environment >>

At this site, there is currently
insufficient information to
determine whether migration of
contaminated groundwater is
under control.

—
Contamination & Exposure




J contaminated groundwater from the site, and protect the effectiveness of cleanup remedies. Engineering Controls are

Contamination:

Infarmation on the contamination and the reason for the cleanup may be available. For further information, see the
contact information provided above, or try the Statement of Basis Web Page to see if a Statement of Basis for the
corrective action remedy has been provided fo EPA.

Exposure:
Is human exposure to contamination at this site under control? UNKNOWN
Is the migration of contaminated groundwater at this site under control? UNKNOWN

The Solution: Cleanup Process & Progress

Cleanup Activities at this site:

1. Site Assessed . : ‘ UNKNOWN

2. Site |dentified for Corrective Action : ~ U YES

3. Solution for Cleanup Selected (Final Remedy Decision) 10-MAR-08

4. Solution for Cleanup is implemented _ L UNKNOWN

5. Cleanup Complete ' ' _ ' o _UN_KNOWN -

Controls in Place at this site:
There are many types of controls that can be put in place to controt human exposure fo contaminants and the migration of

mechanisms that work by physically controlling access to the land, the flow of water, etc. Examples include fences,
cement caps over contaminated areas, and pumps. Institutional Controls (ICs} (also known as land use controls

(LUCS) EXITARUIREmER]  aetivity and use limitations {AULs), and environmental use restrictions (EURs) are

§ administrative and/or legal controls, that work by limiting land or resource use. Private or (proprietary} examples include
deed restrictions, covenants and easements. Public (or govenrmental) examples include zoning ordinances and
groundwater permitting programs.

Are cbnlrols in pface at this site? Type of Confrol(s):

Institutional.Controls: NO
Engineering Controls: NO

Government Performance & Resulis Act gGRPA! Milestones

EPA is required to report on the following milestones under the Government Perfon'nance & Resuits Act. More
Informatlon

Milestone Status

Human Expasure Under Control UNKNOWN

Contaminated Groundwater migration Under Control UNKNOWN

A
Window to My Environment | EnviroMapper | EnviroFacts | Cleanups in My Community
RCRA Coirective Action Home | OSWER Home | Customer Satisfaction Survey

Data Refreshed on Friday , November 14, 2008

This page was generated on Meonday, March 30, 2_009

View the graphical version of this page at: http./iaspub.epa.govl/enviroftcra_profile.getmain?p_handler_id=C0D039508510




You are here: EPA Home

Detailed Facility Report |

Compliance and Enforcement

ECHO

Search Data

For Public Release - Unrestricted Dissemination Report Generated on 03/30/2009
US Environmental Protection Agency - Office of Enforcement and Compliance Assurance

Facility Permits and ldentifiers

Enforcement & Compliance History Online (ECHO)

Search Results

Statute | System Source ID Facility Name ~| . Street Address ] City State Zip
: FRS 110001434138 WILLIAMS VILLAGE CLNRS |679 30TH STREET [BOULDER CO 80303
CAA AFS 0801300270 WILLIAMS VILLAGE CLNRS |s79 30TH ST JBOULDER CO 80303
RCRA RCR COD039508510 WILLIAM'S VILLAGE CLEANERS |679 30TH ST IBOULDER CO 80302
Facility Characteristics
. Permit Expiration Latitude/ Indian Sic NAICS
lStatute Source ID Universe Status Argas - Date Longitude Country? Codes Codes
LRT:
110001434136 39.999644 , No
-105.253001
Minor (Not - IMACT (SECTION 63
CAA  |0801300270 Fed.Rep.) Operating NESHAPS), SIP lNA 7216 812320
|rera conosgsossml f‘gﬁ)"e |N0

If the CWA permit is past its expiration date,
is normatly administratively extended and kept in effect until the new permit is issued.

For the RCRA program, activities that contribute to an overall facility status of Active are displayed in parentheses using the acronym HPACS, where H indicates
handler activities, P - permitting, A - corrective acfion, C - converter, and S - state-specific. More information is available in the Data Dictionary_.

Inspection and Enforcement Summary Data

‘this normally means that the permitting authority has not yet issued a new permit. In these sntuat:uns the explred permat :

Entries in ftalics are not considered inspections in official counts.

Compliance Summary Data
Information on the nature of alleged violations is available on the FAQ page.

I Statute | Source ID Insp. Last 05Yrs Date of Last Inspection . Formal Enf Act Last 05 Yrs Penalties Last 05 Yrs
jcaa Josa13o0270 i 12i27/2006 0 ' $00
|rcra  JCOD039508510 4 : 06/04/2001 0 500
Compliance Monitoring History (05 years )
Statute | Source ID Inspection Type Lead Agency Date Finding
CAA 0801300270 STATE CONDUGCTED FCE/ON-SITE State 1212772006 .
JRCRA |COD039508510 |FOCUSED COMPLIANCE INSPECTION State 11/28/2006 |No Violations Or Compliance Issues Were Found
RCRA |COD039508510 JFOCUSED COMPLIANCE INSPECTION State 04/23/2007 [INe Violations Or Compliance Issues Were Found
RCRA |CODE39508510 JFOCUSED COMPLIANCE INSPECTION State Josi12i2008 {No Violations Or Compliance Issues Were Found
RCRA |COD035508510 |FOCUSED COMPLIANCE INSPECTION State |05!2312008 No Violations Or Compliance lssues Were Found

Three Year Compliance Status by Quarter

Statute Source ID Current SNC/HPV? Description | - "Current As Of Qtrs in NC {of 12)
CAA 0801300270 N/A ) |03/14/2009 C
|IRCRA COD039508510 No Josioai2009 0

Violations shown in a given quarter do not necessarily span the entire 3 months. Information on the nature of alleged viotations is available on the FAQ: page, and




information on the duration of nan-compliance is available at the end of this report.

AIR Compliance Status

Statute:Source ID Qrrt  latrz QTR ATRE - Hargs  forre  |QTR7 |ATRE - lorpg  Jarreo [OTRIT |UTR12
CAA: 0801300270 Apr-Jun06 |Jul-Sep0s Dec;OS Mar}.)? Apr-Jun07 |Jul-Sep07 De<;07 Marb& Apr-Jun08 JJul-Sepd8 Dec08 Mar09
[APv fistory | | | |
JProgram/Pollutant in Current Vielation
IMACT (SECTION B3 [ ]C- C- C- C- C- C- C- C- C- C- C- C-
NESHAPS) PROCED |PROCED |PROCED |PROCED |PROCED JPROCED JFROCED JPROCED [PROCED |PROCED JPROCED §PROCED
SIP C- - - - - C- C- C- C- C- C- C-

PROCED |PROCED [PROCED |PRCCED |PROCED JPROCED |PROCED |PROCED iPROCED PROCED JPROCED |PROCED

High Priority Violator (HPV) History section: "Unaddr" means the facility has not yet been addressed with a formal enforcement action. "Addrs"means the facility has
been addressed with a formal enforcement acfion, but its violations have not been resolved. Lead Agency designated can be US EPA, State, Both, or No Lead
Determined. If HPV History is blank, then the facility was not a High Priority Violator. C=Compliance; V=Violation; $S=Compliance Schedule.

RCRA Compliance Status

Statute:Source ID QTR1  |QTR2 JQTR3 JQTR4 JQTR5S |QTR6é [QTR7 atRs [atRe  [atrio latri1  JaTRi2
RCRA: Apr- Jul- Oct- Jan- Apr- Jul- Oct- Jan- Apr- Jul- Oct- Jan-
CODO39508510 Jun06 Sepl6 Dec06 MarQ7 JunQ7 Sep07 Dec07 Mar08 Jun08 Sep08 Dec08 Mar09
Facility Level Status Compl Compl Compl |Compl Compl Comp! |Comp| Compl Compl JCompl [Compl Compl
Type of Violation Agency '

The first date displayed for a RCRA Violation corresponds to the violation determination date, and the next to the resolution date (if the violation has been resolved).

Notices of Violation or Informal Enforcement - AFS, PCS, ICIS-NPDES, RCRAInfo (05
year history)

Statute | Source 1D -1 Type of Action | Lead Agency |  pate |
) ) - No data records returned.

.Formal Enforcement Actions - (05 year history)
AFS, PCS, RCRAInfo, NCDB

Statute |source ID |Tvpe of Action |Lead Agency ' |pate  |Penaity |Penalty Description |
- No data records returned.

In some cases, format enforcement actions may be entered both at the initiation and final stages of the action. These may appear more than once above. Entries in
itatics are not "formal” actions under the PCS definitions but are either the initiation of ap action or penalfies assessed as & result of a previous action. This seclion
includes US EPA and State formal enforcement actions under CAA, CWA and RCRA.

ICIS

Primary Case Case |Lead Case Issued/Filed Settlement Federal State/Local SEP  [Comp Action
LawiSection Number Type Agency Name Date Date Penalty Penalty Cost |Cost

- No data records returned. : :

Federal enforcement actions and penalties shown in this section are from the Integrated Compliance Information System (ICIS-FE&C). These actions may duplicate
records in the Formal Enforcement Actions section.

Demographic Profile of Surrounding Area (3 Miles)

Open more detailed information in a new window (links leave EGHO): 1 Mi 3 Mi or 5 ML
This section provides demographic information regarding the community surrounding the facility. ECHO compliance data alone are not sufficient to determine
whether viclations at a particular facility had negative impacts on public health or the environment. Statistics are based upon the 2000 US Census data, and are

accurale to the extent that the facility latitude and longitude listed below are correct. The latitude and longitude are obtained from the EPA Locational Reference
Table{LRT) when available.

IRadius of Area: 3 Miles Land Area: 98.37% Households in area: 35,145
Center Latitude: 39.999658 Water Area: 1.63% Housing units in area: 36,155
Center Longitude: «105.252426 Population Density: 2981.09/5q. mi. Househ}lds On Public Assistance: 576
Total Persons: 182,904 Percent Minority: 15.58% Persons Below Poverty Level: 14,365

IRace Breakdown Persons (%) Age Breakdown; Persons (%)

White: 73,255 (88.36%) Cﬁild 5 years and less: 3,573 (4.31%)
African-american: 826 { 1.12%) [Minors 17 years and younger: 10,853 (13.09%)

IHispanic-Origin: 6,621 ( 7.99%) Adults 18 vears and older: 72,050 (86.91%)
Asian/Pacific Islander: 3,307 { 3.99%) Seniors 65 years and older: 7,006 ( 8.45%)

American indian: 1357 { 0.43%)
Other/Multiracial: 2,795 { 3.37%)




F’:;:,:iﬂ:";g?:i‘ld or) Persons (%) Income Breakdown: Households (%)
|Less than 9th grade: 1,139 ( 2.45%) Less than $15,000: 16,351 (18.07%)
9th-12th grades: 1,365 ( 2.94%) $15,000-525,000: 4,114 (11.71%)
High School Diploma: 4,293 ( 9.46%) $25,000-§50,000: 0,426 {26.82%)
[Some College/2-yr: 7,482 (16.11%) $50,000-875,000: 5,940 {16.90%)
B.S./B.A. or more: 32,076 (69.05%) Greater than $75,000: 9,275 (26.39%)

Please note: Entries in gray denote records that are not federally required fo be reported to EPA. These data may not be
reliable.

Notice About Duration of Violations -- The duration of violations shown on this report is an estimate of the actual duration of
the violations that might be alleged or later determined in a legal proceeding. For example, the start date of the violation as
shown in the ECHOC database is normally when the government first became aware of the violation, not the first date that the
violation occurred, and the facility may have corrected the violation before the end date shown. In some situations, violations
may have been corrected by the facility, but EPA or the State has not verified the correction of these violations. In other
situations, EPA does nof remove the violation flag until an enforcement action has been resolved.

This report was generated by the Integrated Data for Enforcement Analysis (IDEA) system, which updates its information
from program daiabases monthly, The data were last updated: AFS: 03/14/2009. RCRAInfo: 03/09/2008. FRS: 03/12/2009.

Some regulated facilities have expressed an interest in explaining data shown in the Detailed Facility Reports in ECHO. Please check company web sites for such
explanafions.

EPA Home | Privacy and Security Notice | Contact Us
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Cleanup Home

Basic Information
Where You Live
Newsroom
Laws/Statutes
Regulations/Standards
Policy/Guidance
Enforcement

EPA Programs
Involved with
Cleanup

Grants/Funding
Science/Technology = -
Partners |
What You Can Do
Publications '
Related Links
Calendars

Glossary

RCRA Corrective
Action Home

Background
Information

RCRAIRfo

RCRA
Where You Live

Cleanups In
My Community

ID: (CO0000255075)

his profile is meant to provide you with basic information on
EPA’s cleanup progress at this RCRA facility. Please use the

>UUS ARMY RESERVE CENTER-BOULDER

US ARMY RESERVE
CENTER-BOULDER

Cleanup Progress Summary

More Details

Facility Information (Facilily Registry System)
Waste Process Report
Facility Classification Report

- Engineeringfinstitutional Centrols and Industry
Classification Report
Other Names for this Site

Environmental Impact Summary

" Getan 0

EPA Region 8 implements and
enforces the RCRA corrective
action program for Colorado,
Montana, North Daketa, South
Dakota, Utah, Wyoming and Tribal
Nations

Site Address:

US ARMY RESERVE CENTER-
BOULDER

4640 TABLE MESA DR
BOULDER, CO 80303
County: BOULDER

US Congressional District: 2
Population within 1 mile:

For further information on this
corrective agtion site, contact region
or state in which this site is located.

Hazardous wastes are managed

under the Resource Conservation
and Recovery Act. When these
wastes contamnate the land, water
or air they must undergo "corrective
action.”

Cléanup is complete for this -
corrective action site. .

View detailed list of ¢leanug
activities >> -

View information on what controls

are_in place to protect human heaith
and the enviranment >>

TR
Contamination & Exposure

{f this corrective action site has
been examined to determine if
human exposures 1o ¢contaminants
are under controf and the migration
of contaminated water is under
control, that information is provided
below,

At this site, human exposures are
under control.

At this site, migration of
contaminated groundwater is
under control,




Institutional Cantrols:
I Engineering Controls:

Contamination:

Information on the contamination and the reason for the cleanup may be avallable. For further information, see the
contact information provided above, or try the Statement of Basis Web Page to see if a Statement of Basis for the
corrective action remedy has been provided to EPA.

Exposure:
|s human exposure to contamination at this site under controk? YES
is the migration of confaminated groundwater at this sife under control? YES

The Solution: Cleanup Process & Progress
Cleanup Activities at this site:

1. Site Assessed T UNKNOWN

2. Site [dentified for Corrective Action E . NO .

3. Solution for Cleanup Selected {Final Remedy Demsmn) 21-JUN-94
4. Solution for Cleanup is Implemented ’ - : 16-FEB-95
5. Cleanup Complete 01-MAR-95

Controls in Place at this site:

There are many types of controls that can be put in place to control uman exposure to contamlnants and the migration of

contaminated groundwater from the site, and protect the effectiveness of cleanup remedies. Engineering Controls are
Imechanisms that work by physically controlling access to the land, the flow of water, etc. Examples include fences,
cement caps over contaminated areas, and pumps. Institutional Controls (ICs) {also known as land use controls

(LUCs) [EXEUMRISRCe R 4etivity and use imitations (AULs), and envirenmental use restrictions (EURs) are
administrative and/or Iegal controls, that work by limiting fand or resource use. Private or (propnetary) examples include
deed restrictions, covenants and easements. Public (or govenrmental) examples include zoning ordinances and
groundwater penmltlng praograms.

Are controls in place at this site? Type of Contrei(s):

':l Government Performance & Results Act (GRPA) Milestones

EPA is required to report on the following milestones under the Government Performance & Resuits Act. Mere
lnformatlon

Milestohe " ‘Status

Human Exposure Under Control YES
Contaminated Groundwater migration Under Control YES
i -

Window fo My Environment | EnviroMapper | EnviroFacts | Cleanups in My Community
RCRA Corrective Action Home | OSWER Home | Customer Satisfaclion Survey

Data Refreshed on Friday , November 14, 2008 '

This page was generated on Monday, March 30, 2009

View the graphical version of this page at: hitp://iaspub.epa.govienvirofrcra_profile.getmain?p_handler_id=C00000255075




Enforcement & Compliance History Online (ECHO)

You are here: EPA Home  Compliance and Enforcement ECHOQ  Search Data  Search Results

Detailed Facility Report

For Public Release - Unrestricted Dissemination Report Generated on 03/30/2009
US Environmental Protection Agency - Office of Enforcement and Compliance Assurance

Facility Permits and Identifiers

Statute | System Source 1D Facility Name Street Address City State | Zip
FRS 110000738532 U8 ARMY RESERVE CENTER-BOULDER 4640 TABLE MESA DR BOULDER |co |sozo3
RCRA RCR CO0000255075 US ARMY RESERVE CENTER-BOULDER 4640 TABLE MESA DR BOULDER |co  ]s0303

Facility Characteristics

Statute Source 1D Universe | Status | Areas | Permit Expiration Date Ll;a::;::z‘; Indian Country? | SIC Codes | NAICS Codes
R 39.987087
110000738532 105.232863 No
JRCRA |CO0000255075 Inactive Ng

5 If the CWA permit is past its expiration date, this normally means that the permitting authority has not yet issued a new permit. In these situations, the expired permit
is normally adminisiratively extended and kept in effect unfil the new permit is issued.

For the RCRA program, activities that contribute to an overall facility status of Active are displayed in parentheses using the acronym HPACS, where H indlcates
handter actwltles P - permitting, A - corrective actaon C- converter and S - state- specnf‘ ic. More mformatlon is avaliable in the Data chtlonary

Inspection and Enforcement Summary Data

Statute Source 1D Insp. Last 05Yrs I Date of Last Inspection Formal Enf Act Last 05 Yrs Penalties Last 05 Yrs .
RCRA CQ0000255075 0 . [Never 0 : $00

Compliance Monitoring History (05 years )

Statute ] Source ID | Inspection Type i Lead Agency | pate | Finding |
- No data records returned.

Entries in italics are not considered inspections in official counts.

Compliance Summary Data
Information on the nature of alleged violations is available on the FAQ page.

| statute Source ID { Current SNC/HPV? Description | Current As Of Qtrs in NC (of 12)
|rRCRA C0O0000255075 {No - Jozro9:2009 0

Three Year Compliance Status by Quarter

Violations shown in a given quarter do not necessaniy span the entire 3 months. Information on the nature of alleged viclations is available on the FAQ page, and
information on the duration of non-compliance is available at the end of this report.

RCRA Compliance Status
i Statute:Source ID QTR1  |oTR2 |aTR2  |oTR4 JatRs fatRe JaTR7  joTRe  |atrRe  |aTtR1o jaTR11  |QTRi2
5 RCRA: Apr- Jul- |oct- Jan- Apr- Jul- © {oet- Jan- Apr- Jul- Cct- Jan-
CO0000255075 Jun0s  |Sep0s |Dec0s8  |Mar07  |uun07  |Sep07 - |Deco7 - |Mar0g  Juunog  [Sep08  |Decos  |Mar0o
Facility Leve! Status Compl - |Compl  [Compl -~ JCompt  [Compt -|Compl |Compl JCompl [Comp! . JCompt [Compl |Compl
]
i Type of Violafion Agency

The first date displayed for a RCRA Violation corresponds to the violation determination date, and the next to the resolution date (if the violation has been resolved).



Notices of Violation or Informal Enforcement - AFS, PCS, ICIS-NPDES, RCRAInfo (05
year history)
Statute |

Source ID 1 Type of Action |

- No data records returned.

Lead Agency | Pate |

Formal Enforcement Actions - (05 year history)
AFS, PCS, RCRAInfo, NCDB

Statute |source ID
- No data records returned.

JType of Action |Lead Agency |pate  |Penaity “[Penalty Description o]

In some cases, formal enforcement actions may be entered both at the initiation and final stages of the action. These may appear more than once above. Entries in
ftalics are not "formal” actions under the PCS definitions but are either the initiation of an action or penalties assessed asa result of a previous action. Th:s section .~
includes US EPA and State formal enforcement actions under CAA, CWA and RCRA. . .

ICIS
Primary Case Case |Lead Case Issued/Filed Settlement Federal State/Local SEP Comp Action
Law/Section Number Type Agency Name Date Date Penalty Penalty Cost Cost

§- No data records returned.

Federal enforcement actions and penalties shown in this section are from the Integrated Compliance Information System (ICIS- FE&C) These actions may duplicate
records in the Formal Enforcement Actions section.

| Demographic Profile of Surrounding Area (3 Miles)

Open more detailed information in a new window (links leave ECHO): 1 Mi 3 Mi or 5 Mi.

This section provides demographic information regarding the community surrounding the facility. ECHO compliance data alone are not sufficient to determine
whether violations at a particular facility had negative impacts on public health or the environment. Statistics are based upon the 2000 US Census data, and are
accurate to the extent that the facilify latitude and longitude listed below are comrect. The latitude and longitude are obtained from the EPA Lacational Reference
Table{LRT) when available.

Radius of Area: 3 Miles |Land Area: 98.34% Households in area: 26,590
Center Latitude: 39.985685 Jwater Area: 1.66% Housing units in area: 27,365
Center Longitude: -105.240931 |Population Density: 2330.76/s9. mi. Househ-olds On Public Assistance: 407
Total Persons: 64,795 |Percent Minority: 16.70% Persons Below Poverty Level: 12,162
Race Breakdown |Persons (%) Age Breakdown: Persons (%)

White: 56,987 (87.95%) Child 5 years and less: 2,501 ( 3.86%)
African-ameritan: 803 (1.24%) IMinors 17 years and younger: 8,006 {12.36%)

Hispanic-Origin:

4,734 ( 7.31%)

Adults 18 years and older:

56,789 (87.64%)

Asian/Pacific Islander:

2,046 ( 4.55%)

American Indian:

299 (0.46%)

Seniors 65 years and older:

5475 ( 8.45%)

Other/Muitiracial:

2,005 ( 3.09%)

Education Level

IPersons (%)

Income Breakdown:

IHouseholds (%)

{Persons 25 & older)

Less than 9th grade: 594 (1.75%) Less than $15,000: 5,263 (19.79%)
[oth-12th grades: 907 ( 2.68%) $15,000-525,000: 3,193 (12.01%) -
h School Diploma: 3,204 { 9.46%) [525,000-550,000: 6,994 (26.30%)
Some College/2—yr: 5771 (17.04%) |s50,000-$75,000: 4,423 (16.53%)
|B.5./B.A. or more: 23,393 {689.07%) |Greater than $75,000: 6,745 (25.37%)

Please note: Entries in gray denote records that are not federally required to be reported to EPA. These data may not be

reliable.

Notice About Duration of Violations -- The duration of violations shown on this report is an estimate of the actual duration of
the violations that might be alleged or later determined in a legal proceeding. For example, the start date of the violation as
shown in the ECHO database is normally when the government first became aware of the violation, not the first date that the
violation occurred, and the facility may have corrected the violation before the end date shown. In some situations, violations
may have been corrected by the facility, but EPA or the State has not verified the correction of these violations. In other
situations, EPA does not remove the violation flag until an enforcement action has been resolved.




This report was generated by the Integrated Data for Enforcement Analysis (IDEA} system, which updates its information
from program databases monthly. The data were last updated: RCRAInfo: 03/09/2009. FRS: 03/12/2009.

Some regulated facilities have expressed an inferest in explaining data shown in the Detailed Facility Reports in ECHO. Please check company web sites for such
explanations.

EPA Home | Privacy and Security Notice | Contact Us









